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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

indicates that minor personal injury can result if proper precautions are not taken.
 

 
NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

 Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY

A5E03515631-02
Ⓟ 12/2012 Technical data subject to change

Copyright © Siemens AG 2012.
All rights reserved
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Preface 1
Purpose of the program     

SIMATIC PDM (Process Device Manager) is a general-purpose, manufacturer-independent 
tool for configuration, commissioning, diagnostics and maintenance of intelligent field devices 
(sensors and actuator) and field components (remote I/Os, multiplexers, control room units, 
compact controllers).

Purpose of the documentation
This documentation supports you in your work with SIMATIC PDM software. You are provided 
with an overview of the following topics:

● Installing SIMATIC PDM

● Commissioning the software

● Procedures for configuring networks and field devices

● Procedures for commissioning and using the runtime functions.

The documentation is intended for persons working in field engineering who are responsible 
for configuration, commissioning and plant operation.

Required basic knowledge
General knowledge in the area of field engineering is required to understand this 
documentation.

Knowledge about the handling of PCs running on Windows operating systems is also required.

Activities using STEP 7 and PCS 7 require corresponding knowledge in the field of automation 
technology and of SIMATIC S7.

Scope of the documentation
This documentation is valid for the software package SIMATIC PDM V8.0 Service Pack 2. 

Device-specific help
This documentation only covers the basic functionality of PDM. For device-specific information, 
refer to the documentation of the field device manufacturers.

Help for SIMATIC PDM (V8.0.2)
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Readme for SIMATIC PDM     
For details of the requirements for using SIMATIC PDM, of special functions, and of the various 
applications, see file pdmbase-readme. You can locate the file as follows:

● On the SIMATIC PDM product DVD in the main folder of the DVD.

● On the SIMATIC PCS 7 product DVD in the folder ...PDM...\PDMBASE\setup.

● After installation of SIMATIC PDM:

– By selecting SIEMENS SIMATIC documentation in the Windows Start menu

– The default folder for the file is ...\SIEMENS\SIMATIC_PDM\.

Online help
The SIMATIC PDM online help is a project-specific help feature, which contains the following 
information:

● Help for SIMATIC PDM 
The PDF file is an extract of the HTML-based online help for SIMATIC PDM. The PDF file 
does not contain any device-specific information.

● Device-specific help 
Device-specific information contained in the online help is derived from the device 
descriptions (EDD) of the devices being used:

– Information on device-specific functions (e.g. available online functions)

– Help for device-specific menu commands (e.g. trend display options, device-specific 
display functions and operating functions)

 

  Note
Scope of the device-specific information

The scope of the device-specific information depends on what information can be 
derived from the device descriptions. 

 

The help system is integrated into the software by way of several interfaces:

● The Help menu provides several menu commands: Help topics opens the table of contents 
of the help for SIMATIC PDM.

● The context-sensitive help provides information with regard to the current context such as 
open dialog boxes or active windows. The help is called by clicking the "Help" button or by 
pressing the F1 key.

● A tooltip is displayed for the toolbar icons using the "mouse over" function.

If you would prefer to read a hardcopy of the help, you can print specific help topics or chapters, 
or the entire help.

Preface

Help for SIMATIC PDM (V8.0.2)
10 Operating Manual, 12/2012, A5E03515631-02



Using SIMATIC PDM 2
2.1 Introduction

SIMATIC PDM (Process Device Manager) is a general-purpose, manufacturer-independent 
tool for configuration, parameter assignment, commissioning, diagnostics and maintenance of 
intelligent field devices (sensors and actuators) and field components (remote I/Os, 
multiplexers, control room units, compact controllers). These are simply referred to as devices 
in the rest of this documentation. 

With one software package, SIMATIC PDM enables processing of more than 2500 devices 
from Siemens and 200 other manufacturers from around the world with an homogeneous user 
interface.

2.2 Using the documentation

Scope
SIMATIC PDM operates within a SIMATIC STEP 7 / PCS 7 environment or in combination 
with suitable function modules.   

Conventions 
The names of the user interfaces in this software are listed in accordance with the regional 
language of this documentation. If you have installed an MUI operating system, certain 
designations are still displayed in the base language of the operating system after a language 
change and will, therefore, differ from those used in the documentation.

Help for SIMATIC PDM (V8.0.2)
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2.3 Contact partner

Your contact partner (not for DEMO version)
● Questions on SIMATIC STEP 7  / SIMATIC PCS 7 / hardware / SIMATIC PDM / problems 

with S7 communication:

Mailing address SIEMENS AG
Customer Support
D-90475 Nuremberg, Germany

E-mail: online-support.industry@siemens.com
Internet http://www.siemens.com/automation/service&support  (http://www.siemens.com/

automation/service&support) 

● Questions on devices and GSD files:
Please get in touch with your contact partner at the device manufacturer. 
See "List of integrated devices". These are available on the "SIMATIC PDM Device Library 
2#2012" DVD in the \Manuals directory.

● Follow-up installations and additional information on SIMATIC PDM are available on the 
Internet at http://pcs.khe.siemens.com/pdm (http://pcs.khe.siemens.com/pdm)

2.4 Basis for using intelligent field devices

Integration of field devices from different manufacturers into control systems
Device descriptions had to be standardized In order to enable intelligent field devices from 
different manufacturers to be integrated into different control systems. This standard (IEC 
61804-2) was developed in collaboration with the following organizations:

● PROFIBUS User Organization (PNO)

● Hart Communication Foundation (HCF)

● Fieldbus FOUNDATION (FF)

● OPC Foundation

● Device descriptions are based on EDDL (Electronic Device Description Language - 
standard IEC 61804-3).

Using SIMATIC PDM
2.4 Basis for using intelligent field devices
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Finding the device description
You can obtain device descriptions in the following ways:     

● From the device manufacturer together with the device

● From the Internet

● In the device catalogs of applications which can evaluate the data contained in device 
descriptions

 

  Note
Device descriptions and EDD

Below, the terms "EDD" (Electronic Device Description) and DD (Device Description) will 
be referred to as "device description". 
However, the terms EDD and DD appear in the user interface.

 

Liability
Siemens explicitly declines any liability for damages resulting from the use of the following 
device description files and use in conjunction with the associated devices:

● For device-specific device description files for non-Siemens devices, the Siemens warranty 
only applies up to the interface.

● For non-device-specific device description files, such as those that correspond to the 
PROFIBUS PA profiles or the HART universal or common practice commands

● For device description files of the HCF library from the DVD "Device Library...)"

● For device description files integrated through the import catalog
 

 
 NOTICE

Important note on the device description files included with the SIMATIC PDM

The device description files of non-Siemens field devices have not been developed by 
Siemens and are included with the shipped products free of charge. The licensee is 
entitled to use the device description files of these devices in the same manner as a trial 
license in accordance with the general terms and conditions for the supply of software for 
automation and drive technology. This right of use may be exercised by the licensee as 
long as the right of use for the PDM software is in effect.

 

2.5 Establishing connections to field devices
Plants use field devices with different communication paths and protocols. The overview shows 
a typical connection scenario for the field device groups that are supported by SIMATIC PDM.

Using SIMATIC PDM
2.5 Establishing connections to field devices
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Network topologies for PROFIBUS DP
The following figure shows the access paths to field devices for SIMATIC PDM.

Using SIMATIC PDM
2.5 Establishing connections to field devices
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Network topologies for PROFINET
The following figure shows the access paths to field devices for SIMATIC PDM.

Supported networks   
With this version of SIMATIC PDM, field devices are supported on the following networks: 

● PROFIBUS DP network (including subordinate Foundation Fieldbus)

● PROFIBUS PA network

● PROFINET

Using SIMATIC PDM
2.5 Establishing connections to field devices
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Communication paths 
 

 Note
Interface with SIMATIC PDM

In the figure below, the PC depicted also serves as the interface with SIMATIC PDM in each 
case. 

In networks with routing capability, the PC can be connected to a linked network. You can 
find information on this in the section "Plant-wide communication by means of routing 
(Page 73)".

 

Activating PDM functions
License keys are required in order to use SIMATIC PDM. You can expand the SIMATIC PDM 
functions by adding optional packages. You can find information on this in the section "Basic 
packages (Page 16)".

Additional information
Section "Inserting devices (Page 77)"

2.6 Product structure

2.6.1 Basic packages
The following product packages with different performance features are available for SIMATIC 
PDM.

Product packages for SIMATIC PDM V8.0

License key SIMATIC PDM product package
STEP 7 PCS 7

SIMATIC PDM Basic and Extended include include
Integration in STEP 7 include include
TAGs 100 100
"SIMATIC PDM Routing (Page 19)" optional package - include

Using SIMATIC PDM
2.6 Product structure
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 Note
Displaying devices subject to licensing

SIMATIC PDM depicts only devices if a license tag is installed for each devices subject to 
licensing.
● Licenses are only required for devices that are subject to licensing.
● No licenses are required for remote I/O modules and channels.

 

Functions in product package
Legend for the following table:

●: Available
○: Optionally available
□: Not relevant
-: Not available

Functions SIMATIC PDM
STEP 7 (PCS 7)

Project functions 
● Create online ●
● Create online ●
● TAG options used ●
● Network view ●
● Plant view ●
● Export / import devices ●
● HW Config ●
● Integration in STEP 7 ●
● User Manager (SIMATIC Logon) ○
Communication functions
● PROFIBUS ●
● PROFINET ●
● FOUNDATION Fieldbus ○
● HART SHC mode (communication acceleration) ●
● "HART Long TAG" ●
Device functions
● Export / import parameters ●
● Use of SIMATIC PDM options ●
● Saving parameters ●
● Log (audit trail) ●
LifeList functions

Using SIMATIC PDM
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Functions SIMATIC PDM
STEP 7 (PCS 7)

● Scan from HW Config ●
● Device diagnostics ●
● Define scan area ●

Operating mode "PDM Demo"
The "PDM Demo" version is an operating mode especially for the product SIMATIC PDM. The 
"PDM Demo" operating mode is activated automatically if necessary licenses are not 
recognized or functions/options that are subject to licensing are present in a project.

● Necessary licenses for SIMATIC PDM (license keys):

– PDM Basic

● Functions/options subject to licensing:

– Communication subject to licensing (HART communication)

– Options subject to licensing (for example PDM Extended)

Reaction 

After starting SIMATIC PDM, you receive a message stating that demo mode is activated. In 
addition, the status line displays the information "Demo".

 

 Note
License conditions violated

If the license conditions are violated, the following applies:
● The processing of the project with other editors is unrestricted.
● Objects that are not affected by the infringement of the license conditions can be created.
● The communication functions are locked.
● Online dialog boxes of field devices can only be opened "offline".
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2.6.2 Options

Program Add-ons for SIMATIC PDM   
You can purchase the following add-ons for SIMATIC PDM:

● SIMATIC PDM Integration in STEP 7 (PCS 7)
It allows field devices and their associated networks to be configured using the STEP 7 
hardware configurator (HW Config).

 

 Note

The combination of SIMATIC PDM and the option "Integration in STEP 7" is referred SIMATIC 
PDM integrated in the remainder of this documentation.

 

● PDM TAG
If you want to use more TAGs per project than those provided in the standard package, the 
TAG options of SIMATIC PDM enable you to use up to an unlimited number of TAGs. The 
maximum number of devices you can configure increases with several license keys (TAG 
addition).
Available license keys:

– 10 TAG

– 100 TAG

– 1000 TAG

● PDM Foundation Fieldbus
This option lets you use the SIMATIC PDM functions for devices on the Foundation Fieldbus.

● SIMATIC PDM Routing (Routing via S7 400)
This option allows you to configure field devices in cases where an automation system 
serves as the gateway.

● PDM Extended
You can use the following additional functions with this option:

– Import

– Export

– Print

– Document Manager

– LifeList

Additional information
Section "Establishing connections to field devices (Page 13)"

Using SIMATIC PDM
2.6 Product structure

Help for SIMATIC PDM (V8.0.2)
Operating Manual, 12/2012, A5E03515631-02 19



2.6.3 Delivery contents

Scope of delivery
Please consult the file pdmbase-readme for information about the software packages that are 
included with SIMATIC PDM.

Device libraries   
For information on the devices contained in the SIMATIC PDM device libraries, refer to the 
following sources:

● The Internet pages of the device manufacturer
The latest versions of the device libraries and the HCF catalog can be found online.

● on the DVD "Device Library" in the folder _manuals\PI_Library_Documentation > in the file 
"index.html"

Liability    
 

 Note

Read the information in the section "Basis for using intelligent field devices (Page 12)".
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Installation 3
3.1 Preparing SIMATIC PDM

Requirement
● SIMATIC PDM is installed.

You can find information about this in the section "Installing SIMATIC PDM (Page 21)"

● Project settings have been made
You can find more information on this in the section ""Options" menu (Page 180)".

● The settings have been made for the fieldbus interfaces.

● Field device planning has been completed.
You can find information on this in the section "Establishing connections to field devices 
(Page 13)".

● The device description files for the field devices used within a plant have been integrated 
into SIMATIC PDM. You can find information on this in the section "How to integrate a 
device description (Page 38)".

● Recommended:
Hardware has been prepared (structure, power supply, network connections)

Additional information
● For additional information on assigning a network, refer to the section "Setting the interface 

on the computer (Page 73)".

● For information on the particular issues relating to the distributed I/Os, refer to the section 
"Modular PROFIBUS device (remote I/O) (Page 85)".

3.2 Installing SIMATIC PDM
SIMATIC PDM must be installed before it can be started. The software package contains all 
SIMATIC PDM software. Depending on the use case in question, you will only need to install 
certain applications from the CD. 

Licensing
In order to use the software you will need product-specific license keys (license agreements), 
which you install with the Automation License Manager. 
You can transfer the required license keys either prior to or following the installation. You can 
find additional information on this in the online help for the Automation License Manager.
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Requirements
● The operating system has been installed.

● No version of SIMATIC PDM has been installed.

● All communications processors have been installed in the PC.

● You have administrator rights on the PC station.

● If you install the software in a domain, be aware of group policies or other restrictions that 
may hinder the installation. Consult the appropriate Administrator as regards these settings 
and the required approvals and permissions.

Calling the setup program
1. Insert the program CD into the drive.

2. Double-click on "Setup.exe" to start the setup.
Setup starts.

 

  Note
Checking the installation requirements

The setup program automatically checks whether the software components needed for 
the installation are already installed on the PC. 
● Read the latest information about installation and the software and hardware 

requirements in the pdmbase-readme file on the program CD.
● If any software components are missing, a message informs you of this. The setup 

program is terminated after the message is confirmed . The setup will start again after 
you have installed the missing software components.

 

Settings in the setup
Below you will find information on the settings made in the setup dialog boxes, listed in the 
order in which they are processed:

1. Setup language

– For example, click "English" and "Next".

2. Welcome

– ... "Next"

3. Product information
... Read this if needed and click "Next"

4. License agreement

– ... Activate the check box "I accept the conditions of the licensing agreement as well as 
the conditions of the Open Source Licensing Agreement".

– ... "Next"

5. Setup type

– ... Activate the "Install" check box and "Next".

Installation
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6. User information

– Enter the user information and click "Next".

7. Installation type

– Package installation

– Custom installation

– You can specify the target folder for SIMATIC PDM.

– "Next"

8. Programs

– The software installed on the PC for this selection is listed in the display window. "Next"
 

  Note
FOUNDATION Fieldbus

If you wish to configure or monitor devices on a FOUNDATION Fieldbus, you need to 
activate the "FOUNDATION Fieldbus" option.

 

9. System settings
System settings are required for problem-free operation of SIMATIC PDM.

 

  Note
Required system settings
● The settings in the exception list of the Windows firewall are applied to the area of the 

local network (subnet). If your PC stations are located in different networks (subnets), 
you need to change this area.

● The settings in the exception list of the Windows firewall are made when the Windows 
firewall is disabled.

● You can open the "Security Controller" dialog box again. To do this, select the following 
in the Start menu, Siemens SIMATIC programs: Security > Security Controller

 

10.Ready to install the selection. 
"Install" - The installation is performed.
Close the dialog box when the installation is complete.

11.Reboot the PC.

Device descriptions of field devices used
Following the installation of SIMATIC PDM, integrate the required device descriptions (EDD) 
for the field devices used. 

You can find information on this in the following sections:

● Section "Integrating devices into SIMATIC PDM (Page 27)"

● Section "How to integrate a device description (Page 38)"
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3.3 Setting the language

Changing the language
1. Select the SIMATIC Manager command Options > Customize.... 

The "Settings" dialog box opens.

2. Open the "Language" tab. You can change the language on this tab page.

3. Select the language you want to work with in the "National language" field.
 

  Note
SIMATIC PDM language versions

The drop-down list contains the languages in which SIMATIC Manager is installed.
If you select a language for which there is no matching SIMATIC PDM language version 
installed on the given computer, "English" is set automatically.

 

3.4 Reinstalling / Removing SIMATIC PDM
 

 Note

Observe the information on dealing with license keys, which can be found in:
● File pdmbase-readme
● Help for the Automation License Manager

 

Reinstalling
Reinstallation over the top of an existing SIMATIC PDM version is not possible. Remove 
SIMATIC PDM prior to installing the new version.

 

 Note
Device descriptions

Following a new installation, the required device description must be integrated again.
● The device descriptions included with SIMATIC PDM are available on the "Device Library" 

DVD.
● You should already be aware of the storage locations for any other device descriptions 

used.

You can find information about integrating the device descriptions in the section "Integrating 
devices into SIMATIC PDM (Page 27)".

 

Removing
To remove SIMATIC PDM, use the Windows system function for removing programs.
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PDM Exportfile Converter 4
4.1 "PDM Exportfile Converter" dialog box

In the "PDM Exportfile Converter" dialog, you can convert export files from older PDM versions, 
enabling them to be imported into PDM again.

The export files from PDM Versions V6.x and V7.x cannot be imported directly into PDM V8.
To enable importing of existing export files, the “old” export files are converted.
A structure file is generated in this case and stored along with the associated parameter import 
files in the corresponding subdirectory generated by the converter. These files can then be 
imported.

Source-File:
Navigate to the desired directory in the file system containing the export files to be converted. 

After the dialog is closed with OK and an export file is correctly selected, the structure it contains 
is displayed in the converter.

Destination-Dir:
Navigate to the desired directory in the file system where the converted files are to be stored.

"Convert" button
Click "Convert". The selected source file is converted. 

Help for SIMATIC PDM (V8.0.2)
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Integrating devices into SIMATIC PDM 5
5.1 Device Integration Manager

The field devices can only be configured if the device descriptions that are suitable for the field 
devices have been integrated into SIMATIC PDM. The Device Integration Manager is the 
SIMATIC PDM function for integrating device descriptions.

Liability
Siemens explicitly declines any liability for damages resulting from the use of the following 
device descriptions and use in conjunction with the associated devices:

● For device-specific device descriptions for non-Siemens devices, the Siemens warranty 
only applies up to the interface.

● For non-device-specific device descriptions, 
such as device descriptions that correspond to the PROFIBUS PA profiles or the HART 
universal or common practice commands

● For device descriptions of the HCF library, FF library and PI library from the DVD "Device 
Library ..."

 

 
 NOTICE

Important information about the device descriptions included with the SIMATIC PDM

The device descriptions of non-Siemens field devices have not been developed by 
Siemens and are included with the shipped products free of charge. The licensee is 
entitled to use the device descriptions of these devices in the same manner as a trial 
license in accordance with the general terms and conditions for the supply of software for 
automation and drive technology. This right of use may be exercised by the licensee as 
long as the right of use for the PDM software is in effect.

 

Starting the Device Integration Manager
1. In the Windows Start menu under the Siemens SIMATIC programs, select the SIMATIC 

PDM > Device Integration Manager menu command. 
The "Device Integration Manager" dialog opens.

2. Read the license agreement. 
You must accept the license agreement in order to be able to work with the Device 
Integration Manager .

3. Click the "I accept the license agreement" button.
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5.2 "Device Integration Manager" main window

Introduction
The "Device Integration Manager" main window remains on the screen throughout the work 
session and is partially or totally covered by other activated dialog windows.

The main window has the following layout
Title bar (Page 28) The product name is displayed.
Menu bar (Page 29) You can access the functions of the Device Integration Manager via 

the menu bar.
Toolbar (Page 30) The toolbar enables certain menu commands to be accessed 

quickly.
Source folder (Page 36) The "Source folder" box shows the storage location in which device 

descriptions are or were searched for.
Filter (Page 37) You can apply filters to reduce the amount of information displayed 

in the device list.
Apply project filter... (Page 51) / 
Apply filter file... (Page 50)

Only those devices that are used in the selected project and for 
which an identical version has not yet been integrated are selected 
for integration.

Device list (Page 32) The device list displays information on devices that have been read 
in or integrated. 

Status bar (Page 36) Contains information on processes currently being performed.

5.3 Views

5.3.1 Title bar
The title bar shows the name "Device Integration Manager".
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5.3.2 Menu bar

Structure
Below you will find an overview of the Device Integration Manager menus.

Menu Submenu Function
File
 

● Read device descriptions 
from source folder... 
(Page 44)

Selecting the storage location of device descriptions to be read in.
Set the path to the device descriptions or navigate to the location.

● Read in device 
descriptions from 
compressed archive... 
(Page 44)

Selecting the storage location of compressed device descriptions to be read in.
Set the path and the file name to compressed device descriptions or navigate 
to the location.

● Reading in the list of 
integrated device 
descriptions (Page 45)

The device descriptions integrated in the PC are read in to the device list.

● Reading in the list of 
integrated device 
descriptions (Page 46)

The device descriptions used in the STEP 7 project are displayed.

● Save device list as ... 
(Page 46)

The displayed information of the current device list is saved.
Specify the storage location and file name for the file in which you want the 
device list to be saved.

● Print device list (Page 46) The device list is sent to the selected printer.
● Deleting the device list 

(Page 47)
The displayed device list is emptied.
Application example: 
Clearing the device list before reading in device descriptions again.

● Exit (Page 47) Closes the Device Integration Manager.
View ● Split device list window 

(Page 47)
The device list window is split or the split is removed.
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Menu Submenu Function
Catalog ● Complete the device 

information ... (Page 49)
If the software detects that relevant information is missing in a device description 
during its import, the "Device info incomplete" icon appears in the status column 
of the device list.
If you select an affected device in the device list, you can then complete the 
device information in a dialog.

● Create own device 
library... (Page 50)

Your own device library is created.
You can copy, compress (zip) or burn to DVD device libraries that were created 
in this way. These libraries can be read in and integrated with the Device 
Integration Manager just like the SIMATIC PDM DVD "Device Library …".

● Apply filter file... (Page 50) Select a filter file (previously saved device list) according to which the currently 
displayed device list is to be filtered.

● Apply project filter... 
(Page 51)

Select a project or multiproject to filter the currently displayed device list for 
components used in the project.

● Revoking file filter/project 
filter (Page 51) 

Filtering by means of a filter file or project filter is stopped.

● Integrate (Page 49) The device descriptions are integrated into SIMATIC PDM for those devices 
selected in the device list.
Requirement:
The check box for the required device is selected in the "Path" column of the 
device list.

● Messages ... (Page 52) The "Messages" dialog box opens.
? ● Help (Page 53) Opens the help for SIMATIC PDM.

● About... (Page 53) The following information is displayed:
● SIMATIC PDM version
● Information about the "Device Integration Manager" component

Additional information
Use SIMATIC Manager to make the settings for the Device Integration Manager.

You can find information on this in the following sections:

● (Set language:) Section Options > "Settings (Page 180)"

● Section Options > SIMATIC PDM > Settings > "Device Integration Manager" tab 
(Page 186)

 

5.3.3 Toolbar
The toolbar is located below the menu bar and contains a number of icons with which you can 
quickly perform frequently used menu commands without having to open a menu and select 
the command. 
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Icons     
Meanings of the icons used:

Icon Menu command Description
Read device descriptions 
from source folder... 
(Page 44) 

Selecting the storage location of device descriptions to be 
read in.
Set the path to the device descriptions or navigate to the 
location.

Read in device 
descriptions from 
compressed archive... 
(Page 44)

Selecting the storage location of compressed device 
descriptions to be read in.
Set the path and the file name to compressed device 
descriptions or navigate to the location.

Integrate (Page 49) The device descriptions are integrated into SIMATIC PDM 
for those devices selected in the device list. 

Print device list (Page 46) The device list is sent to the selected printer.

Deleting the device list 
(Page 47) 

The displayed device list is emptied.
Application example: 
Clearing the device list before reading in device 
descriptions again.

Reading in the list of 
integrated device 
descriptions (Page 45) 

The device descriptions integrated in the PC are read in 
to the device list.

Reading in the list of 
integrated device 
descriptions (Page 46)

The device descriptions used in the STEP 7 project are 
displayed.

Create own device 
library... (Page 50) 

Your own device library is created.

Save device list as ... 
(Page 46) 

The displayed information of the current device list is 
saved.
Specify the storage location and file name for the file in 
which you want the device list to be saved.

Apply filter file... (Page 50) Select a filter file (previously saved device list) according 
to which the currently displayed device list is to be filtered.

Apply project filter... 
(Page 51)

Select a project or multiproject to filter the device list for 
components used in the project.

Split device list window 
(Page 47)

The device list window is split or the split is removed once 
again.

Messages ... (Page 52) The "Messages" dialog box opens.

Using the Find function 
(Page 52) 

The displayed device list is searched.
Open the "Find" dialog box. Enter a string and define the 
search options.

Help (Page 53) The SIMATIC PDM help opens.
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5.3.4 Device list
The device list in the "Device Integration Manager" dialog window includes a table with 
information on device descriptions and devices that can be interpreted by a device description 
by SIMATIC PDM.
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Columns

Column Description
Path Tree structure - 

The devices with 
device 
description are 
displayed in a 
hierarchical 
structure 
(catalog path).
Flat structure - 
The devices with 
device 
description are 
displayed 
without a 
hierarchical 
structure.
The devices are 
displayed in a 
hierarchical 
structure when 
you click the 
"Path" column 
header for 
sorting.
The devices are 
displayed in a flat 
structure when 
you click the 
header of any 
other column 
(except "Path").
● Select the 

check boxes 
for the 
devices 
whose 
device 
descriptions 
are to be 
integrated.

To be 
integrat
ed
Will not 
be 
integrat
ed, for 
exampl
e, 
becaus
e an 
identic
al 
device 
descrip
tion 
has 
already
 been 
integrat
ed. 
Note 
the 
status 
icons.

●  Comm
unicati
on

●  Folder 
for 
device 
classes
 
(actuat
or/
sensor 
etc.)

●  Manufa
cturer

●  Device 
type, 
Compo
nent, 
Device 
version
, 
Variant
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Column Description
Name Device name
Manufacturer Manufacturer
Communicatio
n

Communication 
type for the 
connection to the 
field device.

Type Catalog position 
(object name)

New version Version of the 
device 
description 
which was read 
in from a device 
description 
library.

Installed 
version

EDD source 
version

Installed on Installation date 
of the installed 
EDD

Description Attribute from 
device file

Device type ID of the device 
type

GSD files Names of the 
GSD files

New DD 
revision

 

Old DD revision  
New device 
revision

 

Old device 
revision

 

DVD version Version from 
Device class Hierarchical 

name of the 
device type (e.g., 
SENSOR - 
FLOW, 
ULTRASONIC)
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Column Description
Integrated 
version

Version of the 
device 
description that 
is integrated in 
SIMATIC PDM.

Additional information may be 
displayed.
● You can select the columns to 

be displayed in the SIMATIC 
Manager using the following 
menu command: Options > 
SIMATIC PDM > Settings... .

● You will find additional 
information on this topic in 
section "Device Integration 
Manager" tab (Page 186).

Status icons of the device description

Meaning of icons before the status of the device description integration

Icon Meaning
Not (yet) integrated

Device info incomplete

An identical device description has already been integrated.

The device description is in the process of being integrated.

The device description has been integrated successfully.

The device description is used in the project but neither read in nor integrated.

Error Observe the error details in the message window.

Warning Observe the warning details in the message window.

Meaning of icons after the device descriptions have been read in and before they have been 
integrated

Icon Meaning
The device description has been read in without any errors but has not yet been 
integrated. 
The device information is incomplete in the imported device description. The device 
description cannot be integrated correctly. 
You can find information on correcting this in the section "How to complete a device 
description (Page 40)".
An identical version of the device description has already been integrated.

The device description is in the process of being integrated.
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Icon Meaning
The device description has been integrated successfully.

Errors occurred while reading in the device description. The device description cannot 
be integrated.
For details of the error messages, see the message window
Warnings generated. The device description has been read in and can be integrated. 

Meaning of the icons after integration of the device description

Icon Meaning
The device description has not been integrated because the user did not select it for 
integration.
The device description was not integrated, because an identical version had already 
been installed. 
The device description has been successfully integrated without errors. 

The device description has been successfully integrated without errors. Warnings 
occurred during the semantic check.
The device description has been successfully integrated without errors. Errors occurred 
during the semantic check.
An attempt was made to integrate the device description. The device description could 
not be integrated due to an error.
● Error messages:

For details, please refer to the message window.
● Potential cause: Device information incomplete during integration.
 
The device description has been integrated. The warnings indicate potential 
inconsistencies. 

Sorting
You can sort the contents of the table. Click on the cell in the header of the column based on 
which the contents should be sorted. Clicking on this cell again changes the sorting direction 
(ascending/descending).

5.3.5 Status bar
The status bar is located at the bottom of the main window. It displays the number of read in 
or integrated device descriptions.   

5.3.6 Source folder
The Source folder box is located underneath the toolbar. You use this box to select the path 
in which the device descriptions are located. The device list is created based on the device 
descriptions.
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The source can be:

Icon Meaning
Folder

Compressed file (*.zip)

Device description file (*.xml)

The Source folder box gives you the option to display the history of the directories so far. Click 
the drop-down icon in the right-hand margin of the field to display the last ten sources.

Changing the source folder
Procedure

1. Click the "Find folder" icon.
The "Change source folder" dialog box opens.

2. Navigate to the required directory in the file system.

3. Click "OK".

Alternatively, you can enter the path into the text box.

All compressed files included in the selected source directory are searched for the device 
descriptions. Compressed files within a compressed file are also taken into consideration.

5.3.7 Filter
The "Filter" box is located underneath the "Source folder" box. You can filter for up to three 
strings of your choice (filters 1, 2 and 3) simultaneously. When the filter is applied, all devices 
that include all specified strings in their device description are displayed. A distinction is not 
made between uppercase and lowercase letters.

Applying a filter
Procedure

1. Click in the text box "Filter 1", "Filter 2" or "Filter 3".

2. Enter the required search term.

3. Confirm your entry with the "Enter" key.
The device list is searched for the search terms and updated.

Each text box gives you the option to display the history of the search terms so far. 

Click the drop-down icon to the right of the text box to display the history.

To disable individual filters, click on the  of the respective filter.

Integrating devices into SIMATIC PDM
5.3 Views

Help for SIMATIC PDM (V8.0.2)
Operating Manual, 12/2012, A5E03515631-02 37



 
 

 Note

The filter (text boxes, filter files, project filter) does not only affect the display. The selections 
of all devices excluded by the filter are removed and no longer set when the filter is disabled.

 

See also
Apply project filter... (Page 51)

Revoking file filter/project filter  (Page 51)

Apply filter file... (Page 50)

5.3.8 Filter file/Project filter
The "Filter file/Project filter" box is located underneath the "Source folder" box. It is only 
displayed when you use a filter file or the project filter.

The devices that match the data of the filter file or those contained in the project file are 
displayed when the filter is applied.

Applying a filter
Procedure

The procedure for applying a filter file or a project filter is described under Filter file (Page 50) 
or Project filter (Page 51).

See also
Revoking file filter/project filter  (Page 51)

5.4 Working with the Device Integration Manager

5.4.1 How to integrate a device description
The Device Integration Manager is the SIMATIC PDM function for integrating device 
descriptions.
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Device descriptions of the "Device Library" DVD
Make sure the device descriptions are always integrated in SIMATIC PDM from the "Device 
Library" DVD provided with your version of SIMATIC PDM. Changes in the device descriptions 
and the catalog structure may exist between the different versions.

 

 Note
FOUNDATION Fieldbus

The SIMATIC PDM option "FOUNDATION Fieldbus" must be installed to integrate device 
descriptions for devices on FOUNDATION Fieldbus.
For information on this, refer to the section "Installing SIMATIC PDM (Page 21)".

 

Upgrading SIMATIC PDM
 

 Note
Checking for all device types used in the project

After integrating the device descriptions, you need to check the assignment of the device 
description (by opening the parameter assignment interface once).

 

Procedure
1. Close all SIMATIC programs that are open on the PDM computer.

2. Go to the Windows Start menu and select the menu command SIMATIC PDM > Device 
Integration Manager under the Siemens SIMATIC programs.
You must accept the license agreement to be able to use the Device Integration Manager .

3. Select the menu command File > Read device descriptions from source directory ...  or 
File > Read device descriptions from compressed source ...

4. Navigate to the folder with the device descriptions in the tree structure.
 

  Note
"Device Library" DVD

The "Device Library" DVD is supplied with SIMATIC PDM. Select the drive containing the 
DVD.

 

– Click the "OK" button.
The device descriptions found are displayed in the "Devices" list.
You can find additional information on this in the section "Device list (Page 32)".
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5. Select the check boxes for the devices whose device descriptions are to be integrated. The 
check box is automatically selected for devices that have not been integrated or have been 
integrated with an older version. You can work with a split device list window (Page 47).

6. Select the menu command Catalog > Integrate... .
The device descriptions are transferred to the PC.

 

  Note
During the device description integration

Do not open any SIMATIC programs until the device description integration has completed.
 

Completing the information for a device description
If information is missing from a device description, e.g. regarding the classification, you can 
add this information yourself. You can find information on this in the section "How to complete 
a device description (Page 40)".

Additional information
● Section "Delivery contents (Page 20)"

● Section "Messages (Page 43)"

● Section "Checking the device integration (Page 74)"

● Section "Replacing devices (Page 96)"

5.4.2 How to complete a device description
If the software detects that information is missing in a device description during its import, the 
"Device info incomplete" icon appears in the status column of the device list.

Recommendation:
Each device description marked in this way should be completed before it is integrated in 
SIMATIC PDM.

 

 Note
Completing device information at a later date

If you need to complete any device information at a later date then please follow the procedure 
below.
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Procedure
1. Select an incomplete device description and then select the Complete device 

information ...  command in the shortcut menu.
Complete the device description.

2. Click "OK".
 

  Note
Saving the changes
● If the device description is located on a read-only medium, changes cannot be made. 

In this case, copy the device description to a medium that is not write-protected and 
start the process again.

● The changes will remain available in the Device Integration Manager until the dialog 
box is closed. When you click the "OK" button, the changes are applied to the device 
description.

 

3. Click "Integrate".
The integration of the device description is performed.

Additional information
You can find information on the device list entries in the section "Device list (Page 32)".

5.4.3 How to create your own device library using the project filter
You use the following procedure to create your own device library using the project filter.

Project filter
Information on the project filter and its application is available in the section "Applying a project 
filter (Page 51)".

Basic procedure
1. Read in device descriptions of a standard library.

2. Apply the project filter.

3. Run the Catalog > Create own device library... menu command.

4. Enter the destination path in the "Create own device library... " dialog box.

5. Enter the device library name or version identification of the device library.
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 Note
Devices without help files

If you are using a device without help files, you can integrate the help files at a later time. To 
do this, answer the "Missing Help Files" dialog box with "Yes".

 

Additional information
Section "How to integrate a device description (Page 38)"

See also
Basis for using intelligent field devices (Page 12)

5.4.4 How to create your own device library from a collection of device descriptions
You use the following procedure to create your own device library from a collection of device 
descriptions.

Collection of device descriptions
You can find information about the availability of device descriptions and their application in 
the section "Basis for using intelligent field devices (Page 12)".

Basic procedure
1. Read in device descriptions of a standard library.

2. Select the check boxes for the device descriptions required in your own device library

3. Run the Catalog > Create own device library... menu command.

4. Enter the destination path in the "Create own device library... " dialog box.

5. Enter the device library name or version identification of the device library.
 

 Note
Devices without help files

If you are using a device without help files, you can integrate the help files at a later time. To 
do this, answer the "Missing Help Files" dialog box with "Yes".

 

Additional information
Section "How to integrate a device description (Page 38)"
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5.4.5 How to remove integrated device descriptions

Shortcut menu
If you select objects in the list of integrated device descriptions, you can use the shortcut menu 
to remove the device description:

Remove integrated device description(s) 

Delete the selected objects from the list of integrated device descriptions via this menu 
command. The selected objects are also deleted from the catalog.

5.4.6 Update/upgrade of device descriptions (EDD update)

Basic procedure
1. Check the version of the integrated device descriptions.

You can find information on this in the section "Device list (Page 32)". 

2. Read in the new device descriptions and compare the new version to the integrated version.
You can find information on this in the section "Read device descriptions from source 
folder... (Page 44)".

3. Select the required device descriptions and integrate the device descriptions. The check 
box is automatically selected for devices that have not been integrated or have been 
integrated with an older version.
Information on this is available in the section "How to integrate a device description 
(Page 38)".

See also
Download to device (Page 173)

5.4.7 Messages

Message log
If errors occur during the actions or in the application of the Device Integration Manager, they 
are shown in the message log. The message log opens automatically when a warning or an 
error has occurred, but it can also be opened manually from any node in the device list. In this 
case, all messages of the nodes under this in the hierarchical order are displayed.

Additional information
Section "Message log (Page 121)"
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5.5 Menus and dialog boxes

5.5.1 File

5.5.1.1 Read device descriptions from source folder...
Before devices can be configured in SIMATIC PDM, the associated device description files 
need to be read in using the Device Integration Manager. 

Requirement
You have access to the storage paths of the device description files.

Procedure
1. Select the menu command File > Read in device description files from folder....

In the tree structure, navigate to the storage path where the device description files are 
saved.

2. Click "OK".
The device description files are read in.

 

  Note

If the compressed file is password-protected, you will see a dialog in which you enter the 
password.

 

Shortcut menu
If you select objects in the list of read in device descriptions, you will find the following via the 
object-dependent shortcut menu commands below:

● Messages (Page 43)    
Open the message log via this menu command.

● Complete the device information ... (Page 49)    
Open the "Complete device information..." dialog box via this menu command.

5.5.1.2 Read in device descriptions from compressed archive...
Before devices can be configured in SIMATIC PDM, the associated device description files 
need to be read in using the Device Integration Manager. 

Requirement
You have access to the storage paths of the device description files.
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Procedure
1. Select the menu command File > Read in device description files from compressed 

archive....
In the tree structure, navigate to the storage path where the device description files are 
saved.

2. Click "OK".
The device description files are read in.

 

  Note

If the compressed file is password-protected, you will see a dialog in which you enter the 
password.

 

Shortcut menu
If you select objects in the list of read in device descriptions, you will find the following via the 
object-dependent shortcut menu commands below:

● Messages (Page 43)    
Open the message log via this menu command.

● Complete the device information ... (Page 49)    
Open the "Complete device information..." dialog box via this menu command.

5.5.1.3 Reading in the list of integrated device descriptions

Displaying the device list
Displays the devices for which a device description file is saved on the PC.

Shortcut menu
If you select objects in the list of integrated device descriptions, you will find the following via 
the object-dependent shortcut menu commands below:

● Messages ... (Page 52)    
Open the message log via this menu command.

● Remove integrated device description(s)  (Page 43)
Delete the selected objects from the list of integrated device descriptions via this menu 
command.

See also
Complete the device information ... (Page 49)
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5.5.1.4 Reading in the list of integrated device descriptions

Displaying the device list
Display of the devices used in the project.

The status column (Page 32) indicates whether or not the corresponding device description is 
integrated on the computer.

Shortcut menu
If you select objects in the list of integrated device descriptions, you will find the following via 
the object-dependent shortcut menu commands below:

● Messages ... (Page 52)    
Open the message log via this menu command.

● Remove integrated device description(s) 
Delete the selected objects from the list of integrated device descriptions via this menu 
command.

See also
Complete the device information ... (Page 49)

How to remove integrated device descriptions (Page 43)

5.5.1.5 Save device list as ...

Saving the device list
Specify the storage location and file name for the file in which you want the device list to be 
saved.

5.5.1.6 Print device list
You can print the device list that is currently being displayed.
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Setting the printer options
 

 Note

Note the following:
● The printer options depend on your computer's operating system and on the printer being 

used.
● The file is sent to the default printer.
● If the printout has more than one page, two periods are printed after the page number in 

the bottom right corner of the page. The last page does not have these periods, indicating 
no more pages are to follow.

 

Procedure
1. Select the menu command File > Print device list or click the "Print" button.

The "Print" dialog box opens.

2. Select the required options.

3. Click "OK".

5.5.1.7 Deleting the device list
Clearing the displayed device list 

Example of application
Clearing the device list before reading in device descriptions again.    

5.5.1.8 Exit
Exits the "Device Integration Manager".   

5.5.2 View

5.5.2.1 Split device list window
The device list window is split or the split is removed.   
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When you select the menu command, the device list window is cut in half vertically. The right 
half shows an additional device list window with the same structure. This window includes all 
devices selected in the left device list window (check boxes are selected).

 

 Note

The line selected with the mouse is displayed with a blue background in the active window. 
The line has a gray background in the inactive window.

 

The check boxes in the left device list window are visible but cannot be operated. 

You can move the dividing line between the two device list windows with the mouse.  

The buttons for adding or removing selected individual devices or sub-trees are located 
between the two windows.  

The selection of devices in the device list window is used for
•    Integrating and 
•    Creating your own device library. 
With a device list window that is not split, a selection can be made by setting the check boxes 
in the line of the device.

Mouse operation
By selecting lines in the left device list window and pressing the  button, you add individual 
devices or sub-trees to the right device list window. By selecting lines in the right device list 
window and pressing the  button, you remove the previously added individual devices or 
sub-trees from the right device list window.

Keyboard operation
Use the SHIFT + > key and "<" keys on the keyboard to add or remove the selected devices 
in the right window. 

Rules for working with split device list windows
A filter is applied to both device list windows. 

Sorting can take place independently in each window. 

Searches are only conducted in the active window with the selected line having a blue 
background.

An export only includes the contents of the left window (with selection information).

Only one device list window is displayed after the Device Integration Manager is restarted.
 

 Note

You cannot split the device list window when the list of integrated or used devices is displayed.
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5.5.3 Catalog

5.5.3.1 Complete the device information ...

Modifying the information in a device description file
The table below shows the information that can be completed in the "Device Integration 
Manager" dialog box using the "Complete device information" function. 

Column Explanation
Device name You can modify the device name in this input box.
Name of the device 
version

You can modify the version of the device description in this input field.

Manufacturer Manufacturer of the field device
Type ID Identifier for a device type in hexadecimal format

You can find information on this in IEC 61804-3.
Device revision Identifier for a device revision
Communication Communication type for the connection to the field device.
Classification Class of the device - name of the object (e.g., SENSOR - FLOW - 

ULTRASONIC)
DD revision Version of the device description file

You can find information on this in IEC 61804-3.
EDD Name of the device version 

You can find information on this in IEC 61804-3.

5.5.3.2 Integrate
Use the menu command Catalog > Integrate to integrate the device description files of the 
devices into the device catalog of SIMATIC PDM for those devices with selected check boxes 
in the "Path" column of the device list.

Compiling device description files for SIMATIC PDM
You can find information about the possible settings in the description of the PDM setting in 
the section ""Device Integration Manager" tab (Page 186)".

Remove integrated device description(s)
Section "Reading in the list of integrated device descriptions (Page 45)"
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5.5.3.3 Own device library

Create own device library...
Use the menu command Catalog > Create own device library... to create your own device 
library. You can copy created device libraries, save them as compressed archive or burn them 
on DVD and read in and integrate them with the Device Integration Manager just like the 
SIMATIC PDM DVD "Device Library …".

Additional information
Information on creating a device library from a collection of device descriptions is available 
here (Page 42).

Information on creating a device library using a project filter is available here (Page 41).

"Create own device library..." dialog box
Procedure 

1. Select the menu command Catalog > Create own device library... .
The "Create own device library..." dialog box opens.

2. Enter the destination path, the name and a version identification of the device library.

3. Click "OK".

5.5.3.4 Filter file

Apply filter file...
Use the menu command Catalog > Apply filter file... to apply predefined filter files (device lists 
saved in XML format previously in the Device Integration Manager) to the device library.

The "Filter file" box is displayed underneath the "Source folder" box if a filter file is loaded.

"Apply filter file..." dialog box
Procedure

1. Select the menu command Catalog > Apply filter file... .
The "Apply filter file..." dialog box opens.

2. Select a file with an exported device list.

3. Click "OK".
The currently displayed device list is filtered as follows: 
•    Only devices that are read in and are included in the filter file are displayed. 
•    Only devices that are selected in the filter file can be selected for integration.
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Revoking file filter/project filter 
Use the menu command Catalog > Revoke file filter/project filter to stop the application of the 
filter file or of a project filter. The complete device list is displayed once again when you revoke 
the filter.

5.5.3.5 Project filter

Apply project filter...
Use the menu command Catalog > Apply project filter… to select a STEP 7 project or STEP 
7 multiproject to filter the device list for the components used in the project.

The "Project filter" box is displayed underneath the "Source folder" box if a project is loaded.

You can create a device DVD that is perfectly adapted to your project by combining the 
functions "Create own device library" and "Apply project filter".

 
 

 Note
Object status

Make sure that the status of each device in the project file is also integrated in the device 
library before you apply the project filter. You can determine this by the status icon in the 
"Icon" column of the device list. You can find a list of the icons under Device list (Page 32).

 

Additional information
Information on creating a device library using a project filter is available here (Page 41).

"Apply project filter..." dialog box

Requirement
A device list has been read in.

Applying a project filter
Procedure

1. Click the "Project filter" icon in the menu bar.
The "Open project" dialog box opens.

2. Select the required project in the "User project" tab.
If you want to open a multiproject, select the "Multiproject" tab.
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3. If the required project file is located on an external source, click the "Browse" button and 
navigate to the required path.

4. Confirm your entry by pressing "Enter".
The device list is searched and updated.

To revoke the filter, click   

Revoking file filter/project filter 
Use the menu command Catalog > Revoke file filter/project filter to stop the application of the 
filter file or of a project filter. The complete device list is displayed once again when you revoke 
the filter.

5.5.3.6 Messages ...
The menu command opens the "Messages" dialog box.

Additional information
Section "Message log (Page 121)"

5.5.3.7 Find

Using the Find function
You can find device description files via the menu command Catalog > Find.

 

"Find" dialog box
Procedure

1. Select the menu command Catalog > Find.
The "Find" dialog box opens.

2. Enter a string and define search options.

3. Click "Find".
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Settings in the "Find" dialog box
● Entry field with drop-down list

You can enter any string. You can search for this string.

● Check boxes

– Match case
The writing style of the string entered for an object in the device list is observed.

– Match entire cell contents
The entire string must match for an object in the device list.

– Search up
If this option is enabled, the search begins at the selected point and continues until the 
start of the device list. 
If this option is disabled, the search begins at the selected point and continues until the 
end of the device list. 

● "Find" button
The system searches through the displayed device list.

5.5.4 ? (Help)

5.5.4.1 Help
This menu command displays the Help on SIMATIC PDM. 

You can navigate to different help topics from the Table of Contents. The "Index" and "Find" 
functions enable you to display information on specific terms. 

5.5.4.2 About...
This menu command displays information about the version and the copyright.     
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Views 6
6.1 Introduction

PDM objects are displayed in the following views in SIMATIC Manager:

● Process devices plant view
The process devices plant view provides an overview of all configured devices in all 
configured networks.

● Process devices network view
 The plant topology can be mapped in the process devices network view. The depicted 
objects are links to the objects in the plant view.

● PDM objects can be configured with HW Config. Open the SIMATIC PDM shortcut menu 
to assign parameters.

● The network links to the PDM objects are also listed in NetPro.

Working with SIMATIC PDM
License keys are required to use SIMATIC PDM. Information is available in the file pdmbase-
readme.wri.
Recommendation: Before you assign parameters to a field device with SIMATIC PDM, check 
whether you can reach the required device.

Additional information
Section ""Settings" for the SIMATIC project (Page 70)"

6.2 Views in SIMATIC Manager

6.2.1 Process devices plant view
In SIMATIC Manager, you call the process devices plant view using the menu command View 
> Process devices plant view.

The process devices plant view provides an overview of all configured devices in all configured 
networks. This view is used to obtain a quick overview of the configured devices. You cannot 
configure new networks in this view.
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Additional information
Section ""Settings" for the SIMATIC project (Page 70)"

6.2.2 Process devices network view
In SIMATIC Manager, you call the process devices network view using the menu command 
View > Process devices network view.

The process devices network view displays the devices in groups according to the network 
topology. You can configure smaller projects directly in the process devices network view, for 
example, for end-to-end connections between a PC and a device in the factory.
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Additional information
● Section ""Settings" for the SIMATIC project (Page 70)"

6.2.3 Open SIMATIC PDM in the Process Devices - Plant View

Procedure
1. Select the View > Process devices plant view menu command in SIMATIC Manager. 

The process devices plant view opens.

2. Select the "Devices" object in the S7 project.
All available devices are displayed.

3. Double-click the desired object.
The desired object opens in SIMATIC PDM.

6.2.4 Project synchronization

HW Config
In the course of device configuration in HW Config, an image of the plant structure, including 
all devices which can be configured using SIMATIC PDM, is transferred from HW Config to 
the process devices network view. 

After saving in HW Config, the changes made to the devices are applied in the following views:

● Process devices network view

● Process devices plant view

Changes cannot be incorporated into the process devices view if the higher-level objects are 
linked with HW Config to an existing S7 station.
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6.3 Views in SIMATIC PDM

6.3.1 Main Window "SIMATIC PDM"

Introduction
The "SIMATIC PDM" main window remains on the screen throughout the work session and is 
partially or totally covered by other activated dialog windows.
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The main window is structured as follows:
Title bar (Page 59): The title bar shows the project name or the name of the object which was selected 
before SIMATIC PDM was called.
Menu bar (Page 59): The menu bar can be used to call SIMATIC PDM functions and manufacturer-
specific device functions.
Toolbar (Page 60): The toolbar enables certain menu commands to be accessed quickly.
Structure view (Page 61): The objects 
displayed depend on the object which was 
selected before SIMATIC PDM was started.

Parameter table (Page 62): The parameters for the 
object selected in the structure view are displayed in a 
table.

Status bar (Page 64): Contains information on processes currently being performed.

6.3.2 Title bar
The title bar shows the name of the object which was selected before SIMATIC PDM was 
called.

6.3.3 Menu bar

Structure
Below is an overview of the SIMATIC PDM menus.

Menu Submenu in parameter assignment mode
File ● Save (Page 137)

● Export... (Page 172)
● Import ... (Page 173)
● Print (Page 144)
● Exit (Page 145)

Device ● Download to device (Page 146)
● Upload to PG/PC (Page 148)
● Assign address and TAG (Page 153)
● Value comparison (Page 150)
● Object properties (Page 155)
● Change log (Page 158)

View ● Process variables (Page 162)
● Start LifeList  (Page 117)
● Trends (Page 163) (depends on device)

Diagnostics ● Update Status (Page 165)
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Menu Submenu in parameter assignment mode
Help ● Contents (Page 167)

● Help for device parameters (Page 168)
● About... (Page 168)
● Find... (Page 168)
● Document Manager (Page 168)
● Device manual (depends on device)

6.3.4 Toolbar
The toolbar is located below the menu bar and contains a number of icons with which you can 
quickly perform frequently used menu commands without having to open a menu and select 
the command. 

SIMATIC PDM mode Icons
Parameter assignment mode

Icons     
The icons are linked to the following commands:

Parameter assignment mode Menu command
Save (Page 137) 

Print (Page 144) 

Download to device (Page 173) 

Upload to PG/PC (Page 174) 

Value comparison (Page 150) 

Change log (Page 158) 

Process variables / Measured value display (depends on device) 
(Page 162) 
Update diagnostic status (Page 165) 

Start LifeList (Page 117) 

Find... (Page 168)

Contents (Page 167) 
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6.3.5 Structure view
The left-hand section of the main window in the structure view contains a tree structure. The 
objects displayed depend on the object which was selected before SIMATIC PDM was started.

● If a single field device was selected, it will be displayed in the structure view. You can find 
information on this in the section "Stand-alone device view (Page 65)".

● If a network or gateway (e.g. DP/PA-Link) was selected, the tree structure is displayed with 
the associated devices in the structure view. You can find information on this in the section 
"Multiple devices view (Page 66)".

Icons     
You will see the following status icons in front of the objects in the tree view:

Icon Meaning
The device has been loaded.

At least one parameter of the object has been changed.

The object is already open at another location (window or computer). 
The object is locked for editing in the current view.
The object is already open at another location (window or computer).
Another user is making changes to the object. 
At least one parameter of the object is defective.

Display
The following are displayed in the structure view:

● Objects with associated parameter groups

● Any available lower-level objects

The selected parameter group is displayed on a blue background. The parameter table shows 
the parameters of the selected parameter group. 

Objects that contain lower-level objects can be identified by the check boxes next to the object 
icon:

● Check box "+"

● Check box "-"
 

  Note

Generally speaking, the table is only opened down to the structure view. 

Move the parameter table in order to view all the general information for a device.
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6.3.6 Parameter table
 

The right pane of the main window is filled by the parameter table.

The parameter table shows a device's parameters in the order in which they are listed in the 
structure view. Unlike in the structure tree, no hierarchy is displayed here.

Device parameters
The parameters which can be edited depend on the device in question. Fields with a gray 
background cannot be edited.

Refer to the manufacturer device description for information on how to set the device 
parameters. 

Display of the parameter table
The following columns are displayed in the parameter table:

● Parameter (Page 62)

● Value (Page 62)

● Unit (Page 63)

● Status (Page 63)

Each parameter group starts with a header with the name of the group on a gray background. 
The indented header text indicates the classification level of the header. The parameter lines 
are positioned underneath the header.

Operator input
Any entries and changes made must be loaded to the devices in order for them to take effect.

If you click an object in the structure view, the associated parameters are displayed in the 
parameter table.

Additional information
● Section "Display in the views (Page 64)"

 

6.3.6.1 "Parameter" column of the parameter table
The names of the individual parameters are listed in the "Parameter" column.     

6.3.6.2 "Value" column of the parameter table
This column displays the value of the parameter whose name is in the "Name" (Page 62) 
column. This can be a numerical value, a physical unit, a status or a designation.       
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The "Value" box can only be edited if it has a white background. A box with a gray background 
indicates that the parameter is read-only and cannot be modified or written. 

● Right-click on the value to display a list of possible value settings for selection, provided 
that these value settings are specified in the device description.

● Enter a new value here or select a new setting from the drop-down list box.

Shortcut menu
Right-click inside the parameter table to open one of the following fields: 

● An information box is shown for static fields if the cursor is located over a parameter in the 
"Parameter" column.
Information is displayed to explain the meaning of the field or to explain the associated 
entry in the "Value" column.

● Selection of values from drop-down lists
The drop-down lists open where you select a corresponding value with the cursor and click 
on it.
Select the correct setting for your plant- and device-specific conditions.

● Shortcut menu for input boxes

Menu command Explanations/operating instructions
Minimum value ... Displays the minimum permitted value of the parameter. *) **)
Maximum value ... Displays the maximum permitted value of the parameter. *) **)
Default value ... Displays the default value of the parameter. *) **)
*) Click the value to transfer it to the parameter table.
**) There can be several minimum, maximum and default values.

6.3.6.3 "Unit" column of the parameter table
The "Unit" column displays the engineering unit of the numerical value present in the "Value" 
(Page 62) column.    

6.3.6.4 "Status" column of the parameter table
The "Status" column displays the status of the parameter whose name is in the "Name" 
(Page 62) column.       

The table below shows the icons that can be displayed here:

Icon Meaning Action that can trigger the 
status

- empty -
 

Value (Page 62) corresponds to the offline data storage 
system

Save

Initialization running or status "OK"
Value was never changed

Open new PDM object
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Icon Meaning Action that can trigger the 
status

The parameter has been changed by means of operator 
input, import, or internal methods.
Value was changed by user

Edit;
dialog boxes

The parameter could not be converted.
Value could not be converted following a change in the 
unit

Edit

A parameter's value is defective.
An illegal value was detected the validity check (e.g., 
value too high or too low)

Validity check of value

The parameter has been successfully loaded.
There is no difference between the loaded parameters 
and configured parameters

● Download to device
● Upload to PG/PC

The parameter cannot be loaded, as a communication 
error is present.
● Error message when downloading to the device
● Error message when uploading to PG/PC

● Download to device
● Upload to PG/PC

6.3.7 Status bar
The status bar is located at the bottom of the main window.   

Display 
The following information is provided in the status bar:

● Details of user currently working with SIMATIC PDM

● PDM object for which information is currently being displayed in the parameter list

● Diagnostics activated / deactivated

● Identity check activated / deactivated

● Processing status

● Connection status for the object currently selected in the tree structure

6.3.8 Display 

6.3.8.1 Display in the views

Operating principle
You can open SIMATIC PDM for a device from SIMATIC Manager or HW Config.
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After you open SIMATIC PDM, the table displays the values saved in the project. These values 
are projected values and default values of the object, which was selected before SIMATIC 
PDM was started.

All objects for which parameters can be assigned are displayed in the structure view, including 
the lower-level objects. Only the parameter table of the root object is initially displayed and 
can be edited (fields on white background). 

● Select an object in the structure view; its parameters are then shown in the parameter table, 
where they can be edited.

●  If an object has already been opened by a different user, a message is displayed to 
identify the corresponding user and the PC where the object was opened. All fields of the 
parameter table then have a gray background and cannot be modified.

 

  Note

Changes made to an object opened in SIMATIC PDM only take effect when you select 
the menu command File > Save.

 

The displays in the status bar and title bar depend on the object you have currently selected. 

Setting options for SIMATIC PDM
You can find information on this in the section "Settings for SIMATIC PDM (Page 183)".

6.3.8.2 Stand-alone device view
SIMATIC PDM is opened in the stand-alone device view if a device was selected before 
SIMATIC PDM was started. The device represents the base of the tree in the structure view. 

The main window is structured as follows:
Title bar
Menu bar
Toolbar

Parameter table (on the right in the main 
window)

Status bar
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Additional information
● Section "Main Window "SIMATIC PDM" (Page 58)"

6.3.8.3 Multiple devices view
SIMATIC PDM is opened in the multiple device view if an object with lower-level objects was 
selected before SIMATIC PDM was started, e.g. an ET 200 station with connected field 
devices. The object represents the base of the tree in the structure view.

The main window is structured as follows:
Title bar
Menu bar
Toolbar

Parameter table (on the right in the main 
window)

Status bar

Display
When the multiple device view is opened, only the parameter table of the root object is 
displayed at first. You can edit all the displayed objects and their lower-level objects without 
opening SIMATIC PDM again. 

Additional information
● Section "Main Window "SIMATIC PDM" (Page 58)"

6.3.9 Keyboard operation

Key shortcuts
The tables below list the key shortcuts.
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Selecting menus via keys   

Key shortcut Function
<CTRL + S> Save (File menu) (Page 137) 
<CTRL + P> Print... (File menu) (Page 144) 
<Alt + X> For the menu which contains the underscored letter X
Underscored letter in 
the menu command

Assigned menu command

Key operation in dialog boxes     

Key shortcut Function
<Tab> To the next input field (left to right and top to bottom).
Arrow keys Selected in the drop-down list box.
Spacebar Selects an object or cancels a selection.

Key operation in help programs

Key shortcut Function
<Alt + F4> Closes the help window, return to the tool window

Selecting menu commands using shortcut keys
You can execute many menu commands by pressing the associated ALT key shortcut. Press 
the following keys in succession:

1. <Alt> key

2. The underscored letter of the required menu (e.g. <Alt>, <D> for the File menu - if the menu 
bar contains a File command). The menu opens.

3. Letter that is underlined in the desired menu command.
The submenus of the corresponding menu commands will be opened in the next steps. 
Repeat these actions until you have selected the entire menu command by typing in the 
relevant letters. 
You trigger the menu command as soon as you have entered the last letter of the shortcut 
keys. 

Example

Menu Key shortcut
File <Alt> + <D>
Help <Alt> + <H>
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Functions 7
7.1 Introduction

Before you can work with SIMATIC PDM, a project containing at least one PDM object must 
have been created in SIMATIC Manager. In the following, the term "PDM object" is used to 
refer to those objects that can be configured, have parameters assigned, or be diagnosed with 
SIMATIC PDM. PDM objects include:

● Field devices

● Remote I/O stations (with/without modules or field devices)

● Networks containing field devices

Information about the creation process
● For information on creating a project, refer to the PCS 7/STEP 7 help.

● For information on creating PDM objects, please refer to the section "Inserting devices 
(Page 77)".

Requirements for working with SIMATIC PDM
● SIMATIC PDM is installed.

● The necessary license keys are available.

● The device descriptions have been integrated.

● For online functions to work there must be a connection to the corresponding network. You 
can find additional information on this in the section "Establishing connections to field 
devices (Page 13)".

Calling SIMATIC PDM

Where Requirement Function
SIMATIC Manager 
● Process devices network view
● Process devices plant view

Project containing PDM object has 
been created
Select object 

Edit > Open object

HW Config Device created Double-click device
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Scope of functions
● Configuration and parameter assignment

– Integrating field devices into plants and networks

– Making project engineering settings for and configuring connections

– Making project engineering settings for and configuring devices

● Mini control and monitoring system for field devices

– Controlling and monitoring field devices

● Diagnostics

– Performing diagnostics on field device functions

– Performing diagnostics on networks

– Evaluating logs

Hardware configurations
Integration into a SIMATIC project enables you to create SIMATIC stations and field devices 
in HW Config. You can open SIMATIC PDM directly on the networks and subordinate field 
devices listed below:

● PROFIBUS DP

● PROFIBUS PA

● PROFINET IO

● FOUNDATION Fieldbus

Assigning parameters and loading
● In the case of offline parameter assignment, data relating to entries and changes made in 

SIMATIC PDM is saved in the project data. The inputs and changes will only become active 
after uploading the project data to the device.

● The option for online parameter assignment depends on the device and must be stored in 
the device description. Entries and changes made in SIMATIC PDM must be loaded into 
the project.

7.2 Project editing

7.2.1 "Settings" for the SIMATIC project
You will find the following views in SIMATIC Manager after the installation of SIMATIC PDM:

● Process devices plant view

● Process devices network view
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Project settings
The project settings are made in the SIMATIC Manager. These settings apply to the SIMATIC 
project and SIMATIC PDM.

● Language for the menus and dialog boxes

● Default project view

● Display

● Details in the columns

Project settings
You make the project settings in SIMATIC Manager using the following menu command: 
Options > Settings ... .

Settings Tab  
Language selection
 

"Language" tab Language displayed in the menus and dialog 
boxes in the SIMATIC Manager and SIMATIC 
PDM

Default project view
 

"View" tab Start view for the SIMATIC Manager; 
available views for SIMATIC PDM:
● Process devices plant view
● Process devices network view

Details in the columns
 

"Columns" tab Views and object types in the parameter table

"Columns" tab
On the "Columns" tab, you can select the columns that you want to be displayed in a PDM 
view.

Select an object type in the tree structure. Then go to the "Visible Columns" list and activate 
the check boxes for the entries you want to be displayed for the selected object type.

Object types

● Type 1 in the tree structure

– Process devices plant view

– Process devices network view

● Type 2 in the tree structure

– Process devices plant view > Devices

● Type 3

– Process devices network view > Networks
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● Type 4

– Process devices network view > Networks > PC

● Type 5

– Process devices network view > Networks > Communications network

– Process devices network view > Networks > Communications network > Object (on all 
subordinate levels)

 Visible columns
Object type Type 1 Type 2 Type 3 Type 4 Type 5
Object name Standard Standard Standard Standard Standard
Picture Name For OS Standard     
LID
(Location identifier denotes the 
installation position of a device)

 Standard    

Address  x  Standard Standard
Description Standard Standard Standard Standard Standard
Message Standard Standard Standard Standard Standard
Device status  Standard   Standard
Last communication  Standard   Standard
Text1 x x x x x
Text2 x x x x x
Text3 x x x x x
Device  Standard x x Standard
PLT ID
(process control ID generated 
internally by PDM for 
identification of an object for 
connections to the Asset 
Management System (PCS 7 
Maintenance Station and PDM 
Maintenance Station))

 Standard   x

Manufacturer  Standard   Standard
Serial number  x   x
Install date  x   x
Hardware version  x   x
Software version  x   x
Order number  x   x
Object status  Standard   Standard
DD revision  x   x
Author x x x x x
Revision date Standard Standard Standard Standard Standard
Comment x x x x x
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● Type 6

– Settings for a multiproject

 Process devices plant view (multiproject) Process devices network view (multiproject)
Object type   
Object name Standard Standard
Project language Standard Standard
UNC path Standard Standard
Path to "Computer" Standard Standard
Computer Standard Standard
Computer after removal Standard Standard
Path after removal Standard Standard

See also
Settings for SIMATIC PDM (Page 183)

Menus and dialog boxes for SIMATIC PDM in the SIMATIC Manager (Page 169)

7.2.2 Setting the interface on the computer
Use the interface settings of the project (SIMATIC PCS 7 or SIMATIC STEP 7).

The following interface types are used in SIMATIC PCS 7 and SIMATIC STEP 7:

● PROFIBUS DP interface

● Ethernet interface

Alternative communication channels in the case of redundant S7-400 stations
If SIMATIC PDM signals a connection failure due to a fault in the communication channel, an 
attempt is made to automatically establish a connection using the redundant S7-400 station 
via an alternative communication channel.

7.2.3 Plant-wide communication by means of routing

Overview   
In most automation systems, the programming device can only be operated via the bus cable 
(subnet) connected directly to the automation system. On larger networked plants you must 
connect the programming device to different bus cables (subnets) before you can go online to 
a remote automation system.
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Routing function
The routing function allows you to reach automation systems online across subnet boundaries 
from a central point (Engineering Station) with the programming device or PC, in order, for 
example, to download user programs or a hardware configuration or to perform test functions. 

Requirements
The following conditions must be met for S7 routing: 

● STEP 7 as of version 5.5 and SIMATIC PDM, i.e. SIMATIC PDM integrated.

● The communication-capable modules (CPUs or CPs) which establish gateways between 
subnets must support "S7 routing".

● All the automation devices or communications partners that can be reached in a plant 
network are configured and downloaded within an S7 project.

● The SIMATIC S7 station required is networked and can be reached via the network nodes.

● The last communication interface (CPU, CP) supports the "Dataset gateway" function.

● The modules are downloaded together with the configuration information, which contains 
the current "knowledge" on the complete network configuration of the project.
Reason: All the modules involved in the gateway must receive information on which subnets 
can be reached over which routes (routing tables).

● The programming device or PC to which you want to establish an online connection via a 
gateway is configured in the network configuration and assigned to your programming 
device.

Additional information
SIMATIC documentation; SIMATIC PDM; pdm-readme

7.2.4 Checking the device integration
You can check in a project whether the required device descriptions are integrated for all 
objects to be displayed in SIMATIC PDM. 

These situations serve as examples for this:

● A project has been copied to the PDM computer.

● Device descriptions have been deleted on the computer.

● A computer has been reinstalled and the device descriptions were not integrated.

Requirement
SIMATIC PDM is installed.
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Procedure
1. Open the process devices plant view in SIMATIC Manager.

2. Open the "Devices" folder in the tree view.

3. Check whether devices are there that are labeled as follows:

Icon Meaning Note
Deactivated No device description is integrated in SIMATIC PDM for the 

device.

4. If deactivated devices have been found, select the View > Details menu command.

5. Check the information in the "Object name" column.

Information in the "Object 
name" column

Meaning Further procedure

"TAG" or "Default" A device description from the 
device catalog has not yet 
been assigned to the device.

Assign the required device description to 
the device. 
Section "Device selection (Reassign) 
(Page 175)" 

Plant-specific object 
name

The device description that has 
been assigned to the device 
cannot be found or is no longer 
functional (e.g. accidentally 
deleted). 

Integrate the required device description.
Section "How to integrate a device 
description (Page 38)"

Additional information
● Section "Overview of Device Icons (Page 114)"

● Section "Replacing devices (Page 96)"

● Section "How to complete a device description (Page 40)"

● Section "Cleaning the project (reorganization)  (Page 76)"

7.2.5 Print
You can print out the parameter list for a device. 

"Print" button
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Setting the printer options
 

 Note

Note the following:
● The printer options depend on your computer's operating system and on the printer being 

used.
● The file is sent to the default printer.
● If the printout has more than one page, two periods are printed after the page number in 

the bottom right corner of the page. The last page does not have these periods, indicating 
no more pages are to follow.

 

Requirements
● SIMATIC PDM is open.

● In the structure view, an object is selected in the master folder of a device.
You can find information on the structure view in the section titled "Stand-alone device 
view (Page 65)".

Procedure
1. Select the menu command File > Print or click the "Print" button.

The "Print" dialog box opens.

2. Select the required options.

3. Click "OK".

7.2.6 Cleaning the project (reorganization) 
PDM objects may be contained in copied SIMATIC projects. If SIMATIC PDM is no longer 
used in the project, you can remove the requirement for tag licenses in the project using the 
"Reorganize" function. 

 

 Note

SIMATIC PDM must be closed before you use the "Reorganize" function.

The time it takes to perform reorganization depends on the data movement required, and it 
can be a long time. The function is therefore not carried out automatically (for example, when 
closing a project).
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Procedure
1. In SIMATIC Manager, select the menu command File > Reorganize.

7.2.7 Saving the configuration
Changes that are made with SIMATIC PDM are always stored in the SIMATIC project.

You must save the SIMATIC project to save the changes. You must stop SIMATIC PDM before 
you save an entire SIMATIC project.

(Menu command File > Save As). 

Procedure
1. Select the menu command File > Save As in the SIMATIC Manager.

Additional information
● STEP 7 Online Help

● PCS 7 Online Help

 

7.3 Device management 

7.3.1 Inserting devices

7.3.1.1 How to insert objects
You can use the "Insert New Object" function to perform the following:

● Create networks, including network components

● Insert objects into a configured network:

– Insert an individual device or module

– Insert multiple devices or modules at the same time
 

  Note

This function is only available for the following devices:
● PROFIBUS devices
● PROFINET devices
● HART devices downstream of a remote I/O
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Configure FOUNDATION fieldbus devices in HW Config.

Requirements
● The project is open in the process devices network view.  

● The PDM folder called "Networks" is available in the tree structure. 
If the folder structure has not yet been created, select the menu command Insert New Object 
followed by Networks.

 

  Note

Licenses for SIMATIC PDM are required for further processing.
Without license keys, you can configure a maximum of 4 devices (demo mode).

 

Inserting a network, a header module, modules, and a field device
Follow the steps below to insert objects into higher-level objects one after the other. You will 
find more information on object types that can be inserted in an object in the section ""Insert 
Object - Assign Device Type" dialog box (Page 79) ". 

1. Select the higher-level object in the tree structure in the window on the left.

2. In the shortcut menu, select the menu command Insert New Object > Object. 
The "Insert Object - <...>" dialog box opens.

3. Make the relevant settings for the inserted object. You can find information on this in the 
section ""Insert Object - <...>" dialog box (Page 79)"

– "Object name" input box

– "<Address>" input box (e.g. PROFIBUS address or PROFINET IP address)

– "Number" input box

4. Click the "Assign Device Type" button. 
The "Insert Object - Assign Device Type" dialog box opens.
You can find additional information on this in the section ""Insert Object - Assign Device 
Type" dialog box (Page 79)".

5. Select the object to be added from the tree structure.

6. Click "OK".
The objects are inserted.

7. Correct the assigned addresses if necessary.
Additional information on this can be found in the section "Setting the bus address in HW 
Config (Page 92)".

Additional information
Section "Device selection (Reassign) (Page 175)".
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7.3.1.2 "Insert Object - <...>" dialog box
Make the settings for inserted objects in the "Insert Object - <...>" dialog box.

Setting parameters
You must set the following parameters in order to insert objects:

● Object name
Specify the name of the inserted object.
The entered name is the base name when creating several objects.

● <Address> (e.g. PROFIBUS address or PROFINET IP address)
(Note: This setting cannot be changed when adding HART devices)

– Enter the address for the inserted object.

– If you wish to create multiple objects, enter the first address of the objects to be inserted.

● Number 
(Note: This setting cannot be changed when adding HART devices)
Adjust the number of objects to be added when adding several objects. Please note that 
the value depends on the network being used and other factors.
A certain number (n) of objects of one type is created in accordance with these parameters. 
The object name is generated as follows:

– If the number is equal to 1, the address does not appear in the object name that is 
generated (´<name>).
<name><address>

– If the number is greater than 1:

PROFIBUS devices and modules Channels of remote I/O
<address><name> <name><address>
... ...
<address +(n*-1)><name> <name><address +(n*-1)> 
*: n corresponds to the number of objects to be inserted

"Assign Device Type" button
The "Insert Object - Assign Device Type" dialog box opens.
Assign a specific object type to the object you want to insert into the project. The possible 
object types are listed in the tree structure. The object types displayed depend on the location 
at which an object was inserted. 

7.3.1.3 "Insert Object - Assign Device Type" dialog box
Select the device description file of the desired device in this dialog box. 

Functions
7.3 Device management 

Help for SIMATIC PDM (V8.0.2)
Operating Manual, 12/2012, A5E03515631-02 79



The devices are structured by the device types in a tree structure. 
 

 Note
Integrated devices

You can only select devices for which a device description file has been integrated via the 
Device Integration Manager.

 

Object types
When assigning objects, select the object type. The following object types can be assigned, 
depending on the nature of the higher-level object:

Higher-level object Object to be inserted
PDM "Networks" folder Communications network

● As part of the assignment process, select the 
communications network via which the PDM objects 
are to be connected.

● Selection:
– PROFIBUS DP network
– PROFIBUS link
– PROFINET network
– Foundation Fieldbus network

Header module 
● Selection:

– Remote I/O
– PROFIBUS Link
– PROFIBUS DP device
– PROFIBUS PA device

Remote I/O Modules 
● Selection:

– Module
Modules 
● Selection:

– Module

Field device 
● <HART device>

"Device identification" Button
When you click this button, a connection to the device is established and an attempt is made 
to read the information from the device. If not all the required information could be read out, 
only the structures necessary for the device will remain in the tree structure. Make your 
selection from these structures. 

Device identification procedure:

● for PA devices
Select the "PROFIBUS PA" folder and then press the "Device identification" button

● for DP devices
Select the "PROFIBUS DP" folder and then press the "Device identification" button

● for HART devices
Select the "HART" folder and then press the "Device identification" button
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Additional information
● Section "Integrating devices into SIMATIC PDM (Page 27)"

7.3.1.4 HART device on remote I/O
You can connect the HART devices to a suitable remote I/O module.

Remote I/O with HART devices (PROFIBUS DP)

Creating the PDM basic folder called "Networks"
1. Open the process devices network view in SIMATIC Manager.

2. If the "Networks" object has not been inserted in the tree structure, select the menu 
command Insert New Object and select the "Networks" object.

 

  Note
PDM basic folder called "Networks"

SIMATIC PDM licenses must be available in the project when this folder is created.
 

Creating a communications network
1. Open the process devices network view in SIMATIC Manager.

2. Select the "Networks" folder in the tree structure in the left window and select the Insert 
New Object > Object command from the shortcut menu.
The "Insert Object - <...>" dialog box opens.

3. Click the "Assign Device Type" button.
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Inserting an object (creating a communications network; remote I/O, module, and HART device)
Follow the steps below to insert objects into higher-level objects one after the other.

Higher-level object Object to be inserted
"Networks" folder Type of network via which the field devices are connected 

to the automation system (e.g. PROFIBUS DP network or 
PROFINET).

PROFIBUS DP network Header module (selection: remote I/O)
Header module (selection: remote I/O) Modules (selection: module)
Modules (selection: module) Field device (selection: HART device)

1. Select the higher-level object in the tree structure in the window on the left.

2. In the shortcut menu, select the menu command Insert New Object > Object. 
The "Insert Object - <...>" dialog box opens.

3. Apply the following settings to the inserted object.
You can find additional information on this in the section "How to insert objects (Page 77)".

4. Select the object. In the shortcut menu, select the menu command Object Properties.
The dialog box "<Inserted Object> Properties" opens.

5. Select the "Communication" tab.

6. Apply the following settings to the input boxes:

– For the remote I/O: Enter the PROFIBUS address or the PROFINET IP address.

– For the module (HART module): Enter the slot.

– For the HART device: Do not make changes to the channel settings.

7. Repeat these steps until all remote I/O, modules, and HART devices have been added.

Configuring devices with SIMATIC PDM
1. In the process devices network view, select the PROFIBUS DP network or the PROFINET 

network which is of a higher level than the added HART devices.

2. In the shortcut menu, select the menu command Open Object.
SIMATIC PDM opens and the PROFIBUS DP network or the PROFINET network is 
depicted in the structure view.
The remote I/O, modules, and HART devices are listed when the tree structure is opened.

3. Assign a function individually to the added objects (corresponding with the actual 
configuration in HW Config and the connected equipment):

– Open the object by selecting its icon in the structure view.

– Select the parameters required for the function from the parameter table.
Apply the required settings and save the object.

 

  Note

Objects can be detected automatically if an online connection exists to the devices. 
The automatic detection of the modules depends on the type of remote I/O, the 
modules used, and on the device description.
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Uploading
The configuration and parameters are transferred by selecting the "<Remote I/O>" object and 
then selecting the Device > Upload to PC/PG... menu command.

 

 Note
Slot function settings

The automatic detection of the <modules> depends on the type of <remote I/O>, the 
<modules>, and the device description.

 

Configure lower-level objects
There may be instances where you have to assign a specific device from the catalog to an 
object before you can configure lower-level objects. You have to start SIMATIC PDM for the 
object to make the assignment (context-sensitive menu command "Open object").

Example: 

You insert a remote I/O and assign the respective device to it, for example, an ET 200iSP 
header module. Then, you configure the remote I/O module. Only after you have assigned a 
HART-capable module to this module can you insert a channel and a HART device. The pre-
defined module "unused slot" cannot include HART devices or channels.

7.3.1.5 Compact PROFIBUS device (sensors and actuators)

Procedure             
To integrate a PROFIBUS device (PROFIBUS DP device, PROFIBUS PA device or 
PROFIBUS remote I/O), proceed as follows: 
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Creating a network
1. Open the process devices network view in SIMATIC Manager.

2. Select the "Networks" folder in the tree structure in the left window and select the Insert 
New Object > Object command from the shortcut menu.
The "Insert Object" dialog box opens.

3. Click the "Assign Device Type" button.

Inserting a PROFIBUS device or remote I/O
Follow the steps below to insert objects into higher-level objects one after the other.

Higher-level object Object to be inserted
"Networks" folder Type of network via which the field devices are connected 

to the automation system (e.g. PROFIBUS DP network).
PROFIBUS DP network PROFIBUS DP device / PROFIBUS PA device
Header module (selection: remote I/O) Modules (selection: module)
Modules (selection: module) Field device (selection: HART device)

1. Select the higher-level object in the tree structure in the window on the right.

2. In the shortcut menu, select the menu command Insert New Object > Object. 
The dialog box "<... SIMATIC PDM – Insert Object(s)" opens.

3. In the dialog box that opens, enter the name of the process tag.
 

  Note

Configure the PROFIBUS PA devices directly on the PROFIBUS network if you are using 
a PROFIBUS DP/PA coupler. The coupler itself is not configured (the DP/PA couplers 
with diagnostic capability as of 6ES7157-0AC84-0XA0 can be configured as a stand-alone 
device).

 

4. Alternatively, you can add a PROFIBUS-Link (Y-Link or DP/PA-Link) to a PROFIBUS DP 
network. Downstream of the PROFIBUS-Link , you can then insert PROFIBUS devices, 
but not another PROFIBUS-Link .

 

  Note

The address of the PROFIBUS device that you set in the "Insert SIMATIC PDM Object(s)" 
dialog box can be changed afterwards on the "Communication" tab of the "Object 
Properties" dialog box.

 

Configuring devices with SIMATIC PDM
1. Select the inserted PROFIBUS device in the process devices network view.

2. Select the Open Object command from the shortcut menu.
SIMATIC PDM opens and the PROFIBUS device is shown in the structure view.

Functions
7.3 Device management 

Help for SIMATIC PDM (V8.0.2)
84 Operating Manual, 12/2012, A5E03515631-02



3. Set the required parameters for the function in the parameter table.

4. Make the necessary settings and save the object.

7.3.1.6 Modular PROFIBUS device (remote I/O)

Creating a network
1. Open the process devices network view in SIMATIC Manager.

2. Double-click the "Networks" object in the right window to insert a PROFIBUS DP network. 
Select the "Networks" folder in the left window, and select the Insert New Object > 
Communications Network command in the shortcut menu.
The "Insert Object(s) - <...>" dialog box opens.

3. Click the "Assign device type" button.
The "Insert Object - Assign Device Type" dialog box opens.
You can find additional information on this in the section ""Insert Object - Assign Device 
Type" dialog box (Page 79)".

4. Select the PROFIBUS DP network from the tree structure.

5. Click "OK".
The PROFIBUS DP network is inserted.

Adding remote I/O, module, and PROFIBUS device
Follow the steps below to insert objects into higher-level objects one after the other.

Higher-level object Object to be inserted
PROFIBUS DP network Header module (selection: remote I/O)
Header module (selection: remote I/O) Modules (selection: module)
Modules (selection: module) Field device (selection: PROFIBUS device)

 

1. Select the higher-level object in the tree structure in the window on the left.

2. In the shortcut menu, select the menu command Insert New Object > Object. 
The "Insert Object(s) - <...>" dialog box opens.

3. Make the following settings for the inserted object. 
You can find additional information on this in the section "How to insert objects (Page 77)".

4. Select the object. Select the Object properties command in the shortcut menu.
The "Properties - <Inserted object>" dialog box opens.

5. Select the "Communication" tab.
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6. Make the necessary settings depending on the inserted object in the input fields:

– Remote I/O: Enter the PROFIBUS address.

– Module (device module): Enter the slot.

– PROFIBUS devices: Do not make changes to the channel settings.

7. Repeat these steps until all remote I/Os, modules, and PROFIBUS devices have been 
added.

Configuring devices with SIMATIC PDM
1. Select the PROFIBUS DP network in the process devices network view, which is of a higher 

level than the added PROFIBUS devices.

2. Select the Open object command in the shortcut menu.
SIMATIC PDM opens. The PROFIBUS DP network is represented in the structure view.
You can find the remote I/Os, modules and PROFIBUS devices by opening the tree 
structure.

3. Assign a function individually to the added objects (corresponding with the actual 
configuration in HW Config and the connected equipment):

– Open the object by selecting its icon in the structure view.

– Select the parameters required for the function in the parameter table. 
Make the required settings and save the object.

Downloading
The configuration and parameters are transferred by selecting the "<Remote I/O>" object and 
then selecting the Device > Upload to PC/PG... menu command.

 

 Note
Slot function settings

The automatic detection of the <modules> depends on the type of <remote I/O>, the 
<modules>, and the device description.
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7.3.1.7 Connecting a field device to PROFINET

Procedure             
To integrate distributed I/O devices (e.g. ET 200M) or links for connecting intelligent DP or PA 
field devices (e.g. IE/PB link) via PROFINET, follow these steps: 
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Creating a network
1. Open the process devices network view in SIMATIC Manager.

2. Select the "Networks" folder in the tree structure in the left window and select the Insert 
New Object > Object command from the shortcut menu.
The "Insert Object" dialog box opens.

3. Click the "Assign Device Type" button.

Inserting a field device or remote I/O
Follow the steps below to insert objects into higher-level objects one after the other.

Higher-level object Object to be inserted
"Networks" folder Type of network via which the field devices are connected 

to the automation system (e.g. PROFINET network).
PROFINET network Header module (selection: remote I/O)
Header module (selection: remote I/O) Modules (selection: module)
Modules (selection: module) Field device (selection:HART device)

1. Select the higher-level object in the tree structure in the window on the right.

2. In the shortcut menu, select the menu command Insert New Object > Object. 
The dialog box "<... SIMATIC PDM – Insert Object(s)" opens.

3. In the dialog box that opens, enter the name of the process tag.

Alternatively, you can add a IE/PB-Link  to a PROFINET network. Downstream of the IE/PB-
Link , you can then insert PROFIBUS devices. IE/PB-Links are only supported in HW Config 
in V8.0.

 

 Note

The address of the PROFINET device that you set in the "Insert SIMATIC PDM Object(s)" 
dialog box can be changed afterwards on the "Communication" tab of the "Object Properties" 
dialog box.

 

Configuring devices with SIMATIC PDM
1. Select the inserted PROFINET device in the process devices network view.

2. Select the Open Object command from the shortcut menu.
SIMATIC PDM opens and the PROFINET device is shown in the structure view.

3. Set the required parameters for the function in the parameter table.

4. Make the necessary settings and save the object.
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7.3.1.8 Integrating a device in HW Config
Below, you will learn how to insert devices in the project using HW Config: 

● Inserting a DP device

● Inserting a DP remote I/O system (distributed I/O)

● Inserting a PA device at a DP/PA coupler

● Inserting a PA device at a DP/PA-Link

● Inserting a PA remote I/O system (distributed I/O)

● Inserting a remote I/O system (PROFINET)

Requirement         
PROFIBUS DP master system or PROFINET IO system
Options for creating the PROFIBUS DP master system:

● In HW Config
If the DP master system is not displayed, select the menu command Insert > Master 
system at the required PROFIBUS module.

● In the process devices network view

– Open the process devices network view in SIMATIC Manager.

– Double-click the "Networks" object in the right window to insert a PROFIBUS DP 
network. Select "Networks" in the left window, and select the menu command Insert 
New Object > Object in the shortcut menu.

– Click the "Assign Device Type" button.
The "Insert object - Assign device type" dialog box opens.
You can find additional information on this in the section ""Insert Object - Assign Device 
Type" dialog box (Page 79)".

– Select the PROFIBUS DP network from the tree structure.

– Click "OK".
The PROFIBUS DP network is inserted.

 

  Note
Representation in HW Config

Objects created in the process devices network view are not displayed in HW Config.
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Inserting a DP device
PROFIBUS devices can be inserted directly into the PROFIBUS DP master system. 

1. Select the device you require under "PROFIBUS DP" in the hardware catalog and drag it 
onto the DP master system.

Inserting a DP remote I/O system (distributed I/O) 
Integration is described based on the example of ET 200iSP . 

1. Place the head-end station "IM152-1" you have selected from the hardware catalog under 
"PROFIBUS DP > ET200iSP" at the DP master system.
The slots of the head-end station are displayed in the detail view in the table below the 
graphic. 

2. You can insert the required analog and digital modules in slot 4 and higher.

Inserting a PA device at a DP/PA coupler 
1. Select a device in the PROFIBUS-PA folder of the hardware catalog.

This can be, for example, a SITRANS P pressure transmitter listed under "PROFIBUS-PA 
> Siemens > Sensors > Pressure > SITRANS P" or a device profile listed under "PROFIBUS-
PA > Other".

2. Position it at the PROFIBUS DP master system.
You have to select the device for some objects. You can find information on this in the 
section ""Insert Object - Assign Device Type" dialog box (Page 79)".

 

  Note

The DP/PA coupler does not need to be configured; you only need to set an appropriate 
bus transmission rate (for example, 45.45 kbps for the Siemens coupler) for the DP master 
system.

 

Inserting a PA device at a DP/PA-Link 
1. Place the "IM 153-2" you have selected from the hardware catalog under "PROFIBUS DP 

> DP/PA-Link" at the DP master system. (The IM 153-2 replaces the IM 157, but both types 
can be used as PROFIBUS-Link ).
HW Config creates a PA master system for the DP/PA-Link . 

2. Drag-and-drop the PA devices to this PA master system.
For certain objects it is necessary to select the device. For more information, refer to section 
""Insert Object - Assign Device Type" dialog box (Page 79)".
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Inserting a PA remote I/O system (distributed I/O) 
The integration is described using Pepperl + Fuchs as an example. 

1. You can find the "RSD-GW-EX1.PA" head-end station in the hardware catalog under 
"PROFIBUS-PA\REMOTE I/O\PEPPERL+FUCHS GmbH\ P+F I/O System".
Place the head-end station on the DP master system (with DP/PA coupler, see above) or 
on the PA master system (with DP/PA-Link, see above).
The slots of the head-end station are displayed in the detail view in the table below the 
graphic. 

2. Place one of the modules listed in the hardware catalog under "PROFIBUS-PA > P+F I/
O SYSTEM > RSD-GW-EX1.PA" in a free slot.

Inserting a remote I/O system (PROFINET) 
The integration is described using ET 200M as an example. 

1. Place the head-end station "IM153-4" you have selected from the hardware catalog under 
"PROFINET IO > I/O > ET200M" at the IO system.

2. The slots of the head-end station are displayed in the detail view in the table below the 
graphic. You can insert the required analog and digital modules in slot 4 and higher.

 

7.3.1.9 Integrating an FF field device
FF devices can be configured using SIMATIC PCS 7 from PCS 7 version 8.0 Update 1. 

Information on this can be found in the following documentation:
SIMATIC Process Control System PCS 7, PCS 7 - FOUNDATION Fieldbus

See also
“Interconnection Editor" dialog box (Page 100)

How to download objects in the FF segment (Page 102)

7.3.1.10 Inserting a HART device at a HART module
The integration procedure is explained using the example of a HART device on an ET 200iSP 
HART module:         

Inserting a HART device based on the example of an ET 200iSP HART module 
1. Position an "IM152-1" you have selected from the hardware catalog under "PROFIBUS DP

\ET 200iSP" at the DP master system.
The detail view in the table below the graphic object displays the slots of ET 200iSP. 

2. Insert a HART module "4  AI  2WIRE  HART" from the hardware catalog under 
"PROFIBUS DP\ET 200iSP\IM 152-1\AI", into a free slot.
The HART module with 4 channels is shown in the detail view. 
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3. Place the object listed in "...\AI\4  AI  2WIRE  HART\HART field device" in the detail view.
The PDM dialog "Device selection (Reassign) (Page 79)" opens.

4. Assign the device type to the inserted device (device description).

7.3.1.11 Setting the bus address in HW Config
Make sure the bus addresses of all field devices are entered correctly in HW Config. 

Bus addresses can only be set for field devices on a PROFIBUS network.

Procedure
Proceed as follows to edit the settings:

1. Select a field device in HW Config. In the shortcut menu, select the menu command Object 
Properties.
The "Properties - ..." dialog box opens.

2. Click the button for the associated bus system in the "Node/ ...system" area.
 The "Properties - ...interface <Field device>" dialog box opens.

3. Enter the desired bus address. 
HW Config automatically assigns addresses in the order that objects are created. You may 
need to correct these addresses, depending on the device used (refer to the device manual).
Click the "OK" button to save the address.

4. Click "OK" to close the "Properties - ..." dialog boxes.

5. Save the project with the menu command Station > Save.

7.3.2 Field devices with redundant bus connection 

7.3.2.1 Connecting field devices to a redundant bus system

Redundant connection of field devices with SIMATIC PDM
Some field devices allow redundant connection in the automation system. If information about 
this feature is stored in the device description, SIMATIC PDM can recognize this.

You can determine whether this feature can be configured in the "Properties" dialog box of the 
process devices network view. With these objects, you will see a "Redundancy" area in the 
"Communication" tab.
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Procedure
1. Configure an object for each of the bus addresses of a field device that can be connected 

redundantly.
 

  Note
Applying the configuration

You are allowed to fully configure one object only (this is referred to as the "master field 
device" in the following). The other object must not contain substructures. This also applies 
if redundant partners have been configured in HW Config. In the case of remote I/Os (e.g., 
P+F LB/FB RemoteIO), therefore, you should configure the modules in HW Config only 
after the redundancy selection.

For the second object, you only need to configure the bus address (this is referred to as 
the "partner field device" from this point forward). You can display only the master field 
device on the partner field device. You can find information on this in the section 
""Communication" tab (Page 157)".

 

2. Open the "Object Properties" dialog for the configured master field device in the process 
devices network view. 

3. Open the "Communication" tab.

4. In the "Redundancy" section, click "Select Object".
The list of configured devices opens.

5. Select the partner field device.

6. Click "OK".
The list of configured devices closes. The "Enable redundancy" check box is selected in 
the "Redundancy" section and the partner field device is displayed.

Result
The master is the object on which the substructures are displayed, and redundancy can be 
deactivated again (deactivation only works if the redundant partners have not been configured 
in HW Config). No substructures are displayed at the partner.

Canceling redundancy   
● Select the partner field device.

● The master maintains all substructures and loses its master status.

Additional information
● Section ""Select object" dialog box (Page 93)"

● Section ""Properties - Find object" dialog box (Page 94)"

7.3.2.2 "Select object" dialog box
Use this dialog box to select the required comparison objects or partner objects. 
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7.3.2.3 "Properties - Find object" dialog box
Some field devices can be connected to a redundant bus system. Two field device objects are 
created for these field devices.

The dialog box opens only if a partner object has been specified for the selected field device 
object.

 

 Note

The partner object is labeled in the table after the dialog box opens.
● The dialog box provides information only. 
● You cannot make any changes in it.

 

See also
Connecting field devices to a redundant bus system (Page 92)

7.3.3 Using unspecified PROFIBUS PA devices as placeholders
This method can be used to configure PROFIBUS devices in a system, even though the type 
of device is not yet set at the time of configuration.

Create a placeholder for unknown devices. You should know the profile of the device to be 
used as manufacturer information:

Device profiles:

● Profile3

● Profile I&M

Basic preparation
1. Insert a number of objects for PROFIBUS profile devices of the appropriate type at the 

desired address in the process devices network view in a PROFIBUS PA network. 
Examples:

– Sensor > Temperature > PROFILE3 > Profile3

– Siemens > SIEMENS > Profile I&M

2. Configure the ID data for the PROFIBUS devices in the object properties:

– TAG

– Description

– Message
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Commissioning PROFIBUS devices
1. Connect the PROFIBUS devices in the automation system.

2. Select a device configured as a placeholder in the process devices network view or in HW 
Config.

3. Download the configuration to the device (section "Download to device (Page 146)").

4. Assign the required device description to the device (section "Device selection (Reassign) 
(Page 175)"). Recommendation: Use the "Device identification" function.

5. Where required modify the device's online parameters.

6. Load the data from the device into the configuration (section "Upload to PG/PC 
(Page 148)").

7. Repeat steps 2 through 6 until all devices are configured.

8. Save the data in the project.

7.3.4 Creating typicals for parameters (import without ID data) 
You can use the following procedure to assign the parameters of an already configured device 
to identical devices.

Basic procedure
1. Open the process devices network view

2. Select a configured device or the network in which the configured devices are located.

3. In SIMATIC Manager, select the menu command Edit > SIMATIC PDM > Export.

4. Select the data for export.
You can find information on this in the section "Export... (Page 138)".

5. Perform the export.
A set of device-specific data is created for each device.

6. Select a device to which new parameters are to be assigned in the process devices network 
view or in HW Config.

7. Select the Import... command in the shortcut menu.
The "Import..." dialog box opens.
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8. In the "Import file" input box, enter the XML file that contains the data for the required device.
The check for consistent device types is performed.

– Clear the "Import Identification data" check box. 
You can find information on this in the section "Import ... (Page 140)".

9. Click the "Import" button.
The import file data record is not imported in full into the device. 
The following data is excluded from import:

– Device name

– Description

– Message

7.3.5 Replacing devices
You have several options for replacing devices with SIMATIC PDM.

Replacement of a device with one of the same type
This type of replacement involves replacement with compatible devices.
The device to be replaced can be operated with the device description of the device to be 
integrated (for example, after a firmware update). 

● The configuration can be downloaded to the device you want to integrate.
You can find information on this in the section "Download to device (Page 146)".

Replacement of a device with a similar one
This type of replacement involves incompatible devices.

Parameters for which identical names are entered in the device description are applied in the 
configuration of the new device.

● You can find information on this in the section "Device selection (Reassign) (Page 175)"

Replacement via address change
 

 Note
Typical service scenario

Manufacturers generally set devices to the service address 126 or deliver them with a user-
specific configuration.

 

This type of replacement involves compatible devices. You can use this function to assign the 
address of a configured device to a device with the service address 126. 

● The device to be replaced can be operated with the device description of the device to be 
integrated (for example, after a firmware update).

● The configuration can be uploaded to the device to be integrated.
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Basic procedure (for PROFIBUS devices and FF devices)
 

 Note
Restart

Changing the address will restart the device.
 

● Option 1 

– You apply the "LifeList" function in order to find the replacement device.

– You assign the configuration to the replacement device via the LifeList function "Assign 
address and TAG ...".

You can find additional information on this in the section ""LifeList - Assign address and 
TAG..." dialog (Page 120)".

● Option 2 

– You apply the Assign address and TAG ... function for a configured device in SIMATIC 
PDM.

– In the "Online" area enter the address of the replacement device located in the system 
(with service address 126).

You can find additional information on this in the section "Assign address and TAG 
(Page 152)".

7.3.6 Inserting plant-specific documents for process mode
You can assign up to 10 documents to one PDM object in the Document Manager.

To assign the documents, select the menu command Device > Object Properties > Document 
Manager.

To open the documents, select the SIMATIC PDM menu command Help > Document 
Manager. Use the mouse to select the required document from the submenu.

Requirements
The following requirements must be met in order to assign and display documents:

● The documents are stored locally on the PC or are located on a connected network drive 
(designated by means of a letter). 
Connections involving http, ftp, and UNC paths are not supported.

● A display program is assigned to the document type in Windows on the PC.

● The user who wants to open a particular document has read rights to the document (as a 
minimum).
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Procedure
To assign specific documents to a device, proceed as follows:

1. Open the object properties of the device.

2. Select the "Document Manager" tab.
Rows for a maximum of 10 documents are displayed.

Actions on the "Document Manager" tab

Action To execute
File 1. Click the "..." button.

2. Navigate to the document required.
3. Click "Open".

The storage path and file name of the selected file is displayed in 
the "File" box.

Title Enter a name for the document.
Test whether a document can be displayed. Select the menu command Open.
Remove a document from the list Select the menu command Delete.

7.3.7 Operating modes of field devices

Modes
Each device supports specific, different operating modes which can or cannot be toggled using 
SIMATIC PDM (depends on the interlock setup of the device).

The following operating modes are available:

Operating mode Description
Automatic The device is operating in cyclic mode on an AS master or is ready for this mode.
Manual The device is still operating in cyclic mode, however, the AS master rejects all 

additional process values. Working information is transferred "in situ" to the 
device or by means of a dialog box in SIMATIC PDM.

Simulation SIMATIC PDM provides a dialog box where you can set up the device as follows:
● The default sensor values are valid as output variables and are transferred 

to the AS master
or
● The actuation information for actuators is specified by SIMATIC PDM. The 

reaction is similar to that of "Manual" mode.

Functions
7.3 Device management 

Help for SIMATIC PDM (V8.0.2)
98 Operating Manual, 12/2012, A5E03515631-02



Operating mode Description
Test mode The test mode represents an extended type of internal simulation in the actual 

device. For sensors, for example, the actual sensor value is manipulated instead 
of the output value to the AS master. All calculations generated in auto mode are 
executed in the device and the device transfers all of its configured diagnostics 
messages to the AS master.

Failsafe The device goes into the failsafe mode if an error was detected during acquisition 
of a process variable.

The diagnostics icon of the device identifies the current operating mode. 

Additional information
You can find an overview of the diagnostics icons displayed in SIMATIC PDM in the section 
"Overview of Device Icons (Page 114)".

7.3.8 Deleting devices
An object is deleted from all the SIMATIC PDM configuration views as soon as you delete it 
from any of the following views: 

● HW Config
Devices that have been inserted in a project via HW Config can only be deleted in HW 
Config (Edit > Delete menu command).

● Process devices network view and process devices plant view
You can delete devices used once in both process devices views. The synchronization 
between the process device views is done automatically. 

 

  Note
Exception of objects used more than once  

Objects that can be used more than once (e.g. a device that can be configured with 
redundancy)
●  To cancel redundancy, delete the partner configured as the slave. If you want to delete 

both redundant partners, both objects must be manually deleted.
 

7.3.9 Assigning parameters and downloading to devices
You assign parameters to devices in the parameter table.

The data relating to entries and changes made in SIMATIC PDM is always created offline 
(saved in the project data). The data does not take effect in the device until the "Download To 
Device" function has been performed. 
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"Download to device" function
Downloads all device variables of a device object from the offline data storage to the devices. 
You can find information on this in the section ""Download To Device - <...>" dialog box 
(Page 147)".

Additional information
● Section "Parameter table (Page 62)"

● You will find information on FF devices in the section: "How to download objects in the FF 
segment (Page 102)" as well as in the PCS 7 FOUNDATION Fieldbus commissioning 
manual.

7.3.10 Interconnecting and downloading FF devices

7.3.10.1 “Interconnection Editor" dialog box
 

 Note
Menu command "Start Interconnection Editor"         

This menu command is enabled in HW Config for an FF Link if the "PDM Foundation Fieldbus" 
license key is available.

 

You organize the interconnections for internal FOUNDATION Fieldbus (FF) communication in 
this dialog. The automation system does not participate in this communication. The name of 
this function is "Control in the field" (CiF). CiF can be used to execute technological functions 
in an FF segment. 
Configure each CiF interconnection (hereafter referred to simply as interconnection) in the 
"Interconnection Editor" dialog. 

 

 Note
Internal device interconnections

FF devices have internal device blocks, such as measuring sensor, controller. The internal 
device interconnection of these blocks means that there is no communication load on the FF 
segment.
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Structure
The "Interconnection Editor" dialog box is divided into the following columns:

● "Inputs and interconnections" area

– "Input" column
This column shows the FF devices and the available inputs in the network view of the 
FF segment. Inputs are the target of an interconnection.

– "Interconnection" column
This column displays a list of interconnections that were configured for the FF segment.
Layout: Output of the FF device > Function Block > Signal

● "Outputs" area

– "Output" column
This column shows the FF devices and the available outputs in the network view of the 
FF segment. Outputs are the source of an interconnection.

Buttons

Button Function
"Add 
interconnection"

Click this button to add an interconnection to the column "Interconnections".

"Delete 
interconnection"

Click this button to delete an interconnection.

"Close" Click this button to close the dialog box.
A message informs you if changes were not saved. 

"Save" Click this button to save configured interconnections in the SIMATIC project. 
"Download" Click this button to open the CiF interconnection.

NOTICE!
Use this button only if no other changes have been made to the FF segment since 
the last download of the device.

Icons

Icon Displayed object 
FF segment 

FF Link

FF device

Block within an FF device

Inputs and outputs Status
Analog input Not interconnected

Analog input Interconnected

Digital input Not interconnected
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Icon Displayed object 
Digital input Interconnected

Analog output Not interconnected

Analog output Interconnected

Digital output Not interconnected

Digital output Interconnected

7.3.10.2 How to download objects in the FF segment
You have to download the following data for the function of the FF devices in a system: 

● CPU data

– Hardware configuration of a CPU with connected FF segment (to the CPU)

– Program and connections (to the CPU)

● Schedule, bus parameters and interconnections (to the FF segment)

● Device parameters (to all FF devices)

Replacing devices
You have the following options for replacing devices with SIMATIC PDM:

● Replacement of a device with one of the same type

● Replacement of a device with a similar one

Requirement
You will have to read in the device parameters to the Engineering System before you assign 
the parameters of the FF devices for the first time. 

 

 Note

Observe the following if you have inserted new FF devices on the FF segment or if you want 
to use parameters of additional function blocks.
● The FF segment is stopped briefly during loading if it is downloaded completely (option 

at the FF Link: "Always download FF Link and FF devices"). 
● The FF segment continues running during loading if it is downloaded in increments (option 

at the FF Link: "Download FF Link and FF devices only in case of change").
● First, you have to configure all the interconnections.
● If required, correct the macro cycle settings.
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 Note
Downloading function blocks

It is not necessary to download an entire device if there are only minor changes. You can 
download a group of function blocks or one individual function block for an FF device.

 

Download   
Use the following menu commands to download the respective data to the system.

Menu command CPU data Schedule, bus 
parameters and 
interconnections

Device parameters

For a CPU with FF Link , you always download the 
hardware configuration to HW Config. 
PLC > Download to Module

Hardware 
configuration is 
downloaded 

Downloading -

The menu command PLC > Compile and Download 
Objects... in the SIMATIC Manager.

Program and 
connections are 
downloaded 

- -

In SIMATIC PDM, select the FF Link 
Device > Download to Devices 
Select the "Object with all subordinate objects and 
networks" check box in the "Download to devices" 
dialog.

- - All FF devices will be 
downloaded.

Select the FF device in SIMATIC PDM Device > 
Download to devices
Select the "Object with all subordinate objects" 
check box in the "Download to devices" dialog.

- -
Only when replacing a 
device with one of the 
same type: 
Select the check box 
"Load Schedule to 
Device".

The FF device is 
downloaded

 

 Note

You can download changes to the automation system in "RUN" mode (CIR). Note the settings 
for "Load FF Segment".

 

Settings for "Load FF Segment"
You can make settings in the object properties of the FF link in HW Config that are taken into 
consideration during an AS download. 

Perform the following steps:

1. Open the hardware configuration in SIMATIC Manager.

2. Open the object properties of the FF Link.
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3. Select the "Load FF Segment" tab.

4. Make the settings in accordance with the table below:

Check box Application  
Download FF Link  
and FF devices only 
in case of change

Exclude FF segment during 
AS download
You configure no changes for 
the FF segment, for example 

The FF segment continues running during 
loading if only changes are downloaded.

Always download FF 
Link and FF devices

Complete download of an FF 
segment

The FF segment is stopped when it is 
downloaded completely.
Recommendation
After a complete download of an FF segment, 
select the option "Download FF Link and FF 
devices only in case of change".

Exclude FF Link and 
FF devices from 
download

FUNCTION for 
COMMISSIONING ONLY

This function support you during 
commissioning of other FF links on the same 
PROFIBUS.
NOTICE! 
Undefined states may occur in the FF segment 
when you use this setting. 
A STOP of the FF segment is possible 

7.4 Communication

7.4.1 Saving/reading the device data
The "Download to device (Page 146)" and "Upload to PG/PC (Page 148)" functions are used 
to update the data storage system.

● The "Upload to PG/PC" function is used to load all device tags of a device object from the 
device to the offline data storage.

● The "Download to devices" function is used to load all device tags of a device object from 
the offline data storage to the device.

Procedure
Proceed as follows to load data to the network view, the plant view or the PDM parameter view:

1. Select the device and then select the Download to devices or Upload to PG/PC menu 
command from the shortcut menu.

2. Select the settings in the "Download to devices" or "Upload to PG/PC" dialog.

3. Click "OK" to save your entries.

During the loading process, a dialog displays a tree structure similar to that of the SIMATIC 
Manager that shows the objects you have edited previously. If any errors occur for a device, 
the function is aborted for this device only. The action continues where possible.
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The dialog is updated during the load process. As long as the operation is active, the title bar 
displays the "In progress" status and the "Result" status after the operation has been 
completed.

Loading options
Within the configuration layer of the SIMATIC Manager you can download the data of 
configured devices to the entire plant, to units, or to single devices, or upload this data to the 
PG/PC without having to open SIMATIC PDM separately for each device.

You have the following options of loading data:

● Downloading to the devices, or uploading to the programming device or PC of the selected 
device

● Download to the devices, or upload to the programming device or PC of the selected device 
and of the devices in the root layer under the selected device (only for remote I/O)

 

  Note

At least two connections must be supported simultaneously for remote I/Os to enable 
communication with the connected HART process devices.

 

● Download to devices / Upload to PG/PC of the selected device and of all the devices under 
the selected device

Errors and messages
During the loading, all errors and messages are shown immediately. Any errors occurring in 
a device do not cause the entire action to be aborted; they only apply to the device that is 
currently being processed. Errors and other messages are saved and can be displayed at a 
later time. 

Suppressing message dialogs

You can suppress message dialogs during the loading. Select the "Execute load without info 
dialogs" check box. You can find additional information using the Options > SIMATIC PDM > 
Settings > The "Load" tab (Page 185) menu command.

Loading time
The time required to load the parameter assignment depends on the device in question, so it 
can take quite some time to load data from multiple field devices.

The total time required for this process depends on the following parameters:
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● Number of devices

● Communication mode

● The volume of parameters to be transferred
 

  Note
User action required

In the case of certain devices, loading processes have to be confirmed. 

If none of the devices you are using require any action on the part of the user in order to 
perform the loading processes, you can start the loading process just before you take a 
long break.

 

7.5 Export / Import

7.5.1 Introduction
You can export and reimport the configuration and parameter assignment data of projects with 
PDM objects to a different project or a different PDM computer, for example. 

You can export individual objects as well as modular software objects or modular hardware 
objects and networks with embedded objects (e.g., field devices).

Export
You can export object data from the following environments:

● From SIMATIC PDM

● In the process devices network view in SIMATIC Manager

● In the process devices plant view in SIMATIC Manager

● In HW Config

You can export the configuration and parameter assignment data of the following objects:

● Devices

● Modular devices (e.g. remote I/O stations)

● Networks with subordinate devices

Files are created during the export based on the export object:

● Parameter export files

● Structure export files
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 Note

Devices with a redundant interconnection are configured multiple times in the network and 
exported in the same number during the export of a network (you can find information on this 
in the section ""Select object" dialog box (Page 93)").

 

Parameter export 
If only one object is selected for export, there is only a parameter export in the export directory. 

Parameter export files are created only for device objects. No parameter export files are stored 
for networks or similar objects.

The parameter export file is labeled with the prefix "Param$".

Structure export 
If a set of objects – an object with subobjects – is selected for export, there is also a structure 
export in the export directory 

Along with the structure export file, a directory of the same name containing the parameter 
export files of the exported objects is generated.

Along with the structure export file, a directory of the same name containing the parameter 
export files of the exported objects is generated during the structure export.

Export directory

● Struct$<Plant-specific device name>$<Date(YYYYMMDD_hhmmss)>.xml

● Directory Struct$<Plant-specific device name>$<Date(YYYYMMDD_hhmmss)

– Param$<Plant-specific device name>$<Date(YYYYMMDD_hhmmss)>.xml

In addition to the parameter export files of the individual objects, a structure export file is 
produced during the export of object structures. The structure export file contains information 
on the object topology with all details required to generate the exported object structure again 
or to expand an existing object structure. The structure export file is labeled with the prefix 
"Struct$". 

 

Import
The exporting of data of a PDM object creates files in XML format. For the import, you can 
select an XML file and choose whether a parameter import or a structure import should be 
performed.

Parameter import 
Parameter export files can only be imported for device objects or "placeholder objects. A 
"placeholder object" is an object that is produced by the "Insert object" command without a 
specific type selection.
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In principle, the parameter import works as a comparative import. 

No objects are deleted by the import process.

Structure import 
Structure export files can only be imported for objects of a compatible type or for "placeholder 
objects". A "placeholder object" is an object that is produced by the "Insert object" command 
without a specific EDD selection.

The structure import works as an additive import. The address or the slot of the object is most 
important. 

This means that non-existing objects are created, the EDD is assigned and the parameters 
are imported.  

If objects already exist, the parameters are imported.

No objects are deleted by the import process.

 

Export/import file (*.xml)                   
During export, the data is saved in an XML file. 

The name of each file generated during the export is structured as follows:

Parameter export  Param$<plant-specific device name>$<date(YYYYMMDD_hhmmss)>.xml

Structure export        Struct$<plant-specific device name>$<date(YYYYMMDD_hhmmss)>.xml

 
 

 Note

The parameter export files are identified with the described prefix only in PDM V8.0.2 and 
higher.

 

Creating a plant-specific HTML format information file (HTML transformation file)
You can control how the parameter export files are formatted by using an HTML format 
information file (XSL file for transformation into HTML). You can use the HTML format 
information file (XSL file for transformation into HTML) to convert formats, for example, and to 
prepare the file for the purpose of using external tools. 

To create a plant-specific HTML format information file, use the default file as your starting 
point. 
Once you have created devices in PDM, you can find the path and name of the HTML 
representation file supplied with SIMATIC PDM in the export dialog. 
Default setting: <path>\<name>.<file format>

● Path: Programme\Siemens\Automation\SIMATIC_PDM\Templates

● Name: PDM<Version>_ExportTransformation

● File format: xsl
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Additional information
● Section "Export... (Page 138)"

● Section "Import ... (Page 140)"

7.5.2 How to export configuration and parameter assignment data
You can run the "Export" function for the following objects:

● Devices

● Modular devices (e.g. remote I/O stations)

● Networks with subordinate devices

Export environment
You can export object data from the following environments:

● From SIMATIC PDM

● In the process devices network view in SIMATIC Manager

● In the process devices plant view in SIMATIC Manager

● In HW Config

Procedure
1. Select a PDM object and choose the associated menu command:

– The menu command File > Export... in SIMATIC PDM.

– The shortcut command SIMATIC PDM > Export... in SIMATIC Manager, in the process 
devices network view or process devices plant view.

– The shortcut command SIMATIC PDM > Export... in HW Config.

2. Make the settings for exporting the device data:
You can find additional information on this in the section ""Export - <Object name>" dialog 
box (Page 138)".

3. Click "Start".

Result
The configuration and parameter assignment data for the selected device (or for the devices 
that are subordinate to the PDM object) is exported. 
The progress of the export is shown in the list of devices during the export process.

Display
The dialog box is updated during the export process. 

Status display
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● During the process, the display field shows the entry "Export: action started".

● Once the process is complete, the display field shows the entry "Export: action completed 
without error".

Message log
The message log shows all warnings, errors and information related to the export. You can 
find information on this in the section "Message log (Page 121)".

7.5.3 How to import configuration and parameter assignment data
Depending on the selection, the export generates parameter export files and structure export 
files in XML format. For the import, you can select an XML file and choose whether a parameter 
import or a structure import should be performed. 

Import environment
You can import data from the following environments:

● From SIMATIC PDM

● In the process devices network view in SIMATIC Manager

● In the process devices plant view in SIMATIC Manager

● In HW Config

The import is always started for an object, e.g., via the menu bar or via the shortcut menu in 
SIMATIC Manager. The name of the object for which the import dialog was opened appears 
in the name field of the dialog.

Object consistency check
A consistency check of the device types and objects is performed automatically during the 
import process.

● Imported object
Type of object from which the import file is generated

● Existing object (target object)
Type of object that is selected in the configuration as the target object of the import

The remaining steps depend on the results of the check:
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● Object types are the same
The import can continue immediately.
The entire import file can be imported to the target object. During import, all the data 
contained within the import file is overwritten.

● Object types are different (parameter import)
The import process is interrupted by the following message dialog box:
"Different device types. Only attributes with the same name will be imported."
If you continue the import, the following result is likely:

– No parameters will be deleted or added.

– Only those parameters with the same name will be overwritten on the target object.

● Object types are different (structure import)
The import cannot be started.

 

  Note
Assigned device description file

The target device is not assigned a new device description file.
 

Procedure
1. Go to one of the specified environments and select the device for which you want data to 

be imported from the XML file.

2. Select the relevant menu command in accordance with the environment that you have 
decided to use:

– The menu command File > Import... in SIMATIC PDM.

– The shortcut command SIMATIC PDM > Import... in SIMATIC Manager, in the process 
devices network view or process devices plant view.

– The shortcut command SIMATIC PDM > Import... in HW Config.

3. A dialog box opens. In the "Import file" input box, enter the path and location of the XML 
file that contains the data you want to import. 
The device type consistency check is performed.

4. Select the setting for the "Import identification data" check box.

– "Import identification data" check box activated (default)
The following data of the import file are imported:
- Device name
- Description
- Message

– "Import identification data" check box deactivated
The device name, description, and message are excluded from the import.
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5. Select the setting for the "Import device parameters" check box:

– "Import device parameters" check box selected (default)
The data record of the parameter export file is completely imported.

– "Import device parameters" check box cleared
The data record of the parameter export file is not imported.  

6. Click the "Start" button.
The status of the import is displayed while it is in progress.

Display
The dialog box is updated during the import. 

Status display

● During the process, the display field shows the entry "Import: action started.".

● Once the process is complete, the display field shows the entry "Import: action completed 
without error.".

Message log
The message log shows all warnings, errors and information related to the import. You can 
find information on this in the section "Message log (Page 121)".

Additional information
● Section "Replacing devices (Page 96)"

 

7.6 Diagnostics

7.6.1 Field device diagnostics

Description     
SIMATIC PDM provides a detailed diagnostics for integrated field devices.

The device icons are assigned during configuration. When a connection is being established, 
device-specific diagnostic information is automatically evaluated and classified. The resulting 
classification is indicated by the corresponding icons. You will find information on the icons in 
the section "Overview of Device Icons (Page 114)".

This diagnostic information is automatically saved in the project, even if the assigned 
parameter data are not saved.
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When an online connection is being established, an identification check is performed initially. 
After this, the device status is determined, and the device is depicted with the corresponding 
icon.

 

 Note

It is possible to disable the diagnostics update.
 

Diagnostic information
The diagnostics provides the following (categorized) information:

● Communication

– Communication with the device was good

– Communication was good, but the device does not support further diagnostics

– Communication faulty

– Device assignment error

● Process

– Device unchecked

– Device deactivated

– Measured value alarm

– Measured value warning

– Measured value tolerance

● Maintenance

– Maintenance alarm

– Maintenance warning

– Maintenance required

● Configuration

– Configuration error

– Configuration warning

– Configuration changed

● Operating mode

– Manual mode

– Simulation or substitute value

– Out of service
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Device status
 

 Note

When checking the status of a device, sometimes the diagnostic information cannot be fully 
determined because not all devices support the full scope of this function. 

 

Additional information
Section "Identity check (Page 117)"

Section "Updating diagnostics (Page 117)"

7.6.2 Overview of Device Icons
The following table explains the meaning of the possible icons for the devices configured in 
SIMATIC PDM. The statuses of these icons may not be fully supported by all devices. 

The corresponding icons are assigned to the devices during configuration. 
The displayed icons are updated as follows:

● When a connection is established to field devices

● When a picture is changed

The diagnostic information is automatically saved in the project, even if the parameter data is 
not saved.

Display of the icons
The icons are displayed in the following views:

● In SIMATIC Manager

– Process devices network view

– Process devices plant view

● In SIMATIC PDM in the tree structure

● In the LifeList in the tree structure

Icons               

Icon Description
Deactivated
No device description (EDD) from the device catalog has yet been assigned to the field device. / Field device 
cannot be reached.
Not validated
A device description from the device catalog has been assigned to the field device.
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Icon Description
Communication faulty
Communication error; communication has been interrupted or no communication could take place with the 
device at the configured address. The device cannot provide detailed diagnostic information.
Assignment error
The field device is incompatible with the configured field device or the device has been configured incorrectly. 
The device cannot provide detailed diagnostic information. 
Maintenance alarm
Maintenance is required immediately as there is a device fault.

Maintenance demanded
Maintenance is needed to prevent a possible device fault from occurring.
Additional diagnostic information is available.
Maintenance required
Maintenance should be scheduled.
No functional restriction has been diagnosed for the field device, service is requested. 
Additional diagnostic information is available.
Manual mode
There is a communication connection with the field device. The device is in manual mode.

Simulation mode
There is a communication connection with the field device. The device is in manual mode.
E.g. the device is in "simulation mode" manual mode.
Out of service
There is a communication connection with the field device. The device is in manual mode.
E.g. the device is in "Out of service" manual mode.
Configuration error
Field device fault due to a parameter/interconnection error or configuration error in the hardware 
components. A maintenance alarm is triggered automatically.
Configuration warning
Field device warning due to invalid parameters for which substitute values are used. A maintenance request 
is triggered automatically.
Configuration changed
The parameters set for the device do not match the parameter data saved in the project. Communication 
with the device is possible to carry out a value comparison or to change parameter settings.
Unknown diagnostics status
Unknown field device status due to invalid parameters for which substitute values are used. A maintenance 
request is triggered automatically.
Process value alarm
At least one process value has exceeded or fallen below a hardware interrupt limit whose parameters were 
assigned in the device. Communication with the device is possible.
Process value maintenance
At least one process value has exceeded or fallen below a process warning limit whose parameters were 
assigned in the device. Communication with the device is possible.
Process value tolerance
At least one process value has exceeded or fallen below a process tolerance limit parameter set in the 
device. Communication with the device is possible.
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Icon Description
No messages
No functional restrictions or diagnostic information known.

No diagnostic check
No functional restrictions known. The field device does not support additional diagnostic information.

Test mode (background color of diagnostics icon)
The device is in local test mode. All the displayed information or diagnostics may be simulated. The 
information transferred to the automation systems (measured values and status) may also be simulated.

Icons for FF device blocks
The icons for FF device blocks are based on the device icons.

Icon Description
FF block icon

The block icon is a device icon expanded by the block character. It has an equivalent meaning.
Example: 
FF block not functional (Out of service)

7.6.3 Connection diagnostics

Description       
When you establish an online connection to a device in SIMATIC PDM, the following points 
are checked while the connection is being established: 

● Device type

● Device (TAG)

● Changes made to the device that have not yet been saved in the project

If a connection is aborted, SIMATIC PDM automatically attempts to establish a new connection. 
Any errors that occur are displayed and logged.

If a device has not accepted the data in an identical manner, the values that are written to the 
device and the actual values read back from the device can be displayed.

You can then decide whether or not to use the changed values in your project. 

Additional information
● Section "Overview of Device Icons (Page 114)"

● Section "Communication Problems (Page 197)"
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7.6.4 Identity check
The identification check verifies consistency between the connected and the configured 
device. The scope of the identification check depends on information derived from the device 
description of the respective device.

 

 Note

Once the identification check is complete, the device status is determined and a 
corresponding icon is assigned to the device.

If the identification check determined a difference between the connected and the configured 
device, an informational dialog is depicted listing information about the connected and 
configured device.

 

7.6.5 Updating diagnostics
If online communication with the currently selected object is established, SIMATIC PDM is able 
to carry out a device diagnostic of the field devices. 

Enabling device diagnostics
1. Select the Options > SIMATIC PDM > Settings menu command in SIMATIC Manager.

The "Settings" dialog opens.

2. Select the "Communication" tab.

3. Activate the "Diagnosis Update" check box in the "Device diagnostics" area.

See also
"Communication" tab (Page 184)

"Update diagnostics - <...>" dialog box (Page 166)

Overview of Device Icons (Page 114)

7.7 LifeList

7.7.1 Working with the LifeList

Introduction
LifeList makes it possible to identify active field devices without configuration. With LifeList , 
you perform a scan on one of the following PDM objects:
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● PROFIBUS DP network

● PROFIBUS PA network

● Foundation Fieldbus network
 

 Note
Scanning a network

The selected network is analyzed during a scan with LifeList . A separate scan is required 
for subordinate networks.

 

Starting LifeList 
If the project is opened in SIMATIC Manager, you can start LifeList from the following views:

● Starting from HW Config

– Select a PDM object containing the field devices.

– Select the shortcut menu command SIMATIC PDM > Start LifeList . 
SIMATIC PDM starts. LifeList is opened.

● Starting from the process device network view

– Select a PDM object containing the field devices.

– Select the menu command Edit > SIMATIC PDM > Start LifeList .

● Starting from SIMATIC PDM

– Requirements: A PDM object containing the field devices is selected.

– To open the LifeList , select the menu command View > Start LifeList .

Stopping LifeList 
When the LifeList is open, click "Close".

LifeList via Ethernet routing
The following requirements have to be met to apply the LifeList to objects via Ethernet routing:

● An S7 hardware project can communicate with the automation system via HW Config.

● The hardware project has been downloaded to the automation system along with the 
corresponding PROFIBUS-Link .

If these conditions are met, communication can be established via Ethernet routing with 
networks of the following types:

● PROFIBUS DP network

● PROFIBUS PA network

● FONDATION Fieldbus via FF Link at PROFIBUS DP

You can find information on the required hardware in the file PDM-readme.
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7.7.2 "LifeList" dialog box

Start or update LifeList 
The LifeList for the selected PDM object is not determined automatically. You start to create 
or update the LifeList for the PDM object via the "Start" button.

LifeList data
The following data can be displayed in the LifeList :

● Available nodes

● Address

● ID number

● Manufacturer

● Device type

● Device revision

Scan operation procedure
1. The object selected before the LifeList dialog starts is displayed in the table.

2. You start to create the LifeList for the PDM object

3. The addresses of the devices that are subordinate to the PDM object are ascertained.

4. The available data are requested and displayed in succession for all allocated addresses.

For more information about the icons, refer to section "Overview of Device Icons (Page 114)".

Canceling and restarting the scan
The table will be recreated if you cancel and then restart the scan.

Errors and warnings
If the scan has completed then errors and warnings are provided in the message log. You can 
view all messages by clicking the "Message log (Page 121)" button.

"Assign tag and address" button
You can assign new addresses and device names to one of the following devices via this 
button:

● PROFIBUS field devices

● FF field devices

You can find information on this in the section ""LifeList - Assign address and TAG..." dialog 
(Page 120)".
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7.7.3 "LifeList - Assign address and TAG..." dialog
If the LifeList was found, you can perform the following action in the "LifeList - Assign address 
and tag..." dialog" for the device displayed in the "Online" area:

● Change object name

● Change address

● Change object name and address

Buttons

Button Function
Select object Select this button in the following cases:

● You want to assign an existing device configuration to a replacement 
device with default address.

● You want to assign an existing device configuration to an unspecified 
device.

Transfer You can only select this button if changes were made in at least one input 
box and both input boxes were selected. 
The information in both boxes is identical if the operation was successfully 
completed (status \"Transfer successful\").

Reset address
(only available for FF 
devices)

● The "Reset address" button is only available for FF devices.
● The function "moves" the device to the area for temporary FF devices 

(reserved address range for FF devices - addresses 248 to 251). The 
name (TAG) remains unchanged.

● You can verify execution with LifeList .

 
 

 Note
Restart

Changing the address will restart the device.
 

 Note
Address or name (TAG) occupied

If the address or name (TAG) is occupied, then the action will not be performed. A 
corresponding message will be displayed.

 

Device information
The following data is displayed in this area for the detected device (online) and the new settings:

● Manufacturer

● Device type

● Device revision
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See also
"Assign address and TAG..." dialog box (Page 153)

7.8 Logs

7.8.1 Message log
Information about events in SIMATIC PDM is displayed in the message log.

Events in the message log
The message log contains information on the following events:

● Events in online dialogs

● Events when executing "Upload to PG/PC..." and "Download to devices..."

● Events when executing "Update diagnostics"

● Events when executing the LifeList

● Events when executing Export and Import

● Events in Device Integration Manager
 

  Note
Device-specific log functions

The device description is used to determine which events are logged and which log entries 
are displayed in the message log. 

 

Message log
The message log contains the following columns:

● Index

● Date and time
Displays the date and time in UTC format, including the local time difference.
YYYY-MM-DD HH:mm:ss +/-HH:mm

● Message class

● Context

● Message
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Filtering the message log
You can filter the events shown in the message log according to the following categories. 
Select one of the following settings from the drop-down list:

● Without filter
All information is shown.

● Errors only 
Only errors are shown.

● Errors and warnings only
Only warnings and errors are shown.

File saving and formats     
You can save the message log in CSV format (*.csv).

7.9 Graphical displays
 
 

 Note

Functions for the graphical display of values are available in SIMATIC PDM, if they are 
provided by the manufacturer of the device description.

 

Chart dialog window
When working with field devices, please note that:

● The following cannot be changed:

– The contents of the chart dialog window

– Process values

● If the device description can be edited, you can use SIMATIC PDM to change the following 
data in the chart dialog window:

– Variables

– Constants

Functions and possible representation 
The following functions can be displayed by SIMATIC PDM:

● Monitoring process values

● Monitoring measuring signal raw values

● Monitoring status or wear values inside the device

● X-Y trends, e.g. envelope trends for radar level gauges
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● Trends (for multiple process variables, measured values)

● Calibration functions

● Zero point settings

● Min/max pointer

● Diagnostic states

● Restore factory settings

● Mode changes

● Online parameter assignment

● Simulation of process variables, statuses, and diagnostics messages

● Classification of device-specific diagnoses

Additional information
● IEC 61804-2

● IEC 61804-3

7.9.1 Graphical display of values

Online functions
The following is defined in the device description with regard to online functions:

● Process variables and measured values that can be visualized or used online 

● Type of display and content of the online dialogs

● Possible online operations

The values and parameters appear on standardized online displays, which are coordinated 
with different functions.

 

 Note
Online functions are active (time running)

If a function accesses online values then an animated clock icon is shown in the title bar in 
the online dialogs.
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Displaying information in the chart 
Device description files can include the following information on displaying values/parameters 
in charts:

● Source of values/parameters

● Chart type

● Value ranges

Charts for process values
● Trend chart (Page 125)

Multiple values/parameters can be displayed in a chart at the same time.

– y-t charts

● Tachometer chart (Page 127) 
Each value/parameter is displayed in a separate chart.

● Bar chart (Page 164) 
Multiple values/parameters can be displayed simultaneously in a chart.

Trend chart for variables and constants
Multiple variables/constants can be displayed in a chart at one time.

● Trend chart (Page 125)
Multiple variables/constants can be displayed in a chart at one time.

– y-t charts

– x-y charts

The following data is displayed:

● Online values

● Data from files

● Data read from the device

Trend chart for digital values
Digital values can be shown in a trend chart.

The representation of the values depends on the device description.

Additional information
● Section "Charts and trends (depends on device) (Page 163)"

● Section "Displaying process variables and measured values  (Page 164)"

● IEC 61804-2

● IEC 61804-3
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7.9.2 Trend chart
The following may be displayed in the trend charts:

● Display of several trends

● Display of one x axis and several y axes

● Display of one y axis with several trends

The way in which trends are displayed is derived from the device description:

● Trend colors

● Visual highlighting of individual trends (e.g. line width)

y-t chart   
In y-t charts, the trends are updated incrementally.

The following display modes are usually used:

● Automatic scrolling along the time axis

● If the trends have reached the right-hand margin, they continue to be recorded starting from 
the left again, and the old trends are overwritten one after the other

● If the trends have reached the right-hand margin, the trend display is cleared and the trends 
start again from the left

x-y chart   
The way in which information is displayed with x-y charts depends on the specifications in the 
device description. The following displays are typical:

● Representation of static trends

● Representation of parameters which change upon certain events (e.g. change of 
parameters)
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Display mode
The trend display mode can be selected in the trend charts by using the toolbar that is available 
in the "Display mode" drop-down list. 
Modes:

● Strip

– The most recent value is always shown on the far right of the chart.

– The user can change the length of the time interval.

● Scope 

– The time axis shows a defined time interval.

– The first value for the current time interval is always shown on the left-hand side of the 
chart. The subsequent values are always assigned to a time that falls within the time 
interval shown. The final value for the time interval that is being displayed is always 
shown on the right-hand side of the chart.

– As soon as a time interval expires, the displayed values are deleted.

– The first value for the subsequent time interval is always shown on the left-hand side of 
the chart.

● Sweep

– The time axis shows a defined time interval.

– The first value for the current time interval is always shown on the left-hand side of the 
chart. The subsequent values are always assigned to a time that falls within the time 
interval shown. The final value for the time interval that is being displayed is always 
shown on the right-hand side of the chart.

– The values that are displayed in the chart get overwritten by the values for the 
subsequent time interval.

● Static 

– The time interval is not updated.

– The user can change the displayed range however he or she likes.

– Recommendation: 
Use this display mode to display static values.

7.9.3 Bar chart
 

 Note

Functions for the display of process variables and measured values are available in SIMATIC 
PDM, if they are provided by the manufacturer of the device description.

 

Process variables and measured values are displayed in bar charts. A bar chart always shows 
current values.

The following may be displayed in the bar charts: 
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● Name of the chart

● Names of the variables

● Limit (for the warning range)
 

  Note

The value range of the axis can be moved with the mouse.
 

Example
The figure below shows an example of a dialog window with a bar chart.     

1

2

3

4

Plant designation/TAG

Description

Parameter

Limit

Parameter

Current value

Additional information
● Section "Trend chart (Page 125)"

● Section "Tachometer chart (Page 127)"

● Section "Icons and buttons (Page 129)"

● Section "Work with trends (Page 130)"

● Section "Editing trends (Page 132)"

 

7.9.4 Tachometer chart
In SIMATIC PDM, only one value is displayed in a tachometer chart. 

Limits can be assigned to the displayed value. These are highlighted in color in the chart.   
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Chart
The chart can show the following elements:

● Name of the chart

● Inscription for the tachometer

● Name of the variable

● Min/max pointer (marks the maximum or minimum value reached since the start of 
monitoring)

● Warning ranges (represented by hatching)

● Limit (for a warning range)

● Current value (represented as a needle on the tachometer and as a numeric value below 
the tachometer)

● Inscription of the axis

● Unit

Example
The figure below shows an example of a dialog window with a tachometer chart.     
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7.9.5 Icons and buttons

Icons and buttons on the toolbar

Icon Description
Zoom in horizontally
Use the "Zoom in" button to enlarge the trend area.
Zoom out horizontally
Use the "Zoom out" button to make the trend area smaller.
Zoom in vertically
Use the "Zoom in" button to enlarge the trend area.
Zoom out vertically
Use the "Zoom out" button to make the trend area smaller.
"Display mode (Page 125)" - Allows you to set the trend display mode
● Strip
● Scope 
● Sweep
● Static 
Trend Manager - Allows you to make settings for the trends and markers shown
● You can use the check box in the "Trend Manager" drop-down list to hide/show trends. In the legend, 

hidden trends are grayed out.
● Each trend is automatically assigned a marker (trend symbol) with its own color and appearance. 

You can use the check box to hide/show the marker.
● An editable trend is always selected via the Trend Manager.
Export
Trends can be exported in .csv file format.
Import
Once a trend has been exported, the resulting .csv file can be imported.
Imported trends are shown with their own x and y axes. To allow an imported trend to be compared 
with recordings that are currently in progress, the X axis of the imported trend can be linked to an existing 
axis.

 Link axis
Once a trend has been imported, the new X axis (axis B) for the imported trend can be linked to the 
existing X axis (axis A). Axis B is then synchronized with axis A to run simultaneously, but it can be 
adjusted without affecting axis A. This makes it possible to compare trends that were recorded and 
displayed previously with the current trend.

"View" drop-down 
list

"View" drop-down list - for displaying/hiding elements in the user interface
● Legend
● Ruler
● Table (values tables)
● Marker (symbol assigned to a trend)
Print
There is a Print dialog that allows you to print out the current trends. You can enter a comment for the 
printout.
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Icons, buttons, and information displayed in the trend chart

Icon Description
Open padlock 
You can change the value. 
The value represents a limit for the values that are displayed on the relevant axis. 
Closed padlock
You cannot change the value. 
The value represents a limit for the values that are displayed on the relevant axis.

Legend Each trend is identified by means of its name and a symbol with the same color as the line. The legend 
displays the following information consecutively for the trends shown in the chart
(format: Symbol Name Date:Time: Value): 
● Trend symbol
● Trend name
● Date:Time (format: DD:MM:YYYY hh:mm:ss.sss
● Value

– Value currently being read in (measuring lines not activated)
– Cursor points to a measuring line (active measuring line): Value at the intersection of the trend and 

measuring line (the values at the intersection point are underlined)
Measuring line Measuring lines

SIMATIC PDM makes a measuring line available in trend charts. The measuring line symbol identifies the 
current position of the measuring line. 
● Legend for measuring line

– The value at the intersection of the trend and measuring line is shown at the intersection
– Active values are underlined
– Interpolated values are not underlined

● Using the measuring line
– Pull the measuring line to the required position
– Removes a measuring line (park position).
– Remove measuring line (ALT + click)
– Duplicate measuring line (Ctrl + click)

White Active
Orang
e

Passiv
e

Shaded trend Cause: Data reduction 
The trend includes a large number of data points within the displayed range. The individual values cannot 
be displayed.

Dotted trends There are no measured values in a range.

7.9.6 Work with trends

Interaction
The following functions are available in dialog boxes with trends:
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● Adjust display range  
You can increase or decrease the range of a trend shown in the chart to meet your needs. 

– Select a range
Use the mouse to select the starting point and keep the left mouse button pressed to 
select the end point of the range to be displayed. Display is stopped and the desired 
range is shown.

– Display minimum and maximum of all trends
Double-click on the Y axis. The minimum and maximum of the Y axis are set in such a 
way that the values of all trends associated with this Y axis are completely visible in the 
interval displayed on the X axis.

– Display the entire time range
Double-click the X axis. The X axis is set in such a way that all trends are included, from 
the first to last point.

– Adjust the left display area
You can stretch or compress the corresponding axis by holding down the left mouse 
button. The right or upper scale value remains unchanged in this case.

– Adjust the right display area 
You can stretch or compress the corresponding axis by holding down the right mouse 
button. The left or lower scale value remains unchanged.

– Move the display range 
You can move the corresponding axis range by keeping the center mouse button 
pressed.

● Capture trend 
You can capture all trend areas. 
Double-click in the trend area. The values for all trends are displayed in the selected area 
(currently selected time range / X axis).

● Move the ruler
You can move the ruler. 
Select the ruler with the mouse and move it by keeping the left mouse button pressed. The 
changing x-position is displayed in the bottom right of the chart. Moving the "handles" is 
depicted as a numeric value. Once the left mouse button is released, the Y value associated 
with the X position is displayed.   
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● Move axis 
You can move an axis.
Hold down the "CTRL" key. Click on an axis in the chart and move it via drag-and-drop. 
The grid within the chart is based on the scale shown to the left of the chart.

● Link axes
This function is used for comparing trend values.
Requirement: A file containing exported trend values is available.   

– Select the "Static" entry from the "Display mode" drop-down list.
 The time axis is stopped.

– Import the values for a trend.

– Align both axes of the displayed and imported trends in order to match up suitable points 
of reference. To do this, use the "Move axis" function and adapt the display range of the 
axes.

– Click the "Link axes" button on the toolbar.

– Select the "Strip" entry from the "Display mode" drop-down list.
The axes now move simultaneously and you can compare the values. Changing the 
leading axis affects the following axis, but not vice versa.

● Display help    

– Device-specific help on trends can be integrated in the device description. You can open 
this help by clicking the "Help" button.

– Any existing tooltip help for an object is displayed when you hover the mouse pointer 
over an object.

● Print functions

● Export/import function

7.9.7 Editing trends
The manufacturer of a device determines which values/parameters can be visualized and 
used. The device description is used to specify how SIMATIC PDM shows data that is to be 
displayed in charts. SIMATIC PDM may only be used to edit data (variables and constants) in 
charts if this is permitted by the device description. Before you can edit a trend, it must be 
selected in the Trend Manager.
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Editing in the Trend Manager
Once you have selected the trend in the Trend Manager, the following is displayed for the 
editable trend:

● Black trend points
Trend points which can be edited

 

 Note

Only possible if the relevant function is permitted by the device description.
 

● Adding trend points
Hold down the "CTRL" key. Click the drawing area in the chart.

– If the point you have clicked in the chart features on the trend line, the new point is 
inserted into the trend between two existing points.

– If the point you have clicked in the chart falls outside the trend line, the new point is 
added at the end of the trend.

● Deleting trend points

– Press and hold down the "Alt" key. Click a trend point in the chart. The trend point is 
deleted.

– Once a trend point has been selected, you can delete it by pressing the "Del" key.

– For multiple trend points:
Press "CTRL" + "ALT" and click on the trend points to be deleted.

● Move trend points
Hold down the "CTRL" key. Click on a trend point in the chart and move it via drag-and-
drop.

 

  Note

The grid and other trend points have a magnetic effect on the point to be moved.
 

● Selecting multiple trend points
The trend points are captured by using a selection rectangle. 
Click with the left mouse button to select the starting point for your rectangle. Then drag 
the cursor across the chart while keeping the mouse button pressed. All the trend points 
that fall within this rectangle are marked with a red dot. 

● Define the zoom area
The zoom area is captured using a selection rectangle. 
Click with the left mouse button to select the starting point for your rectangle. Then drag 
the cursor across the chart while keeping the mouse button and SHIFT key pressed. The 
area inside the rectangle is part of the zoom area.

● "Monotonic entry" check box
To enter monotonic data values, activate the "Monotonic entry" check box. The arrow 
indicates the direction (monotonically ascending or monotonically descending).
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Additional information
● Section "Icons and buttons (Page 129)"

7.10 Asset management

7.10.1 Asset management 
Asset management covers all activities and measures which help to preserve or increase the 
value of a plant. As well as production management, process control, and process optimization, 
above all this includes maintenance work designed to preserve and increase a system's value, 
known as "plant-level asset management".

Asset management with SIMATIC PDM
SIMATIC PDM supports you in performing plant-level asset management with functions for 
configuring, assigning parameters for, commissioning, diagnosing, and maintaining intelligent 
field devices and components.

Asset management functions of SIMATIC PDM
SIMATIC PDM can supply extended information for the Asset Management for devices that 
are described by a device description (EDD/DD), for example: 

● Detailed diagnostic information (manufacturer information, information on fault diagnostics 
and troubleshooting, further documentation)

● Change information (audit trail log)

● Parameter information

● Diagnostic and status information for all devices is labeled and displayed with with 
standardized icons
You can find information on this in the section "Overview of Device Icons (Page 114)".

● Data is sent to an asset management system (e.g. PCS 7 maintenance station) upon 
request from the system.

● Export interface
You can find information on this in the section "Export... (Page 138)".

● Device-specific information and profile information is displayed in multiple languages, 
provided that such information can be extracted from the device description files.

Functions
7.10 Asset management

Help for SIMATIC PDM (V8.0.2)
134 Operating Manual, 12/2012, A5E03515631-02



7.10.2 Use with the PCS 7 Maintenance Station

Maintenance Station Standard and Maintenance Station Basic
Process control of a maintenance station is started in the same way as the process control of 
an Operator Station. 

When using an MS multi-user system and SIMATIC PDM, the Engineering Station must be 
switched on and the PDM Server manager started so that PDM device data is delivered.

SIMATIC PDM Maintenance Station
Before activating process control, check the setting for the WinCC project type in WinCC 
Explorer. A single-station project must be set as the project type. 

Activate process control in WinCC Explorer using the "Activate" icon.

Activate SIMATIC PDM ASSET Service 
You can display the diagnostics of field devices in faceplates with SIMATIC PCS 7 and 
SIMATIC PDM. Assign the current diagnostics project in SIMATIC PDM in order to be able to 
use the diagnostics function of SIMATIC PDM.

Requirements

● Configuration of the PCS 7 multiproject/project is complete.

● SIMATIC PDM is installed on ES.

● Field device parameter assignment is complete.

● A PDM application is inserted into the PC station of the engineering station.

Procedure      

1. Select the PCS 7 multiproject/project in the component view of SIMATIC Manager.

2. Select the menu command Options > SIMATIC PDM > Settings... .

3. Select the "Maintenance" tab.

4. Check the configured path. 
If the configured path is not the desired path, select the path via the button "Assign current 
project".

5. Click "OK".

Start SIMATIC PDM ASSET Service
 

 Note

Note that you need to start the SIMATIC PDM ASSET Service in the SIMATIC PDM ASSET 
Service Manager on the engineering station once manually in order to receive data from PDM.
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1. Click the following icon in the information area of the task bar of the operating system:
Starting/stopping the SIMATIC PDM ASSET Service.
The "Simatic PDM Asset Service Manager" dialog box opens.

Editing several PCS 7 projects with PDM       
If you edit several projects in SIMATIC Manager with a PDM computer, you have to observe 
the following sequence when you change between projects:

1. Stop the SIMATIC PDM ASSET Service on the PDM computer.

2. Stop the process mode on the Maintenance Station of the current project.

3. Open the required project in SIMATIC Manager.

4. Set the maintenance project in the SIMATIC Manager.

5. Start the SIMATIC PDM ASSET Service on the PDM computer.

6. Start the process mode on the Maintenance Station of the current project.
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Menus and dialog boxes in SIMATIC PDM 8
 

The menus and dialog boxes can contain other device-specific menu commands.

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, device-specific functions are grayed out in the second window and can only be 
accessed in the window that was opened first.

 

 Note

Device-specific menu items and help for these menu items are derived from the device 
description assigned to the object. You will find device-specific information in the online help 
and in the documentation provided by the device manufacturer. The PDF file associated with 
this documentation does not contain any device-specific information.

 

8.1 "File" menu 
 

The menus and dialog boxes can contain other device-specific menu commands.

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, device-specific functions are grayed out in the second window and can only be 
accessed in the window that was opened first.

 

 Note

Device-specific menu items and help for these menu items are derived from the device 
description assigned to the object. You will find device-specific information in the online help 
and in the documentation provided by the device manufacturer. The PDF file associated with 
this documentation does not contain any device-specific information.

 

8.1.1 Save
This menu command is used to save the current parameter settings from the parameter table 
in the project (Offline data storage) on hard disk.     

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.
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8.1.2 Export...
 

Figure 8-1 Export... 

This menu command starts the export of device data of a PDM object to an XML file.       

Make the settings for the export of device data in the "Export - <object name>" dialog.

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.

See also
"Export - <Object name>" dialog box (Page 138)

8.1.2.1 "Export - <Object name>" dialog box
Use the "Export - <Object name>" dialog box to make the settings for exporting device data 
and start the export function.

Select the export directory and transformation file
● Export directory

Enter the path for storing the generated XML files in the input box. The name of each 
exported XML file is structured as follows:
Parameter export Param$<plant-specific device name>
$<date(YYYYMMDD_hhmmss)>.xml
Structure export        Struct$<plant-specific device name>
$<date(YYYYMMDD_hhmmss)>.xml
 

 

  Note

The parameter export files are identified with the described prefix only as of PDM V8.0.2.
 

 

● HTML transformation file

– Xsl file which includes the information for display in HTML format.

– This input box allows you to specify a file containing reference data for how the export 
file (XML format) should look. To create plant-specific HTML transformation files, use 
the default file as your starting point.

Menus and dialog boxes in SIMATIC PDM 
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Selecting data for export
The following information can be included in the parameter export:

● Device parameters
Device parameters of the devices selected before export.

● Diagnostics
Table listing diagnostic parameters plus the associated diagnostic text.

● Document Manager
Table listing the names of the documents that have been assigned to a device.

If all three check boxes are cleared, only the structure export file is created. A directory 
containing parameter export files is not created.

The structure export file contains information on the object topology with all details required to 
generate the exported object structure again or to correspondingly expand an existing object 
structure. 

"Select" area - Selecting an object
If the object selected prior to the export contains subordinate objects, you can create a separate 
export file for each subordinate object. Use the option buttons in the "Select" area to make 
your selection.

● Object
Only the selected object (parameter export)

● Object with all subordinate objects
Only the selected object/device with directly subordinate substructures (networks are not 
considered) (parameter and structure exports)

● Object with all subordinate objects and networks
The selected object/device, including all subordinate substructures (parameter and 
structure exports)

List
The list in the dialog box shows the objects for which an export file is to be generated in 
accordance with the option button that has been activated in the "Select" area.

The following icons are used to indicate the processing status:

The export was performed without error.

Messages and warnings occurred during the export.

The export was not performed due to an error.

The object is currently being processed elsewhere.

The export was not performed for this device.

The function is not supported by this device.

Export is currently underway for this device.
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Display
The dialog box is updated during the export process. 

"Status" display

● During the process, the display field shows the entry "Export: action started.".

● Once the process is complete, the display field shows the entry "Export: action completed 
without error.".

Messages
Errors and warnings are entered in the message log.

Start
Starts the export.

Stop
Stops the export.

The object that is currently being processed will be completely processed.

Close
Closes the dialog box.

8.1.3 Import ...
 

Figure 8-2 Import ... 

This menu command starts the import of device data from an XML file to a PDM object.       

Make the settings for the import of device data in the "Import - <object name>" dialog. 

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.

See also
"Import - <Object name>" dialog box (Page 141)
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8.1.3.1 "Import - <Object name>" dialog box
In the "Import - <Object name>" dialog box, make the settings for the import of device data 
and start the import function.

The import assigns the data created for a device of network by the export to XML files to an 
existing device or network. You can select these XML files as the import file.

Import file   
In the "Import file" input box, enter the XML file that contains the data of the required device 
or network.

As soon as you enter the import file (parameter import file or structure import file), a device 
type consistency check is performed automatically. You can find information on this in the 
section "How to import configuration and parameter assignment data (Page 110)".

"Import identification data" check box
You can use the "Import identification data" check box to make the following settings:

● "Import identification data" check box activated (default)
The following data of the parameter export file are exported:

– Device name

– Description

– Message

● "Import identification data" check box deactivated
The device name, description, and message are excluded from the import.

"Import device parameters" check box
You can activate the "Import device parameters" check box to make the following settings:

● "Import device parameters" check box selected (default)
The data record of the parameter export file is completely imported.

● "Import device parameters" check box cleared
The data record of the parameter export file is not imported.  

Parameter import
If the file to be imported is a parameter export file, only the object that was exported appears 
in the tree view. The object is shown with a blue icon because the object model was not adapted 
in the project. The object is prepared for the parameter import, which is started using the "Start" 
button.
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Parameter export files can only be imported to device objects or "placeholder objects. A 
"placeholder object" is an object that is produced by the "Insert object" command without a 
specific type selection.

 

 Note

For FF devices, the type of the object to be imported must correspond exactly to the type of 
the start object. If they do not match, a corresponding message is displayed in the "Status" 
text box and the import cannot be started.

 

The actual import is started using the "Start" button.

The import is interrupted by the following message dialog box if the object types are different.
If you nevertheless want to continue the import, you can expect the following results:
–    No parameters are deleted or added.
–    Only parameters with the same name are overwritten in the target object.

Structure import
If the file to be imported is a structure export file, the object structure of the exported object 
appears in the tree view. All device objects are "grayed out". This is an indicator that these 
objects have not yet be included in the configuration.

Structure export files can only be imported for objects of a compatible type or for "placeholder 
objects". A "placeholder object" is an object that is produced by the "Insert object" command 
without a specific EDD selection.

The actual import is started using the "Start" button.

 

Phase 1

First, the object structures in the project data storage are adapted as needed:

● Missing objects are generated. For device objects, the check to determine whether an 
object is 'missing' relies exclusively on address information and not on the name information.

● Adaptation of the type assignment after a positive consistency check.

● If the "Import identification data" check box is selected, the identification data are adapted.
 

 Note

During Phase 1, the import cannot be canceled.
 

 

Phase 2

The object structure based on the file to be imported is structured after conclusion of "Phase 
1". All device objects are shown in "blue", which is an indicator that they have been incorporated 
in the configuration.
If problems occur during the creation of the object structure, the relevant import objects are 
marked in the tree view and messages are generated. These can be called up using the 
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"Messages" button. 
In Phase 2, the parameter import occurs for all objects in the file to be imported. 

 

 Note

During "Phase 2", the import can be canceled. The object currently being processed will be 
completely processed.

 

After the conclusion of "Phase 1", "Phase 2" starts automatically.  The parameter import then 
follows for all import objects for which an error was not signaled during the first pass.

List
During the import process, the "Import" dialog box shows which objects have been processed 
so far in a tree view. 

The following icons are used to indicate the processing status:

The import was performed without error.

Messages and warnings occurred during the import.

The import was not performed due to an error.

The object is currently being processed elsewhere.

The import was not performed for this device.

The function is not supported by this device.

The import is currently running for this device.

Display
The dialog box is updated during the import. 

"Status" display

● During the process, the display field shows the entry "Import: action started.".

● Once the process is complete, the display field shows the entry "Import: action completed 
without error.".

Messages
Errors and warnings are entered in the message log.

Start
Starts the import.
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Stop
Stops the import.

The object currently being processed will be completely processed.

Close
Closes the dialog.

8.1.4 Print
You can print out the parameter list for a device. 

"Print" button

Setting the printer options
 

 Note

Note the following:
● The printer options depend on your computer's operating system and on the printer being 

used.
● The file is sent to the default printer.
● If the printout has more than one page, two periods are printed after the page number in 

the bottom right corner of the page. The last page does not have these periods, indicating 
no more pages are to follow.

 

Requirements
● SIMATIC PDM is open.

● In the structure view, an object is selected in the master folder of a device.
You can find information on the structure view in the section titled "Structure view 
(Page 61)".

Procedure
1. Select the menu command File > Print or click the "Print" button.

The "Print" dialog box opens.

2. Select the required options.

3. Click "OK".
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8.1.5 Exit
 

This command closes the "SIMATIC PDM" program.   

If changes have been made in the current session, a prompt appears giving you the option of 
saving the file before closing the program. 

8.1.5.1 "Save changes?" dialog box
This dialog box indicates that changes have been made, which have yet to be saved. 

● Click "Yes" if you want to save the changes.

● Click "No" if you want to discard the changes.

● Click "Cancel" if you do not want to exit SIMATIC PDM yet.

8.2 Editing (depends on device)
 

The menus and dialog boxes can contain other device-specific menu commands.

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, device-specific functions are grayed out in the second window and can only be 
accessed in the window that was opened first.

 

 Note

Device-specific menu items and help for these menu items are derived from the device 
description assigned to the object. You will find device-specific information in the online help 
and in the documentation provided by the device manufacturer. The PDF file associated with 
this documentation does not contain any device-specific information.

 

8.3 "Device" menu
 

The menus and dialog boxes can contain other device-specific menu commands.
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If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, device-specific functions are grayed out in the second window and can only be 
accessed in the window that was opened first.

 

 Note

Device-specific menu items and help for these menu items are derived from the device 
description assigned to the object. You will find device-specific information in the online help 
and in the documentation provided by the device manufacturer. The PDF file associated with 
this documentation does not contain any device-specific information.

 

8.3.1 Download to device
 

Figure 8-3 Download to devices... 

This menu command writes the parameters shown in the parameter table to the device.           

If you are not yet online, SIMATIC PDM makes an online connection at this time. 

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.

Errors and messages
During the loading, all errors and messages are shown immediately. Any errors occurring in 
a device do not cause the entire action to be aborted; they only apply to the device that is 
currently being processed. Errors and other messages are saved and can be displayed at a 
later time. 

Suppressing message dialogs

You can suppress message dialogs during the loading. Select the "Execute load without info 
dialogs" check box. You can find additional information with the Options > SIMATIC PDM > 
Settings > The "Load" tab (Page 185) menu command.

Additional information
You can find information on loading FF devices in the PCS 7 FOUNDATION Fieldbus 
commissioning manual

See also
"Download To Device - <...>" dialog box (Page 147)
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8.3.1.1 "Download To Device - <...>" dialog box
In this dialog box, you enter the desired settings for downloading the configuration data to the 
devices. 

"Select" area
If the object selected prior to loading contains subordinate objects, you can load the 
configuration to all subordinate objects. Use the option buttons in the "Select" area to make 
your selection.

● Object

● Object with all subordinate objects

● Object with all subordinate objects and networks

Field Explanations/operating instructions
Object Only downloads the data for the selected object. 
Object with all 
subordinate objects

Downloads the data for the selected object, including all subordinate objects.
Note: 
The tree structure can be expanded and collapsed for objects with 
subordinate objects.

Object with all 
subordinate objects and 
networks

Downloads the data from the selected object, including all subordinate 
substructures.

List   
The list in the dialog box shows the objects that are to be loaded in accordance with the option 
button that has been activated in the "Select" area.

The processing status is indicated by the following icons:

Upload performed without error. 

Messages and warnings occurred during the upload.

Upload was aborted due to an error.

The object is currently being processed elsewhere.

Upload has never been performed for this device.

Upload was not performed because the action is not supported by the device type.

Upload is currently underway for this device.

Display
The dialog box is updated while the data is being loaded.

Status display
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● During the process, the loading progress is indicated as a percentage for the relevant 
device.

● Once the process is complete, the display field shows the entry "Result".

Message log
● The message log shows errors and warnings or outputs from the EDD.

See also
Overview of Device Icons (Page 114)

8.3.2 Upload to PG/PC
 

Figure 8-4 Upload to PG/PC...

This menu command reads the parameters of the device and displays them in the parameter 
table.           

SIMATIC PDM will ask you if the existing data should also be saved offline before overwriting 
it. 

If you are not yet online, SIMATIC PDM makes an online connection at this time. 

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.

 

 Note

Before uploading to PG/PC from remote I/Os, you need to add a corresponding number of 
empty modules below the head module in the configuration.

 

Errors and messages
During the loading, all errors and messages are shown immediately. Any errors occurring in 
a device do not cause the entire action to be aborted; they only apply to the device that is 
currently being processed. Errors and other messages are saved and can be displayed at a 
later time. 

Suppressing message dialogs

You can suppress message dialogs during the loading. Select the "Execute load without info 
dialogs" check box. You can find additional information with the Options > SIMATIC PDM > 
Settings > The "Load" tab (Page 185) menu command.
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Additional information
You can find information on loading FF devices in the PCS 7 FOUNDATION Fieldbus 
commissioning manual

See also
"Upload to PG/PC - <...>" dialog box (Page 149)

8.3.2.1 "Upload to PG/PC - <...>" dialog box
In this dialog box, you enter the desired settings for uploading the data from the devices to the 
configuration data. 

"Select" area
If the object selected prior to loading contains subordinate objects, you can load the 
configuration to all subordinate objects. Use the option buttons in the "Select" area to make 
your selection.

● Object

● Object with all subordinate objects

● Object with all subordinate objects and networks

Field Explanations/operating instructions
Object Only downloads the data for the selected object. 
Object with all 
subordinate objects

Downloads the data for the selected object, including all subordinate objects.
Note: 
The tree structure can be expanded and collapsed for objects with 
subordinate objects.

Object with all 
subordinate objects and 
networks

Downloads the data from the selected object, including all subordinate 
substructures.

List     
The list in the dialog box shows the objects that are to be loaded in accordance with the option 
button that has been activated in the "Select" area.

The processing status is indicated by the following icons:

You can find more detailed information on icons in the section "Overview of Device Icons 
(Page 114)".

Upload performed without error.

Messages and warnings occurred during the upload.

Upload was aborted due to an error.
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The object is currently being processed elsewhere.

Upload has never been performed for this device.

Upload was not performed because the action is not supported by the device type.

Uploading is currently underway for this device.

Display
The dialog box is updated while the data is being loaded.

Status display

● During the process, the loading progress is indicated as a percentage for the relevant 
device.

● Once the process is complete, the display field shows the entry "Result".

Message log
● The message log only shows errors and warnings or outputs from the EDD.

8.3.3 Value comparison

8.3.3.1 Value comparison

Starts the comparison of device parameters. 

You make the settings for comparing device parameters in the "Value Comparison" dialog 
box (Page 150).

See also
Parameter table (Page 62)

8.3.3.2 "Value Comparison" dialog box

Purpose   
You start the comparison of device parameters in this dialog box. The value comparison is 
always based on the device parameter values saved in the project.

The device parameter values saved in the project can be compared with the following data 
types: 
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● Offline data
Device parameter values saved in the project.

● Online data
Parameter values currently saved in the device.

Comparisons
The following comparisons are possible:

● Comparison of the parameters of one device (offline/online parameter comparison)

● Comparison of the parameters of two devices:

– Offline/online parameter comparison

– Offline/offline parameter comparison

Selecting check boxes
The loaded object is the one which is currently selected in SIMATIC PDM in parameter 
assignment mode.

Comparison object Check box Additional information
Online data of the 
loaded object

Compare with online data of 
the loaded object

1. Click "Apply". The online data is read in 
from the device.

2. Click "OK".
Offline data of another 
object

Compare with offline data of 
another object

1. Click "Select object" dialog box 
(Page 152). 
The "Select object" dialog box (Page 152) 
dialog box opens.

2. Select the comparison object that you want 
to search for.

3. Click "Apply". The online data or offline 
data of the comparison object is read.

4. Click "OK".

Online data of another 
object

Compare with online data of 
another object

Display
The Parameter table (Page 62) is expanded by the columns for value, unit and status of the 
comparison object. These columns cannot be edited.

Display Meaning
No color difference in columns The respective parameters and the associated values are 

identical for both devices.
A yellow box in the value or unit 
column of the comparison object.

The parameter is available in both devices. The associated 
values are different.

Yellow box in the parameter column The parameter is only available in one device.
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Display Meaning
A plant-specific value check must be carried out. Automatic 
analysis is not possible.
The value has been changed.

8.3.3.3 "Select object" dialog box
Use this dialog box to select the required comparison objects or partner objects. 

8.3.4 Assign address and TAG
 

Figure 8-5 Assign address and TAG

In the "Assign address and TAG" dialog box, you can assign new addresses and device names 
to a device:

● PROFIBUS field devices

● FF field devices

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.

Changing the address and TAG online
For devices that can be reached online you can execute the following changes via the "Assign 
address and TAG" menu command:

● Move devices to any address within the segment or to a configured place

● For FF field devices: Change device name

Consistency check
● The name or the address cannot be changed in the object.

● The target address is occupied and/or is located in an unauthorized area.

● The device name is unauthorized and/or already present in the segment.
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Procedure
1. Open SIMATIC PDM for a configured device:

– In a process device view, select the menu command Edit > Open object.

– Double-click the device in HW Config.

2. Select the menu command Devices > Assign address and TAG... .

3. In the "online" area enter the following for the device located in the plant:

– the address (mandatory with PROFIBUS devices)

– Only possible with FF field devices: 
Enter the device designation (TAG) of the field device in the plant configuration.

4. Click "Search":

– A search is performed for a device at the online address entered.

– If the device is found the online data is displayed.

– The "Transfer" button is now enabled.

5. Click "Transfer".
 

 Note
Restart

Changing the address will restart the device.
 

Additional information
Section ""Assign address and TAG..." dialog box (Page 153)"

See also
Working with the LifeList (Page 117)

8.3.4.1 "Assign address and TAG..." dialog box

Requirement
An online connection to the field device must be available to execute this function.   
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Required steps
The application of the function consists of the following steps:

1. Find
Establish an online connection to a device with the relevant device address.

2. Transfer
Transfer address and tag to the device to which the online connection has been established.

Buttons

Button Function
Find
Button in the target 
device area (online)

You can use the search function in online mode to find a device with a specific 
address. 
Search criterion:
● For PROFIBUS devices: online address only
● For FF devices: online address or device name
The name and identification data of an online device found are displayed.

Transfer
(Device: Project) 
area

If there is an online connection to a device, you can transfer the project data 
entered in the "Name/TAG" and "Address" input boxes to the device.
If the operation is successful (status \"Transfer succeeded\"), the same 
information is in both boxes.

Reset address
(only available for 
FF devices)

● The "Reset address" button is only available for FF devices.
● The function "moves" the device to the area for temporary FF devices 

(reserved address range for FF devices - addresses 248 to 251). The name 
(TAG) remains unchanged.

● You can verify execution with LifeList .

 
 

 Note
Restart

Changing the address will restart the device.
 

 Note
Address or name (TAG) occupied

If the address or name (TAG) is occupied, then the action will not be performed. A 
corresponding message will be displayed.
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Device information
In the dialog box, the following data is shown for both the device in the project (source) and 
the detected device (online):

● Manufacturer

● Device type

● Device revision

See also
Working with the LifeList (Page 117)

8.3.5 Object properties
 

Displays general information about the selected object. 

This information is stored together with the parameter set. 
Depending on the device, some of this information can be transferred to the device, for 
example:

● TAG

● Message

● Description

● Address

● ...

See also
"General" tab (Page 155)

"Device" tab (Page 156)

"Diagnostics" tab (Page 157)

"Communication" tab (Page 157)

"Document Manager" tab (Page 157)

8.3.5.1 "General" tab

Purpose   
On this tab you will find information on the PDM object and you can enter additional information, 
if you so wish. 
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You can find information on this in the section ""Options" menu (Page 180)".

Field Explanations/operating instructions
Object name (TAG) The name of the PDM object assigned during configuration is entered here 

as a default. 
You can enter a new object name. The change is applied everywhere where 
reference is made to the object name. The name is only visibly updated once 
the change has been saved or (in some cases) when the object concerned 
is next opened.

Description Enter a comment for the object here, e.g. plant area and function, or leave 
the field blank.

Message Enter a message here for a service technician, for example, or leave the field 
blank. 

Text 1 Enter additional information here or leave the field blank.
Text 2 Enter additional information here or leave the field blank.
Text 3 Enter additional information here or leave the field blank.
Author Enter the name of the author or leave the field blank.
Created on: Displays the date on which the PDM object was created.
Revision date Displays the date on which the last change was made.
Comment Enter a comment here or leave the field blank.
"System configuration" 
check box

If this option is activated, the object is linked with the system for hardware 
configuration (e.g. with STEP 7/HW Config).

License information Shows the utilization of the TAG licenses (number of tags used and licensed 
TAGs).

Entries that appear in bold within this table can be changed.

8.3.5.2 "Device" tab

Purpose   
You display the device data in this tab. 

The contents of the fields cannot be changed. The contents are derived from the device 
description assigned to the object provided they are entered in this description. 

Some entries are displayed as codes instead of plain text.

Field Explanations/operating instructions
Device Type Shows the device type as specified in the "Device Selection" dialog box.
Device DDL Shows the device description file assigned to the object.
Order number Shows the order number of the device.
MANUFACTURER: Shows the manufacturer.
DD_REVISION: Shows the version of the device description file (hexadecimal format).
DEVICE_TYPE: Shows the device type (hexadecimal format).
DEVICE_REVISION: Shows the hardware version of the device (hexadecimal format).
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8.3.5.3 "Diagnostics" tab

Purpose 
In this tab, you can display information about the communication of the device. The icon shown 
for the device depends on the information available. 

Field Explanations/operating instructions
Communication Shows whether the communication is good or faulty.
Device status Shows specific information about the status of the connected device. 
Last check Shows the date when the device was last tested.
Message text Shows detailed information about the device status.

"Update Diagnostics" button
Click the "Update Diagnostics" button if required.

8.3.5.4 "Communication" tab

Purpose
On this tab you can display the address of a device. If the device was configured in the process 
devices network view, you can change the address.

The "Redundancy" area is displayed for field devices which are capable of redundant 
interconnection.

See also
Connecting field devices to a redundant bus system (Page 92)

"Select object" dialog box (Page 93)

8.3.5.5 "Document Manager" tab
Use this tab to assign documents to a PDM object.
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Actions on the "Document Manager" tab

Action To execute
File 1. Click the "..." button.

2. Navigate to the document required.
3. Click "Open".

The storage path and file name of the selected file is displayed 
in the "File" box.

Title Enter a name for the document.
Test whether a document can be 
displayed

Select the menu command Open.

Remove a document from the list Select the menu command Reset.

Open documents
To open the documents, select the SIMATIC PDM menu command Help > Document 
Manager. Use the mouse to select the required document from the submenu.

8.3.6 Change log

8.3.6.1 Show Change Log...

The change log records which actions have been performed with SIMATIC PDM on objects 
of the plant. 

Properties 
● The change log is part of the associated SIMATIC project.

● The change log is a circular log (first in, first out).

● Some boxes of the change log are created automatically. Information is entered in the 
language preset in the SIMATIC project.

Requirements for using the "Change Log" function
You need the "SIMATIC PDM Extended" license key to use the "Change log" function.

Entries in the change log
The "SIMATIC PDM Change Log" dialog window displays actions which have been performed 
in the project or on individual objects (devices). The displayed actions depend on the object 
displayed in SIMATIC PDM.
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You can limit the displayed information by setting the filter. The "Action" drop-down list box of 
the filter shows which actions can be displayed.

It comprises the following entries:

Column Meaning
Object identification Data base identification of the object (device or network) for which a change 

was made.
Object name Name of the object (device or network) for which a change was made.
Action What was done?
Time When was the action performed?

Time set on the computer when the action was carried out.
Description Description of action
Details Details of action
Comment Comment which a user entered before applying a change.

Prerequisite for an entry:
In the SIMATIC PDM settings, the "Show entry dialog for change log comments" 
check box on the "General" tab must be selected.

User name Who has made the change?
Logon details of the user who performed the change.

Computer name Where was the action performed?
Name of the computer from which the change was made.

Object path Name of a device

8.3.6.2 Menus and dialog boxes

File menu

Add entry
Adds a manual entry to the change log.

Archiving
Archives the entries depending on the set date.

Load archive
Loads an archived change log.

Print
Prints the currently displayed view.
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Close
Closes the change log.

View menu

Filter
Reduces the information displayed in the change log.

Find
Finds entries in the change log after input of a search term. 

"Find" dialog box
Procedure

1. Select the menu command View > Find.
The "Find" dialog box opens.

2. Enter the string you are looking for.

3. Click "Find next".

Settings in the "Find" dialog box
● Entry field

 You can enter any string. You can search for this string.

● "Find next" button
The system searches through the displayed device list. The displayed change log is 
searched and the found entry selected.
The next entry found is selected when you press the button again. The search starts all 
over again at the end of the list. 
A message will inform you if no matching entry is found.

● "Close" button
Closes the dialog.

Show all objects
Toggles the view between all objects and the object for which the change log was called.

Help menu

Help
Opens the help for SIMATIC PDM. 
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You can navigate to different help topics from the Table of Contents. The "Index" and "Find" 
functions enable you to display information on specific terms. 

About...
Opens the information about the version and the copyright details of SIMATIC PDM.     

8.3.6.3 Menu bar

Structure
Below, you will find an overview of the Change log menus.

Menu Submenu 
File
 

● Add entry (Page 159)
● Archiving (Page 159)
● Load archive (Page 159)
● Print (Page 159)
● Close (Page 160)

View ● Filter (Page 160)
● Find (Page 160)
● Show all objects (Page 160)

Help ● Help (Page 160)
● About... (Page 161)

8.3.6.4 Toolbar
The toolbar is located below the menu bar and includes several buttons. By clicking on a button, 
you can perform frequently used menu commands without having to open the menu. 

 

Icons     
Meanings of the icons used:

Icon Menu 
command

Description

Add entry 
(Page 159) 

A manual entry is added to the change log.

Print 
(Page 159) 

The current view is printed.
Opens the "Print" dialog box. Select a printer that is available on the 
computer.
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Icon Menu 
command

Description

Filter 
(Page 160)

The displayed change log is filtered.
Opens the "Filter" dialog box. Enter a string and define the filter 
options.

Find 
(Page 160) 

The displayed change log is searched.
Opens the "Find" dialog box. Enter a string and define the search 
options.

Show all 
objects 
(Page 160) 

Toggles the view between all objects and the view from which the 
change log was called.

Help 
(Page 160) 

The SIMATIC PDM help opens.

8.4 "View" menu 
 

The menus and dialog boxes can contain other device-specific menu commands.

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, device-specific functions are grayed out in the second window and can only be 
accessed in the window that was opened first.

 

 Note

Device-specific menu items and help for these menu items are derived from the device 
description assigned to the object. You will find device-specific information in the online help 
and in the documentation provided by the device manufacturer. The PDF file associated with 
this documentation does not contain any device-specific information.

 

8.4.1 Process variables / Measured value display (depends on device)

General Information         
Opens the "Process variables" or "Measured value display" online dialog box. 

Structure
The dialog box and its associated help program are structured in a device-specific manner. 
The information required for this is derived from the device description assigned to the object. 
Therefore, this dialog box cannot be described in detail here.

The device description contains the following information:

● Structure of the individual tabs

● Which values are displayed
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● Where and how the values are displayed

● Scope of the message window

● Scope and content of the device-specific help program

Status information
Status icons can be displayed for every value shown in the dialog box. You can find information 
on this in the section ""Status" column of the parameter table (Page 63)".

Operator elements
● "Close" button

● "Messages" button

● "Help" button

Cycle time
If there is an online connection to the field device, the process variables displayed in the dialog 
box are updated cyclically. To set the cycle time, select the menu command Options > SIMATIC 
PDM > Settings in SIMATIC Manager and then go to the "Communication (Page 184)" tab.

8.4.2 Start LifeList
This menu command is used to call the LifeList.

LifeList makes it possible to identify active field devices without configuration. With LifeList , 
you perform a scan on one of the following network objects:

● PROFIBUS DP network

● PA network

● FF network

See also
"LifeList" dialog box (Page 119)

8.4.3 Charts and trends (depends on device)
 
 

 Note

History trends can be displayed in SIMATIC PDM if they are provided by the manufacturer 
of the device description.
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Additional information
● Section "Trend chart (Page 125)"

● Section "Work with trends (Page 130)"

● Section "Editing trends (Page 132)"

● Section "Icons and buttons (Page 129)"

Example
The figure below shows an example of a dialog window with history trends.     

 

8.4.3.1 Displaying process variables and measured values 
 

 

 Note

Functions for the display of process variables and measured values are available in SIMATIC 
PDM, if they are provided by the manufacturer of the device description.
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 Note

If the color of the value to be displayed changes from orange to yellow, the parameter could 
not be read within the monitoring time.

 

Additional information
● Section "Trend chart (Page 125)"

● Section "Tachometer chart (Page 127)"

● Section "Bar chart (Page 126)"

● Section "Icons and buttons (Page 129)"

● Section "Work with trends (Page 130)"

● Section "Editing trends (Page 132)"

8.5 "Diagnostics" menu
 

The menus and dialog boxes can contain other device-specific menu commands.

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, device-specific functions are grayed out in the second window and can only be 
accessed in the window that was opened first.

 

 Note

Device-specific menu items and help for these menu items are derived from the device 
description assigned to the object. You will find device-specific information in the online help 
and in the documentation provided by the device manufacturer. The PDF file associated with 
this documentation does not contain any device-specific information.

 

8.5.1 Update diagnostic status
 

SIMATIC PDM attempts to establish an online connection to the object which is currently 
selected and to update the status.         

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.
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See also
"Update diagnostics - <...>" dialog box (Page 166)

8.5.1.1 "Update diagnostics - <...>" dialog box
In this dialog box, you select the objects whose diagnostic status you want to update. 

"Select" area
If the object selected prior to carrying out the menu command contains subordinate objects, 
you can determine the diagnostic status for all subordinate objects. Use the option buttons in 
the "Select" area to make your selection.

● Object

● Object with all subordinate objects

● Object with all subordinate objects and networks

Field Explanations/operating instructions
Object Determines the diagnostic status of the selected object. 
Object with all 
subordinate objects

Determines the diagnostic status of the selected object, including all 
subordinate objects.
Note: 
The tree structure can be expanded and collapsed for objects with 
subordinate objects.

Object with all 
subordinate objects and 
networks

Determines the diagnostic status of the selected object, including all 
subordinate substructures.

Starting an action
The diagnostic status of the selected object is not determined automatically. Click "Start" to 
start the action for the current selection.

List   
The list in the dialog box shows the objects for which the diagnostic status is to be determined 
in accordance with the option button that has been activated in the "Select" area.

The processing status is indicated by the following icons:

The diagnostic status was determined. 

Messages and warnings occurred during determination of the diagnostic status.

Determination of diagnostic status was aborted due to an error.

The object is currently being processed elsewhere.

Determining diagnostic status has never been performed for this device.
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Determining diagnostic status was not performed because the action is not supported by 
the device type.
Determination of diagnostic status is currently underway for this device.

Display
Click "Start" to execute the menu command. The dialog box is updated as long as the function 
is executed or until the function is canceled.

Status display

● During the process, the progress is indicated as a percentage for the relevant device.

● Once the process is complete, the display field shows the entry "Result".

Messages
The message log shows errors and warnings or outputs from the EDD.

8.6 "Options" menu (depends on device)
 

The menus and dialog boxes can contain other device-specific menu commands.

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, device-specific functions are grayed out in the second window and can only be 
accessed in the window that was opened first.

 

 Note

Device-specific menu items and help for these menu items are derived from the device 
description assigned to the object. You will find device-specific information in the online help 
and in the documentation provided by the device manufacturer. The PDF file associated with 
this documentation does not contain any device-specific information.

 

8.7 "Help" menu

8.7.1 Contents
This menu command displays the Help on SIMATIC PDM. 

You can navigate to different help topics from the Table of Contents. The "Index" and "Find" 
functions enable you to display information on specific terms. 
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8.7.2 Help for device parameters
This menu commands calls the device-specific help with descriptions of the parameters. 

Note: The device-specific help is derived from the device description assigned to the object.

8.7.3 About...
This menu command displays information about the software version and the copyright. 

8.7.4 Find...
The displayed parameter list is scanned.

You may enter any string. You can run the search for this string.

8.7.5 Document Manager
In the submenu of the "Document Manager" menu command, you can call the documents 
assigned to a PDM object.

To assign the documents, select the menu command Device > Object Properties > Document 
Manager.

Additional information
● Section "Inserting plant-specific documents for process mode (Page 97)"

● Section ""Document Manager" tab (Page 157)"
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Menus and dialog boxes for SIMATIC PDM in the 
SIMATIC Manager 9
9.1 "Edit" menu

9.1.1 SIMATIC Manager > "Edit" menu
Installing SIMATIC PDM makes additional functions available in the Edit menu of SIMATIC 
Manager. 

Requirement
A field device or a network with subordinate field devices is selected in one of the SIMATIC 
PDM views.

Functions
● Start SIMATIC PDM

Select menu command Edit > Open object.

● SIMATIC PDM functions
The following functions are available in the Edit > SIMATIC PDM menu:

– Export... (Page 138) 

– Import ... (Page 140) 

– Download to device (Page 146) 

– Upload to PG/PC (Page 148) 

– Update diagnostic status (Page 165) 

– Start LifeList (Page 175) 

– Device selection (Reassign) (Page 175) 

– Show Change Log... (Page 177)

9.1.2 Object properties
 

Displays general information about the selected object. 
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This information is stored together with the parameter set. 
Depending on the device, some of this information can be transferred to the device, for 
example:

● TAG

● Message

● Description

● Address

● ...

See also
"General" tab (Page 155)

"Device" tab (Page 156)

"Diagnostics" tab (Page 157)

"Communication" tab (Page 157)

"Document Manager" tab (Page 157)

9.1.2.1 "General" tab

Purpose   
On this tab you will find information on the PDM object and you can enter additional information, 
if you so wish. 

You can find information on this in the section ""Options" menu (Page 180)".

Field Explanations/operating instructions
Object name (TAG) The name of the PDM object assigned during configuration is entered here 

as a default. 
You can enter a new object name. The change is applied everywhere where 
reference is made to the object name. The name is only visibly updated once 
the change has been saved or (in some cases) when the object concerned 
is next opened.

Description Enter a comment for the object here, e.g. plant area and function, or leave 
the field blank.

Message Enter a message here for a service technician, for example, or leave the field 
blank. 

Text 1 Enter additional information here or leave the field blank.
Text 2 Enter additional information here or leave the field blank.
Text 3 Enter additional information here or leave the field blank.
Author Enter the name of the author or leave the field blank.
Created on: Displays the date on which the PDM object was created.
Revision date Displays the date on which the last change was made.
Comment Enter a comment here or leave the field blank.
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Field Explanations/operating instructions
"System configuration" 
check box

If this option is activated, the object is linked with the system for hardware 
configuration (e.g. with STEP 7/HW Config).

License information Shows the utilization of the TAG licenses (number of tags used and licensed 
TAGs).

Entries that appear in bold within this table can be changed.

9.1.2.2 "Device" tab

Purpose   
You display the device data in this tab. 

The contents of the fields cannot be changed. The contents are derived from the device 
description assigned to the object provided they are entered in this description. 

Some entries are displayed as codes instead of plain text.

Field Explanations/operating instructions
Device Type Shows the device type as specified in the "Device Selection" dialog box.
Device DDL Shows the device description file assigned to the object.
Order number Shows the order number of the device.
MANUFACTURER: Shows the manufacturer.
DD_REVISION: Shows the version of the device description file (hexadecimal format).
DEVICE_TYPE: Shows the device type (hexadecimal format).
DEVICE_REVISION: Shows the hardware version of the device (hexadecimal format).

9.1.2.3 "Diagnostics" tab

Purpose 
In this tab, you can display information about the communication of the device. The icon shown 
for the device depends on the information available. 

Field Explanations/operating instructions
Communication Shows whether the communication is good or faulty.
Device status Shows specific information about the status of the connected device. 
Last check Shows the date when the device was last tested.
Message text Shows detailed information about the device status.

"Update Diagnostics" button
Click the "Update Diagnostics" button if required.
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9.1.2.4 "Communication" tab

Purpose
On this tab you can display the address of a device. If the device was configured in the process 
devices network view, you can change the address.

The "Redundancy" area is displayed for field devices which are capable of redundant 
interconnection.

See also
Connecting field devices to a redundant bus system (Page 92)

"Select object" dialog box (Page 93)

9.1.2.5 "Document Manager" tab
Use this tab to assign documents to a PDM object.

Actions on the "Document Manager" tab

Action To execute
File 1. Click the "..." button.

2. Navigate to the document required.
3. Click "Open".

The storage path and file name of the selected file is displayed 
in the "File" box.

Title Enter a name for the document.
Test whether a document can be 
displayed

Select the menu command Open.

Remove a document from the list Select the menu command Reset.

Open documents
To open the documents, select the SIMATIC PDM menu command Help > Document 
Manager. Use the mouse to select the required document from the submenu.

9.1.3 SIMATIC PDM

9.1.3.1 Export...

Figure 9-1 Export... 
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This menu command starts the export of device data of a PDM object to an XML file.       

Make the settings for the export of device data in the "Export - <object name>" dialog.

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.

See also
"Export - <Object name>" dialog box (Page 138)

9.1.3.2 Import ...

Figure 9-2 Import ... 

This menu command starts the import of device data from an XML file to a PDM object.       

Make the settings for the import of device data in the "Import - <object name>" dialog. 

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.

See also
"Import - <Object name>" dialog box (Page 141)

9.1.3.3 Download to device

Figure 9-3 Download to devices... 

This menu command writes the parameters shown in the parameter table to the device.           

If you are not yet online, SIMATIC PDM makes an online connection at this time. 

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.

Errors and messages
During the loading, all errors and messages are shown immediately. Any errors occurring in 
a device do not cause the entire action to be aborted; they only apply to the device that is 
currently being processed. Errors and other messages are saved and can be displayed at a 
later time. 

Suppressing message dialogs
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You can suppress message dialogs during the loading. Select the "Execute load without info 
dialogs" check box. You can find additional information with the Options > SIMATIC PDM > 
Settings > The "Load" tab (Page 185) menu command.

Additional information
You can find information on loading FF devices in the PCS 7 FOUNDATION Fieldbus 
commissioning manual

See also
"Download To Device - <...>" dialog box (Page 147)

9.1.3.4 Upload to PG/PC

Figure 9-4 Upload to PG/PC...

This menu command reads the parameters of the device and displays them in the parameter 
table.           

SIMATIC PDM will ask you if the existing data should also be saved offline before overwriting 
it. 

If you are not yet online, SIMATIC PDM makes an online connection at this time. 

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.

 

 Note

Before uploading to PG/PC from remote I/Os, you need to add a corresponding number of 
empty modules below the head module in the configuration.

 

Errors and messages
During the loading, all errors and messages are shown immediately. Any errors occurring in 
a device do not cause the entire action to be aborted; they only apply to the device that is 
currently being processed. Errors and other messages are saved and can be displayed at a 
later time. 

Suppressing message dialogs

You can suppress message dialogs during the loading. Select the "Execute load without info 
dialogs" check box. You can find additional information with the Options > SIMATIC PDM > 
Settings > The "Load" tab (Page 185) menu command.

Menus and dialog boxes for SIMATIC PDM in the SIMATIC Manager
9.1 "Edit" menu

Help for SIMATIC PDM (V8.0.2)
174 Operating Manual, 12/2012, A5E03515631-02



Additional information
You can find information on loading FF devices in the PCS 7 FOUNDATION Fieldbus 
commissioning manual

See also
"Upload to PG/PC - <...>" dialog box (Page 149)

9.1.3.5 Update diagnostic status

SIMATIC PDM attempts to establish an online connection to the object which is currently 
selected and to update the status.         

If a device is opened twice, for example, by opening the higher-level network and by opening 
it directly, this menu item is grayed out in the second window and can only be accessed in the 
window that was opened first.

See also
"Update diagnostics - <...>" dialog box (Page 166)

9.1.3.6 Start LifeList
This menu command is used to call the LifeList.

LifeList makes it possible to identify active field devices without configuration. With LifeList , 
you perform a scan on one of the following network objects:

● PROFIBUS DP network

● PA network

● FF network

See also
"LifeList" dialog box (Page 119)

9.1.3.7 Device selection (Reassign)
Use this menu to assign a different or new device description (EDD) to an object.
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The devices are structured by the device types in a tree structure.       
 

 Note
Integrated devices

You can only select devices for which a device description file has been integrated via the 
Device Integration Manager.

 

Device description dependency
When a device is replaced in a plant, you have to update the project in SIMATIC PDM. When 
devices are replaced in a plant, the following situations can arise:

● Device description is compatible
The device to be replaced can be operated with the device description of the device to be 
integrated (e.g. after updating the firmware). 
The configuration can be downloaded to the device to be integrated.

● Device description is incompatible
The device to be replaced cannot be operated with the device description of the device to 
be integrated (e.g. replacing device with one from a different manufacturer).
The device to be replaced should be removed from the configuration when replacing this 
device with an incompatible one. Reconfigure the device.

 

  Note
Recommendation

Export the device data before making the change, because the device will be initialized 
again with the new device description.
The following steps describe how to reassign the device description.

 

Assigning a device description to an object
You have the following options for assigning a device description to an object:

● Identify a device via an online connection

● Assigning the device description manually

Identify a device via an online connection
If you have an online connection to the device, click the "Device identification" button.

● "Device identification" button
When you click this button, a connection to the device is established and an attempt is 
made to read the information from the device and assign the required device description 
to it.

● If not all the necessary information could be read out, you need to assign the device 
description manually. After device identification 
you can only see the structures required for the device in the tree structure. 
Make your selection from these structures.
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Assigning the device description manually
Select the required device description from the "Device catalog" list, based on the following 
data:

● Device type

● Manufacturer

● Device

● Revision
 

  Note
Note on remote I/Os

With remote I/O, you search for the manufacturer and a type for the head-end station 
during device selection. 

Assign the required device description to the device.
 

Device description missing from PC
Open the Device Integration Manager and integrate the missing device descriptions.

See also
How to integrate a device description (Page 38)

9.1.3.8 Show Change Log...

The change log records which actions have been performed with SIMATIC PDM on objects 
of the plant. 

Properties 
● The change log is part of the associated SIMATIC project.

● The change log is a circular log (first in, first out).

● Some boxes of the change log are created automatically. Information is entered in the 
language preset in the SIMATIC project.

Requirements for using the "Change Log" function
You need the "SIMATIC PDM Extended" license key to use the "Change log" function.
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Entries in the change log
The "SIMATIC PDM Change Log" dialog window displays actions which have been performed 
in the project or on individual objects (devices). The displayed actions depend on the object 
displayed in SIMATIC PDM.
You can limit the displayed information by setting the filter. The "Action" drop-down list box of 
the filter shows which actions can be displayed.

It comprises the following entries:

Column Meaning
Object identification Data base identification of the object (device or network) for which a change 

was made.
Object name Name of the object (device or network) for which a change was made.
Action What was done?
Time When was the action performed?

Time set on the computer when the action was carried out.
Description Description of action
Details Details of action
Comment Comment which a user entered before applying a change.

Prerequisite for an entry:
In the SIMATIC PDM settings, the "Show entry dialog for change log comments" 
check box on the "General" tab must be selected.

User name Who has made the change?
Logon details of the user who performed the change.

Computer name Where was the action performed?
Name of the computer from which the change was made.

Object path Name of a device

9.2 "Insert" menu

9.2.1 Inserting an object
Installing SIMATIC PDM makes additional functions available in SIMATIC Manager. These 
can be accessed by selecting the menu command Insert > SIMATIC PDM.

Select the PDM object that you want to insert. Depending on the object selected in SIMATIC 
Manager, only objects which can be inserted at the selected object are available.

Requirement
One of the following views is open:

● Process devices network view

● Process devices plant view
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Purpose   
The configured view determines which of the following object types can be inserted:

● Object

● Networks

● Communications network

● Devices

Insert > SIMATIC PDM > <submenu>

Networks (process devices network view) and devices (process devices plant view)
● You can select the "Networks" menu command in the process devices network view. This 

menu command expands the tree structure by adding the "Networks" folder for working 
with PDM objects.

● You can select the "Devices" menu command in the process devices network view. This 
menu command expands the tree structure by adding the "Devices" folder for working with 
PDM objects.

 

  Note
"Networks" (process devices network view) and "Devices" (process devices plant view) 
folders

If you want to reuse copied projects without PDM objects, you can delete this folder 
including the PDM configuration it contains. Select the following function in the SIMATIC 
Manager: File > Save As ... with the "With reorganization (slow)" check box selected. 

 

Communications network (process devices network view)
In the process devices network view, you can create the following communications networks 
under the "Networks" folder: 

● PROFIBUS DP network.

● PROFINET network

Selecting the menu command opens the selection dialog ("Insert object - <...>" dialog box).

You can use the menu command to create the following objects:

● First time only: 
The "PC station" object (PDM computer, computer on which PDM is installed)

● The communications network
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Objects 
● Process devices network view

In the process devices network view, you can create objects for field devices. This is done 
at a communications network.
Selecting the menu command opens the selection dialog ("Insert object - <...>" dialog box). 
Click the "Assign device type... " button. The "SIMATIC PDM device selection" dialog box 
opens. Select the field devices in the tree structure.

● Process devices plant view
You can create objects (objects for field devices) in the process devices plant view under 
the "Devices" folder.
Selecting the menu command opens the selection dialog ("Insert object - <...>" dialog box). 
Click the "Assign device type... " button. The "SIMATIC PDM device selection" dialog box 
opens. Select the field devices in the tree structure.

9.3 "View" menu 

9.3.1 Process devices plant view
In SIMATIC Manager, you call the process devices plant view using the menu command View 
> Process devices plant view.

The process devices plant view provides an overview of all configured devices in all configured 
networks. This view is used to obtain a quick overview of the configured devices. You cannot 
configure new networks in this view.  

9.3.2 Process devices network view
In SIMATIC Manager, you call the process devices network view using the menu command 
View > Process devices network view.

The process devices network view displays the devices in groups according to the network 
topology. Devices that can be reached via several networks are displayed multiple times. You 
can configure networks and process devices in this view.  

9.4 "Options" menu
 

You will find the following views in SIMATIC Manager after the installation of SIMATIC PDM:

● Process devices plant view

● Process devices network view

Menus and dialog boxes for SIMATIC PDM in the SIMATIC Manager
9.4 "Options" menu

Help for SIMATIC PDM (V8.0.2)
180 Operating Manual, 12/2012, A5E03515631-02



Project settings
The project settings are made in the SIMATIC Manager. These settings apply to the SIMATIC 
project and SIMATIC PDM.

● Language for the menus and dialog boxes

● Default project view

● Display

● Details in the columns

Project settings
You make the project settings in SIMATIC Manager using the following menu command: 
Options > Settings ... .

Settings Tab  
Language selection
 

"Language" tab Language displayed in the menus and dialog 
boxes in the SIMATIC Manager and SIMATIC 
PDM

Default project view
 

"View" tab Start view for the SIMATIC Manager; 
available views for SIMATIC PDM:
● Process devices plant view
● Process devices network view

Details in the columns
 

"Columns" tab Views and object types in the parameter table

"Columns" tab
On the "Columns" tab, you can select the columns that you want to be displayed in a PDM 
view.

Select an object type in the tree structure. Then go to the "Visible Columns" list and activate 
the check boxes for the entries you want to be displayed for the selected object type.

Object types

● Type 1 in the tree structure

– Process devices plant view

– Process devices network view

● Type 2 in the tree structure

– Process devices plant view > Devices

● Type 3

– Process devices network view > Networks

Menus and dialog boxes for SIMATIC PDM in the SIMATIC Manager
9.4 "Options" menu

Help for SIMATIC PDM (V8.0.2)
Operating Manual, 12/2012, A5E03515631-02 181



● Type 4

– Process devices network view > Networks > PC

● Type 5

– Process devices network view > Networks > Communications network

– Process devices network view > Networks > Communications network > Object (on all 
subordinate levels)

 Visible columns
Object type Type 1 Type 2 Type 3 Type 4 Type 5
Object name Standard Standard Standard Standard Standard
Picture Name For OS Standard     
LID
(Location identifier denotes the 
installation position of a device)

 Standard    

Address  x  Standard Standard
Description Standard Standard Standard Standard Standard
Message Standard Standard Standard Standard Standard
Device status  Standard   Standard
Last communication  Standard   Standard
Text1 x x x x x
Text2 x x x x x
Text3 x x x x x
Device  Standard x x Standard
PLT ID
(process control ID generated 
internally by PDM for 
identification of an object for 
connections to the Asset 
Management System (PCS 7 
Maintenance Station and PDM 
Maintenance Station))

 Standard   x

Manufacturer  Standard   Standard
Serial number  x   x
Install date  x   x
Hardware version  x   x
Software version  x   x
Order number  x   x
Object status  Standard   Standard
DD revision  x   x
Author x x x x x
Revision date Standard Standard Standard Standard Standard
Comment x x x x x
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● Type 6

– Settings for a multiproject

 Process devices plant view (multiproject) Process devices network view (multiproject)
Object type   
Object name Standard Standard
Project language Standard Standard
UNC path Standard Standard
Path to "Computer" Standard Standard
Computer Standard Standard
Computer after removal Standard Standard
Path after removal Standard Standard

See also
Settings for SIMATIC PDM (Page 183)

Menus and dialog boxes for SIMATIC PDM in the SIMATIC Manager (Page 169)

9.4.1 Settings for SIMATIC PDM

9.4.1.1 Settings for SIMATIC PDM
This command opens the "Settings" dialog box.     

In this dialog box, you can adapt SIMATIC PDM to your preferences and requirements.

Setting options for SIMATIC PDM
Select the menu command Options > SIMATIC PDM > Settings... .

Settings Tab Notes
Device parameters "General" tab (Page 184) Display of the device parameters
Communication "Communication" tab 

(Page 184) 
Settings for communication

Load procedures The "Load" tab (Page 185) Selection of information for load procedures
Device Integration 
Manager

"Device Integration 
Manager" tab (Page 186) 

Settings for the Device Integration Manager

Maintenance project "Maintenance" tab 
(Page 188) 

Settings for the maintenance station project

Change log "Change Log" tab 
(Page 188)

Settings for the change log

Service "Service" tab (Page 189) Settings for expert mode of SIMATIC PDM
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See also
"Settings" for the SIMATIC project (Page 70)

9.4.1.2 "General" tab

Purpose   
You can set the display of the device parameters in this tab.

Area Field Explanations/operating instructions
Project Check box "Use message as long TAG for 

HART devices with HART revision < V6"
If this check box is selected, the string stored in the 
"Message" parameter is sent as a "Long TAG" for HART 
devices with a HART revision prior to V6. 

"Select type when device is inserted in HW 
Config" check box

If the check box is selected, the dialog for device type 
selection appears immediately when you insert a device in 
HW Config if the device cannot be assigned explicitly to a 
device type.
If the check box is cleared, this dialog does not appear until 
the device is opened for the first time.

File paths HTML transformation file Xsl file which includes the information for display in HTML 
format.

Path for "Export" files Storage path for files created with the "Export" function.
Path for "Asset export" files Storage path for "Asset export" files
Path for "Document" files Storage path for "Document Manager" files
Path for "Message protocol" files Storage path for "Message protocol" files
Path for "Compare Log" files Storage path for "Compare Log" files
Path for "Archive" files Storage path for "Archive" files

9.4.1.3 "Communication" tab

Purpose   
The following communication settings can be made in this tab:

Field Explanations/operating instructions
Cycle time
(default value: 1000 
ms)

Updating of the values shown in the "Process value display" dialog box is carried 
out in accordance with the time interval entered here. 
Note: You can change the cycle time value for periodic communication jobs. We 
recommend against significantly reducing the cycle time unless absolutely 
necessary. 

Identity If the "Identity check" check box is activated, SIMATIC PDM performs an identity 
check automatically each time there is any online communication.
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Field Explanations/operating instructions
Device diagnostics If the "Diagnostics update" check box is activated, SIMATIC PDM performs 

device diagnostics automatically each time there is any online communication.
HART 
communication

If the "SHC mode active" option is activated, SIMATIC PDM independently 
detects for the analog channels of HART remote I/Os whether the SHC function 
(uninterrupted HART command sequence) as per the "HART on PROFIBUS" 
specification from the "PROFIBUS & PROFINET International (PI)" fieldbus 
organization is supported. 
● SIMATIC PDM is able to use SHC mode, if the HART module of the remote 

I/O supports this mode. 
This results in shorter reading and writing times for the parameter data of 
HART field devices.

● If the HART module of the remote I/O does not support SHC mode, the 
conventional communication method is used instead.

Note: 
Communication with HART field devices aborted:
If communication with individual HART field devices is aborted repeatedly when 
this option is used, you should deactivate it when working with the HART field 
devices concerned.

Identity check and device diagnostics
 

 Note
Reduction of times for servicing or loop check

You can reduce the load / read times by up to 20 seconds if you deactivate the ID check and 
device diagnostics. You can still use the "Update diagnostic status (Page 175)" function for 
diagnostics.
● During any communication with the field device, identity is checked and the diagnostics 

is updated.
● You have the option of disabling these functions
● Manually updating the diagnostics is still possible

 

 

9.4.1.4 The "Load" tab
On the "Load" tab, specify which information you want to be displayed during loading 
processes. 
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"Upload to PG/PC" area

Check box Explanations/operating instructions
Save parameter set in project 
data regardless of 
transmission errors.

Saves the configured parameters even if individual parameters could 
not be loaded from the device. 

Save inconsistent parameter 
sets in project data

Saves the parameters received from the device, even if individual 
parameters have invalid values (for example, range limit exceeded). 

Execute even if the device 
TAG does not match the 
project data TAG

Executes the action even if the device identifiers in the device and in 
the project data differ.

"Download To Device" area

Check box Explanations/operating instructions
Reset changed configuration 
flag

Resets the change flag after successfully loading a device.

Download inconsistent 
parameter sets to the device.

Writes parameter values to the device, even if the values are invalid 
(e.g. range exceeded). 

Execute even if the device 
TAG does not match the 
project data TAG

Executes the action even if the device identifiers in the device and in 
the project data differ.

"Execute 'Load' without info dialogs" check box
If this check box is selected, information dialogs are not displayed during download. This setting 
applies to all loading processes.

"Exclude passivated FF blocks" check box
If this check box is selected, passivated function blocks are ignored during download. 

9.4.1.5 "Device Integration Manager" tab

Core statement
You can open the configuration dialog for the Device Integration Manager by selecting the 
menu command Options > SIMATIC PDM > Settings... in SIMATIC Manager and then opening 
the "Device Integration Manager" tab.       

Visible columns Displayed information
Status Status of the device description integration
Path Catalog path of the devices for which a device description was found.
Device name Device name
Manufacturer Manufacturer
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Visible columns Displayed information
Communication Communication type for the connection to the field device.
Device class Hierarchical name of the device type (e.g. flow sensor)
New version Version of the device description which was read in from a device description library.
Integrated version Version of the device description that is integrated in SIMATIC PDM.
Integrated on Date on which a device description was integrated into SIMATIC PDM.
Description Descriptive text from the device description
Type ID ID for a device type in hexadecimal format
GSD File Name of the communication description file
New EDD revision Revision of the imported device description
Integrated EDD revision Revision of the integrated device description
New device revision Device revision of the device description that was read from a device description library. 

Devices of the associated device type with this device revision can be interpreted in SIMATIC 
PDM.

Integrated device revision Device revision of the device description which is integrated in SIMATIC PDM. Devices with 
this device revision of the device type can be interpreted in SIMATIC PDM.

Device library Revision of the device description library (EDD library), from which the device description of 
the associated device has been read in.

* Columns marked in bold are selected by default.

Use the following buttons to speed up the configuration process:

● Select all (select)

● Deselect all

● Reset selection

"Actions during device integration" area               

Options Explanations/operating instructions
"Semantics check" check box If this check box is activated, the Device Integration Manger checks 

the device description files for semantic errors during the integration 
process.

"Compile DD after import" check 
box

If this check box is activated, the individual device descriptions are 
compiled for SIMATIC PDM during the actual integration process. 
Note:
Integrated device descriptions that have not yet undergone 
compilation are compiled automatically when a device type is 
opened in SIMATIC PDM for the first time.
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9.4.1.6 "Maintenance" tab

Purpose   
In this dialog box, you specify the path to the project of a maintenance station for the use of a 
maintenance station. 

Field Explanations/operating instructions
"Maintenance project" 
input box

You can enter the path for the maintenance project in this input box. 

"Assign current project" 
button

Click this button to use the currently open project as the project for the 
maintenance station.

"Send maintenance 
alarm to MS station" 
check box

Activate this check box if you want maintenance alarms to be sent to the 
Maintenance Station.

Additional information
You can find information on working with the maintenance station in the configuration manual 
titled Process Control System PCS 7 Operator Station.

9.4.1.7 "Change Log" tab

"Enable change log" check box
When this check box is selected, a log file is created when changes are made in SIMATIC 
PDM. 

"Automatic Archiving" area

Drop-down list Explanations/operating instructions
Off Disables automatic archiving of the log file.
By interval Archives the log file in a particular cycle (yearly, monthly, weekly). 
By limit value or memory size Archives the log file once it has reached a particular memory size.

"Show input dialog for comments in change log" check box
If this check box is activated, the "Change log comment on process" dialog opens when 
changes are entered. You can enter comments in the entry dialog. 
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9.4.1.8 "Service" tab

Purpose
Service options for EDD developers are activated in this dialog box. A "Debug log" is created 
if you select any of the options.

 

 Note
System analysis for experts

We recommend that you only enable logging if instructed to do so by the hotline.   
 

Trace mode

Field Explanations/operating instructions
User If this check box is activated, user actions are logged.
Errors If this check box is activated, a log is started when an error occurs. 

The first error message and any subsequent ones are all logged.
Warning If this check box is activated, a log is started when a warning occurs. 

The first error message or warning and any subsequent ones are all 
logged.

Communication If this check box is activated, a log is started. The first error message 
or warning and any subsequent ones are all logged. In the 
"Communication" tab, you can specify what types of notes are 
recorded in the communication log.

Detail If this check box is activated, a log is started when SIMATIC PDM is 
launched. The first message and any subsequent messages, 
warnings, and errors are all logged.

EDD Expert mode - Activate messages for analyzing device descriptions
Object Manager Expert mode - Activate specific system messages for analysis

Trace Level

Field Explanations/operating instructions
Details If this check box is activated, a log is started when SIMATIC PDM is 

launched. The first message and any subsequent messages, 
warnings, and errors are all logged.

Warnings If this check box is activated, a log is started when a warning occurs. 
The first error message or warning and any subsequent ones are all 
logged.

Errors If this check box is activated, a log is started when an error occurs. 
The first error message and any subsequent ones are all logged.

Nothing Deactivates expert mode for Trace level
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Trace Function Type
The expert options for the errors are activated in this dialog box.
We recommend that you only enable logging when the Hotline instructs you do so.

Tools for EDD development

Field Explanations/operating instructions
Displaying EDD IDs If this check box is activated, the parameter table shows the variable 

IDs of the EDD.
Open online dialogs offline If this check box is activated and there is no connection with the device, 

no error message pertaining to the connection status will be output; 
the online dialog will open instead. The values displayed are those 
saved in the project or the EDD.
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Menus and dialog boxes for SIMATIC PDM in HW 
Config 10

Installing SIMATIC PDM makes additional functions available in the Edit > PDM menu of HW 
Config. 

See also
Export... (Page 172)

Import ... (Page 173)

Download to device (Page 173)

Upload to PG/PC (Page 174)

Update diagnostic status (Page 175)

“Interconnection Editor" dialog box (Page 100)
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Notes, Tips & Tricks 11
11.1 Information on configuration and parameter assignment

This section contains notes that provide additional information in particular cases. You should 
also read the information in the file pdmbase-readme. This file is usually available in the folder ...
\Siemens\SIMATIC_PDM.

Bus parameters
For information on specific settings for the bus parameters made in the Set PG/PC Interface 
program, you need to read the pdmbase-readme file. 

PROFIBUS PA profile devices

Using profile parameter assignment (profile EDD)
The following procedure applies to profile devices for which there is no EDD in the device 
description catalog and for which you want to use your own device-specific GSD file (device 
master file):

1. Import the device-specific GSD file required for the master configuration. 
Following the import, you can find this device-specific GSD file for the field device in the 
hardware catalog under .. \ Additional field devices".

2. Place the field device in the DP/PA master system.

3. Assign a suitable profile device description (EDD) to the field device. 
You can find information on this in the section "Device selection (Reassign) (Page 175)".

Using profile communication (profile GSD)
The following procedure applies to profile devices for which a profile GSD file and a custom 
device-specific device description (EDD) are to be used for parameter assignment:

1. Place the profile GSD file required for the master configuration in the DP/PA master system.

2. Assign a suitable device description to the field device. 
You can find information on this in the section "Device selection (Reassign) (Page 175)".

Block configuration of HART devices
HART devices are configured using general parameters and parameters that are assigned to 
blocks. For example, some pressure transmitters can measure the temperature as well. For 
such a device, you set the number of blocks and the number of inputs/outputs to two each. 
SIMATIC PDM supports devices having up to six blocks. The number of inputs/outputs is 
limited to a maximum of four by the HART definition. The online dialog of the Block 
assignment can be used to assign I/O to the blocks. This online dialog box is only supported 
by devices that allow inputs/outputs to be assigned to blocks. 
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Basic configuration of HART devices
The basic configuration of HART devices (in the "SIMATIC PDM Device Selection" dialog box 
under HART > Universal > Standard) includes the range of functions that are defined by HFC 
in the Universal Commands and the Common Practice Commands. 

11.2 Connecting field devices by means of Industrial Ethernet

Difference between routing and data record routing
"Routing" refers to the transmission of data beyond network limits. A transmitter sends 
information across network boundaries to a receiver. Particular equipment engineering is 
required for this function to work. 

Data record routing is a routing function which is used exclusively by SIMATIC PDM . Only 
S7-400  CPU modules with a firmware version of V5.1 or higher meet the requirements. 
Appropriate interfaces could be internal CPU interfaces, communication processors (e.g. CP 
443-5 EXT) or external equipment (e.g. IE/PB-Link). You can find information on the suitability 
of modules in the associated operating instructions.

Data sent by means of data record routing could comprise the following:

● Parameter assignments of the communication devices concerned

● Device-specific information (e.g. setpoints, limits, or similar)

With data record routing, the structure of the destination address depends on the contents of 
the data, i.e. on the device for which the data has been determined. The field devices 
themselves do not have to support data record routing, since these devices do not forward the 
information they receive. 

IE/PB-Link in connection with S7 stations   
You need an IE/PB-Link to go establish a connection via Ethernet to a DP device at an S7-300  
or at the internal DP interface of S7‑400 up to firmware V5.1 . The link provides the data record 
gateway for the plant. An IE/PB-Link must be created for each DP line in the project.

To commission the IE/PB-Link , you must assign an IP address to the link. To do this, you 
connect the IE/PB-Link with the Engineering Station via Ethernet. 

● The IE/PB Link PN IO is supplied with a fixed MAC address. If not configured, the IE/PB 
Link PN IO is accessible via this MAC address (requires Ethernet port).

● An IP address is automatically assigned during the configuration process. This IP address 
is later transferred to the IE/PB Link PN IO (IO device) when the PROFINET IO controller 
starts up.

● Please assign a device name to the IE/PB Link PN IO  so that the IO controller is able to 
identify the IO device during this process. In the SIMATIC Manager or in HW Config, simply 
select the menu command Target system > Edit Ethernet nodes... . 
(Please consult the online help in STEP 7 for details about this process.)
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Requirement
For the SIMATIC project, an IE/PB-Link is created in a SIMATIC 300 station. 
(Hardware catalog under "SIMATIC 300 > Gateway > IE/PB Link PN IO)

Procedure
1. In SIMATIC Manager, select the menu command Target system > Edit Ethernet nodes....

The dialog box "Edit Ethernet nodes..." opens.

2. Enter the MAC address of the IE/PB-Link in the "Ethernet node" section or click the 
"Browse..." button to search for and select the IE/PB-Link.

3. Assign the corresponding IP parameters to the IE/PB-Link.

4. Open HW Config.

5. Parameterize the Ethernet connection and the DP interface with the values that apply to 
the project.

6. On the "Operating Mode" tab, select the "No DP" checkbox. The IE/PB-Link now operates 
like a PG/PC.

7. After having configured and programmed all stations, select the Network > Save and 
Compile command in order to generate all routing tables.

8. To communicate via Ethernet, you select the TCP/IP protocol in the programming device/
PC interface settings for the CP 1613 or other network card that will be used for 
communication.

9. Create another programming device/PC parallel to the stations in the component view, and 
configure an Ethernet interface in this programming device/PC.

10.Assign this interface to the interface configured under the programming device/PC interface.

Now when you open the hardware configuration for a SIMATIC 300 station, communication to 
the devices will also function via Ethernet.

IE/PB-Link in connection with third-party systems
In order to be able to use systems made by third-party manufacturers, you will have to configure 
a SIMATIC 300 or SIMATIC 400 station as a "dummy" station. For this purpose, a simple 
configuration consisting of a rack, PS, CPU and DP interface will be sufficient. The devices 
will then be distributed on the DP lines of this station just as they are connected to the third-
party masters. 

Select the DP settings on the third-party master so that the token routing is performed through 
two masters (the third-party master and the IE/PB-Link). 

Like in an S7 plant, one IE/PB-Link per DP line is also required here.

The same settings as for STEP 7 stations apply for establishing communication. You need a 
programming device/PC with an Ethernet interface. 
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11.3 HART applications

System environment
Implementation of intelligent field devices with HART functionality requires the following system 
environment (see the figure below):

● Current loop 4 - 20 mA

● HART configuration tool:
The HART parameters can be set using an external handheld panel (HART Handheld) or 
a HART configuration tool (SIMATIC PDM). The configuration tool deploys the HART 
analog module, whereas the HART Handheld is connected directly in parallel to the field 
device.

● HART system integration:
The HART analog module assumes a "master" function by receiving the commands from 
the HART configuration tool. It then transfers these commands to the intelligent field device 
and returns corresponding response frames. The interface of the HART analog module is 
formed by data records which are transferred via the I/O bus. The HART configuration tool 
must generate and interpret the data records.

● IM153-2 head-end station for the HART configuration tool:
Head-end station for PROFIBUS DP, which supports master class 1 and master class 2 
functionality.

Figure 11-1 System environment: Use of HART
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Appendix A
A.1 Communication Problems

If communication problems occur, you should check for the following:

Connecting
● Configuration

– Is the programming device or PC interface configured correctly? The SIMATIC Manager 
menu command Options > Set PG/PC Interface or the Windows Control Panel can be 
used to set the PG/PC interface parameters.

– If you are not performing configuration in HW Config: Is the correct interface assigned 
to the PC? Is this interface assigned to the correct network? Check the assignment by 
selecting the interface and the required network with the menu command Edit > Object 
Properties in the "Communication" tab.

– In case of routing: Is a programming device/PC included in the project in the component 
view? Is the correct interface assigned to the programming device/PC?

– Are the addresses (address, slot, channel) assigned correctly and uniquely in the 
project?

● Hardware structure

– Is the system complete and has it been cabled correctly? Are all the connectors plugged 
in correctly? Are the modules inserted correctly?

– Are all the modules and devices of the plant supplied correctly?

– Are there low-or high-frequency interference in the system? Is the system subject to the 
influence of electromagnetic fields?

– Is there a short circuit on the bus or a wire break in a wire leading to the device?

● Addressing the devices

– Are the addresses (address, slot, channel) set correctly for the devices in the system?

– Do the addresses set on the devices agree with the configured addresses?
The address settings are made on the devices via parameter assignments, hardware 
switches, or a combination of both. 
The device address can be set by means of SIMATIC PDM for some field devices 
(PROFIBUS DP/PA and FF). You can find additional information on this in the section 
"Delivery contents (Page 20)".
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● Consistent project engineering and configuration in the CPU and CP

– The project engineering settings loaded to the CPU or to a CP must match the 
configuration. The routing tables for the project/multiproject must have been created 
and all components loaded in the network configuration (NetPro). 
To load the configuration to the CPU or to a CP, select the HW Config menu command 
Target system > Download to module > Target module.

● Maximum number of connections

– Devices or communication components can only manage a restricted number of open 
connections. It is therefore possible that connections cannot be established. To open 
new connections to devices, close S7 applications. For information on the maximum 
number of connections permitted, refer to the respective device manuals.

– At least two connections must be supported simultaneously for remote I/Os to enable 
communication with the connected HART devices.

Communication Errors
Communication errors can occur when using standard device descriptions, for example, HART 
Universal Standard descriptions. 

● The reason for this may be an unsuitable device assignment. If this is the case, assign a 
suitable device in the network or plant view. 
You can find additional information on this in the following sections:

– Section "Delivery contents (Page 20)"

– Section "Replacing devices (Page 96)"

● Another reason may be that the device does not fulfill or fully implement the standard. 
Contact the device manufacturer in this case.

Broken Connection
● Reset functions

– Was a reset function triggered in the device? A reset can be triggered manually or by 
the firmware of the device (for example, in case of hardware errors or incorrect program 
execution). The reset can block the device in a defined "safe" operating state or trigger 
a restart of the program with initial settings. These initial settings can differ from the 
desired settings, for example, different address or transmission rate.

● Disturbances

– Do low-or high-frequency interference occur in the system or is the plant subject to the 
influence of electromagnetic fields? Has the power supply of the system, of parts of the 
system or of devices been disconnected? Have connectors been withdrawn or plugged 
in elsewhere?

 

  Note

If any other communication problems occur, contact the device manufacturer. 
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A.2 Message window

A.2.1 "Decision on error" dialog box
You can obtain the specific information you need from the dialog box; if necessary, contact 
the hotline.

A.2.2 "Error history" dialog box
You can obtain the specific information you need from the dialog box; if necessary, contact 
the hotline.

A.2.3 "Error" dialog box
You can obtain the specific information you need from the dialog box; if necessary, contact 
the hotline.

A.2.4 "Multiple errors" dialog box
You can obtain the specific information you need from the dialog box; if necessary, contact 
the hotline.

A.2.5 "Messages" Dialog Box

Purpose  
Messages about the following points are displayed in this dialog box.

● Communication problems  

● Export/import 

● DIM 

● Device descriptions

You can obtain the specific information you need from the dialog box; if necessary, contact 
the hotline.
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